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DeluxePhotoLtW is a collection of three powerful graphics tools in one package. Each of 
the three programs - Paint, Colors, and Posters - is a breakthrough in its class, and 
together they offer a comprehensive solution for painting, image processing, and poster 
printing. 

Paint lets you paint in every Amiga display mode, including Hold and Modify 
Interlaced. Now you can create those photo quality images you've yearned after, or you 
can touch up and combine digitized images without sacrificing resolution or color. You 
can even work on multiple screens in different display modes simultaneously, and your 
pictures can be as large as your computer's memory can accommodate. 

Colors helps you process your existing pictures. Whether you need to change the colors, 
convert display modes, or resize the picture, Colors makes it straightforward. You can 
upgrade your art from Low Resolution to Hold and Modify Interlaced display mode 
without any fuss. 

Posters prints your pictures in any size up to 100 square feet, and it can anti-alias while 
it prints. You'll be amazed at the quality of the printouts. 

We've mentioned only a few of the things you can do with these programs, and in a 
moment, you'll see for yourself just how powerful DeluxePhotoLab is. 

ABOUT THE MANUAL 

We realize that you don't want to spend a lot of time reading a manual. You just 
bought some great software, and you want to get started with it right away. This 
manual is organized so you can use only as much of it as you need, and so you 
can learn to use DeluxePhotoLab at a pace that suits you best. Understanding 
how the manual is organized will help you get the most from it in the least time, 
so be sure to read the next few paragraphs. 

The first thing you'll notice is that the manual is divided into five major sections. 

The first section contains a general table of contents, this introduction, and a 
Getting Started section, which covers the absolute fundamentals everyone 
should know. 
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The next three sections cover Paint, Posters, and Colors as separate programs. 
When you are using one of the programs, you can turn to the section of the 
manual that applies to it to find information quickly. Each of these sections 
contains a Guided Tour, for those who want a structured introduction to the 
program's features, and a Reference, for information about specific features. The 
Paint and Colors sections also contain Tutorials that explain the more powerful 
and complex features of each program. It isn't necessary to use all chapters for 
each program, but the more chapters you use, the more likely you are to get the 
most out of the programs. 

The last section of this manual contains the Appendices and an Index. The index 
is a valuable tool for finding information quickly. 
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This clulpterisdesigned to get you up and running quickly. To tlult end, we tell you only 
the essentials. We recommend tlult all users read through this clulpter to make sure you 
Iulve all ofthe necessary Iulrdware and software. You'll also learn how to start a program, 
how to load a picture, and Jww to quit a program. 

GErI"lNG STARTED 

SOFTWARE 

Your DeluxePhotoLab package contains two disks: the programdisk, containing 
three programs (Paint, Posters, and Colors) that give you everything you need 
to perform high quality painting and image processing, and the art disk, a 
collection of images you can use in your work and as you learn to use the 
programs. These images are stored in two drawers, labeled according to the 
display mode (HAMx400 or HAMx200 - HAM is an abbreviation ofHold And 
Modify) of the images they contain. As you will see shortly, you access these 
images by first specifying the drawer, and then specifying the image. You can 
save your work to disk in the same way. 

HARDWARE 

To use DeluxePhotoLab you will need an Amiga with at least one megabyte of 
random access memory, a monitor, and some initialized blank disks for saving 
your work. Finally, if you intend to print the files you create using either the 
printing function in Paint or by creating a poster with Posters, you will need a 
printer. Consult your Amiga Users Guide for information about connecting 
printers and other peripherals to the Amiga. 
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GETTING STARTED 


ORGANIZING YOUR DISKS 

We assume that you already know how to copy disks, how to delete files, and 
howtomove files from onedisk to another. Ifyou are not familiar with all of these 
procedures, we suggest you consult your Amiga Users Guide before going any 
further. 

• 	 The firstthing you should do is to make oneor more working copies of your 
DeluxePhotoLab disks to reduce the chance of anything happening to the 
original. Your Amiga Users Guide has information on making copies. We 
will be looking at some of the pictures on the art disk in the Guided Tours 
and Tutorials. 

You will need one or more blank initialized disks handy for saving your work. 
Your Amiga Users Guide has information on initializing disks. 

INSTALLING ON A HARD DISK 

Ifyou own a hard drive, you will probably want to install DeluxePhotoLab. The 
following steps assume that you started the computer with a standard Work
bench that has been configured properly to support a hard disk. If you wish to 
install the program using some other method, feel free to do so. 

• 	 Create a Drawer named DeluxePhotoLab on your hard disk 

(Oick the Empty Drawer icon to select it. Choose Duplicate from the 
Workbench menu. In a moment, a new drawer is created called "copy of 
Empty." Oick the "copy of Empty" drawer to select it. Choose Rename 
from the Workbench menu. Press Del several times to erase the drawer 
name. Type "DeluxePhotoLab" and press Return. You now have a drawer 
named DeluxePhotoLab.) 

• 	 Insert the DeluxePhotoLab program disk into a disk drive. 

• 	 Double-click the program disk icon to view the contents of the disk. 

• 	 Click the Paint icon. Then hold down the Shift key and dick the other two 
program icons - Colors, and Posters. You now have all three programs 
selected. 
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GETTIN 

• 	 Hold down the Shift key and drag the three icons so that the one you are 
pointing to is directly over the DeluxePhotoLab drawer icon. Release the 
mouse button. Now the Workbench copies the three programs into your 
hard disk drawer. 

• 	 Replace the program disk with the DeluxePhotoLab art disk. 

• 	 Double-click the art disk icon to view the contents of the disk. 

• 	 Drag the HAMx200 and HAMx400 icons onto the DeluxePhotoLab drawer 
icon the same way you dragged the program icons above. 

You now have copies of the three DeluxePhotoLab programs and the two art 
drawers on your hard disk. 

POWER UP 

When you're ready to begin, just follow these instructions: 

• 	 Tum onthe computer and mon itor. (Amiga 1000 users, start byinserting the 
Kickstart 1.2 disk in the internal disk drive before turning on the computer.) 
When the request for the Workbench disk appears on the screen, insert your 
working copy of the DeluxePhotoLab program disk. 

The drive will spin for a few seconds, and then the DeluxePhotoLab disk icon 
will appear on the right side of the screen. 

• 	 Double-click the disk icon (move the pointer onto the icon and click the left 
mouse button twice in rapid succession) to open the disk window. 

The disk window opens to reveal icons for the three programs in DeluxePhoto
Lab (paint, Colors, and Posters) plus the Amiga Preferences program. 
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STARTING A PROGRAM 

To start one of the programs, simply double-dick that program's icon. Rig htnow 
let's start Paint, so wecan show you howmenuswork, and how to load a picture. 
(If you are an experienced Amiga user, you can simply start the program and 
skip down to the description of the Load Requester, so you'll know how to get 
the most out of it.) 

• 	 Double-dick the Paint icon, the triangular icon with a hand holding a paint 
brush in the center. 

When you start Paint, the program presents a requester ( a window that requires 
some input from you) inviting you to select a display mode. This requester (the 
Display Mode Requester) is explained in the first chapter of the Paint section of 
this manual. The default settings, the ones the program automatically uses 
unless you specify otherwise, are displayed in the requester (Low Resolution, 
Non-Interlaced, 5, and Full). We'll look at some of the other options in the Paint 
section of the manual. For now, we'll use the default settings. 

Figure 1.1 Display Mode Requester 

• 	 Click Open with the left mouse button to tell Paint to use the default 
settings. 

This last command brings us to the Painting Screen, with the large painting area 
and the Palette and Toolbox at the top. 
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GETTING STARTED 


Figure 1.2 The Painting Screen 

THE MENUS 
The menus in Paint work just like other Amiga menus: pointto the Title Bar and 
press the right mouse button to display the Menu Bar. Then, point to a menu 
name to open that menu. Finally, drag the arrow down to one of the menu 
options and release the mouse button to select that option. Let's try it. 

• 	 Point to the Title Bar and hold down the right mouse button to reveal the 
Menu Bar. Point to the Project Menu to display its options. Now drag the 
pointer down to the About option near the bottom ofthe menu. (Notice that 
as you drag, the option you are pointing to becomes highlighted. This lets 
you know exactly which option you are pointing to.) Finally, release the 
mouse button. A requester appears, showing the programmer's name and 
the copyright information for Paint. 
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GETTING STARTED 
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Figure 1.3 Project Menu open with About selected 

You've just selected the About option from the Project menu. In the future, that's 
how we'll write the instruction: "Select About from the Project menu." 

• Click Cancel to close the About box. 

Some menu options present submenus to the right side of the option. In these 
cases, you can drag the highlight down to the option to display the submenu, 
then drag the highlight to the right and down again to select an option from the 
submenu. 

LOADING A PICTURE 

Before you move on, let's load a picture so you can see how the Load Requester 
works. As an example, we'll load the picture called Airwar. 

• Select Load from the Project menu to bring up the Load Requester. 
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Load Cancel 
PHOTOLAB: 


F:ILES 

Figure 1.4 Load Requester 

In the middle ofthe Load Requester is a list of files, directories, and volumes. You 
can scro 11 through these file names (not all of them are always visible at one time) 
by dragging the scroll box (the small rectangle within the dark vertical column 
on the right side ofthe requester) up and down. Just pointto the scroll box, press 
the left mouse button, and drag it up or down. 

You can also scroll through the file listings one at a time by clicking on the up and 
down arrows, or you can scroll one page at a time by clicking in the areas above 
and below the scroll box. Incidentally, note that the size of the scroll box is a 
function of the number of file names in that particular directory. For example, 
with a large number of file names, the scroll box is relatively small, to show that 
the ones currently visible are only a small percentage of the whole. On the other 
hand, if all the file names are visible at one time, the scroll box will fill the entire 
column. 

Above the file list you see an edit field that displays the current volume and 
directory names. This box is called the Path gadget. (By using directories, to 
classifyyour pictures, you can keep related images together, in the same wayyou 
keep related papers together in one file folder. See your Amiga manual for 
information on creating directories, also called drawers on the Amiga.) In this 
case, the setting is PhotoLab:, which means that you are in the root directory of 
the Photo Lab disk. There is a second edit field below the file list for entering the 
name of the file you want to load. 
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GETTING STARTED 

• 	 If you are using only one disk drive, eject your working copy of the 
DeluxePhotoLab program disk and replace it with your working copy of 
the art disk. (If you are using two drives, put your art disk in the external 
drive, press v on the keyboard - this keyboard equivalent displays the 
volumes in the file list - and dick the volume name of your art disk, 
PHOTOLAB ART:. 

• 	 Now press d on the keyboard to display the list of directories. Click the 
directory HAMx200. 

In a moment, this directory name is added in the Path gadget and the contents 
of the directory are displayed in the file list. 

• 	 Now click the file named Airwar (the file name appears in the File gadget) 
and click Load. 

The disk drive will spin for a few moments and the Airwar picture gradually 
appears on the screen. (This load will take longer than normal, because the 
pictureyou are loading is actually saved as a Hold and Modify image with 4,096 
colors, and it must be converted during the load process to display the picture 
in only 32 colors. Later, be sure to load the picture again to see what a difference 
an extra 4,064 colors can make.) 

QUITIING APROGRAM 

When you are finished using a program, you can exit by selecting Quit from the 
Project menu. In all three programs, the Project menu is the first menu on the left 
end of the Menu Bar, and Quit is at the bottom of the Project menu. If you've 
made changes to a picture using Paint or Colors, and then select Quit without 
saving your changes, a requester asks if you want to save your changes before 
quitting the program. 

10 




GETTING STARTED 


Now that you've seen how to start a program and load afile, you might want to expl,!re 
the features ofeach program on your own. The Reference section for each program will 
answer any questions you might have. If you'd like to be introduced to the features in a 
more structured manner, with explanations along the way, work through the Guided 
Tour for each program. After that, if you want to learn even more about a program, work 
through the additional chapters. This manual was organized so you can use only as much 
as you need, but keep in mind that the moreyou read, the better you will understand each 
program. 
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PAINT: GUIDED TOUR 


This section of the manual tells you everything you need to know about Paint, the 
multiple display mode painting program included in DeluxePhotoLab. If you are 
familiar with DeluxePaint, you'll find that the tools, menu options, and in some cases 
keyboard equivalents are much like those in Delu:xePaint. If you are an experienced 
DeluxePaint user, you may want to jump right in and begin using Paint and look in the 
Reference section for anr;wers to any questions you might have. However, even experi
enced Delu:xePaint users will benefitfrom reading sections ofthe manual that explain the 
Paint Modes, which help you create paint effects in HAM display mode. The tutorial 
section explains someofthe painting optionsandgives suggestionsfortheirpractiml use. 

WHAT YOU'LL NEED 

To complete this guided tour, you'll need your working copies of the Deluxe
PhotoLab program diskand art disk. Ifyou want to save your work, you'll need 
an initialized disk with a fair amount of available space for saving large files. 

SELECTING ADISPLAY MODE 

When you start Paint, the first thing you see is the Display Mode Requester. 

Di5pla~ Hode I~I~ 

di.iILiiIILow ReSOlu.tionjlm'lllBm ( EMit J 
.'I!m$Hon Inh:rla.cedLU~t Open] 

Figure 2.1 Display Mode Requester 

This requester lets you select the display mode you want to work in. To change 
the settings in this requester, click the appropriate area. Right now we'll show 
you how the gadgets work. In Chapter Two, "The Elements/' we'll explain each 
of the display modes in more detaiL 

• Point to the words Low Resolution and click once. 
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PAINT: GUIDED TOUR 

Each time you click the top half of the Screen Type gadget, it cycles to the next 
setting. Paint supports all Amiga display modes: Low Resolution, High Resolu
tion, Extra HalfBrite, and Hold and Modify (HAM). In addition, each of these 
modes can be either Interlaced or Non-Interlaced. 

• 	 Click Non-Interlaced. 

Each click on the bottom half of the Screen Type gadget toggles the selection 
between Non-Interlaced and Interlaced. 

The Depth gadget lets you select how many bit planes (and thus how many 
colors) the display mode uses. The number of planes you can select depends on 
the Screen Type you selected. (Appendix B: Amiga Display Modes explains how 
the number of bit planes is related to the display modes and the number of colors 
available.) 

• 	 Click the top half of the Screen Type gadget several times and watch as the 
Depth setting changes. 

When you select a screen type, the Depth setting is automatically changed to the 
maximum number of bit planes supported by the screen type. You can change 
the Depth setting to fewer bit planes as long as the setting is supported by the 
screen type. The Depth gadget restricts you to the acceptable settings. Let's take 
a look at how this affects a couple of screen types. 

• 	 Set Screen Type to Hold and Modify. Click the number below Depth. In 
Hold and Modify mode, the screen can have either 5 or 6 bit planes. 

• 	 Now set the Screen type to Low Resolution and click the Depth gadget. In 
Low resolution, the screen can have 1 to 5 bit planes. 

Finally, the Size gadget lets you select whether the page size will use the full 
screen or only the top 3/4 of the screen. This is especially useful if you want an 
extra screen to cut and paste to, but want to conserve on memory. 

• 	 When the Display Mode Requester shows the settings you want to use, (for 
now, set the Screen Type to Low Resolution Non-Interlaced with a depth of 
5 bit planes and a full size screen) click OPEN to open a screen in that format. 
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THE PAINTING SCREEN 


Now that you've started Paint and selected your screen format, you are pre
sented with the Painting Screen. Along the top of the screen are the Title Bar, 
Palette, and Toolbox. 

Figure 2.2 The Painting Screen 

The area below the Toolbox is where you work on your pictures. This area is 
called the page. The normal page size is the same as the screen size, but in the next 
chapter you'll see that you can make the page much larger. When your page is 
larger than the screen, youcan scroll the pageby pressingthearrow(cursor) keys 
on the keyboard. When you use the arrow keys, think of them as moving the 
screen rather than the picture; pressing thedown arrow moves the screen down, 
so it looks like the page is moving up. 

THE TITLE BAR 

The Title Bar lists the name of your picture (in this case Untitled A). It also lists 
the current settings in the Modes menu and whether you are using a custom 
brush or a built-in brush. At the moment, this information probably doesn't 
mean anything to you, but as you become familiar with the program, you'll find 
that the information in the Title Bar can save you a lot of time. 
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THE MENUS 

The menus in Paint work just like other Amiga menus: point to the Title Bar and 
press the right mouse button to display the Menu Bar. Then, still holding down 
the mouse button, point to a menu name to open that menu. Finally, pull the 
highlight down to one ofthe menu options and release the mouse button to select 
that option. 

THE PALETTE 

The upper left area of the Painting Screen contains the Palette where you select 
the color you want to paint with. The number of colors in the Palette depends on 
the display mode you are using. Note that the painting area below the Palette is 
black. This is the default background color. If you were to paint with the back
ground color directly onto the background, it would appear to have no effect, as 
if you were putting black paint onto a black canvas. As you'll see in a moment, 
painting with the background color is a way of erasing an image on the page. 

AGBValues 

Untitled AI

IIIIIIII ttl·):1
I I I 

Palette Coklr Indicator Coordinates 

Figure 2.3 Palette and Indicators 

To the right of the Palette is the Color Indicator, two rectangles side by side. The 
left rectangle shows the foreground color. You can change this color at any time 
by clicking one of the other colors in the Palette with the left mouse button. Try 
it. 
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• 	 Move the pointer to one of the colors in the Palette and click. 

Notice that the left rectangle of the Color Indicator changes to show the new 
foreground color. Click theother colors and see how the Color Indicator changes 
each time. Also notice that numbers appear above the Color Indicator when you 
click on a color for the first time, and these numbers change each time you click 
a different color. These numbers show you the RGB (Red, Green, and Blue) 
values of the color you clicked most recently. We'll say a lot more about RGB 
values later in the manual, for now, just remember that the values are listed 
above the Color Indicator. 

The right rectangle in the Color Indicator shows the current background color. 

• 	 To change the background color, move the pointer to one of the colors in the 
Palette and click the right mouse button. 

Notice that the right rectangle in the Color Indicator is now filled with the new 
background color; the painting area itself is still the old background color. Paint 
lets you maintain the old background color as a "wash" over the new back
ground color, and will keep it there until you clear the painting area. Try it now. 

• 	 Click the button labeled CLR in the top right corner ofthe screen. This clears 
the screen of the old background color and replaces it with the new one. 

Before you do anything else, let's look at one of the most important tools in the 
Toolbox, the UND button. Located just below the CLR button, the UND button 
will generally "undo" your last painting action. 

• 	 Click UND now to bring back the old background color. 

UND reverses your last action, provided there has not been an intervening 
mouse click; if you were to click CLR twice, for example, clicking UND would 
not reverse the clear command. 
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PAINTING WITH THE MOUSE 

Now that you've seen how to choose colors from the Palette, let's put brush to 
paper and create our first free form painting. 

• 	 Select a foreground and background color by clicking with the appropriate 
buttons on the Palette. Choose contrasting colors such as light blue for the 
foreground and gray for the background. 

• 	 Click CLR to cover your page with the background color. 

• 	 Move the pointer over to the page (where it turns into a cross-hair) and, 
while holding down the left mouse button, paint an image on the screen. (If 
you've already played with some of the tools, make sure that the first tool 
in the Toolbox is highlighted.) Don't worry about quality for the moment
a squiggly line or a rough circle will do. 

• 	 Now press the right mouse button and paint over your first image. 

Notethat the right mouse button has theeffectoferasing your painting, although 
whatyou are actually doing is painting over it with the background color. Notice 
that this parallels the rule we noted above for selecting colors from the Palette: 
select the foreground color by clicking with the left button and the background 
color by clicking with the right button. 

Before we move on, let's scroll the page a bit so you see how this works. 

• 	 Draw a little scribble on the screen so you'll be able to see it move. Now press 
the down arrowon your keyboard to move the screen down to see lower on 
your page. 

As we mentioned earlier, the page is normally the same size as the screen. You're 
able to scroll itupand down a little right now, because the Menu Barand Toolbox 
are hiding part of the page. Ifyour page were wider, you would be able to scroll 
it sideways also. 
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COORDINATES 

You might have noticed that as you painted on the screen, the numbers to the 
right of the color indicator changed. These numbers show you the current 
position (the coordinates) of the cross-hair, and thus the position ofyour brush. 

When you are not pressing a mouse button, the Coordinates show you the 
position of the brush relative to the upper left comer of your page. The top 
number shows you the number of pixels from the left side of the page. The 
bottom number shows you the number of pixels from the top of the page. 

If you press a mouse button, the Coordinates reset to +000 and +000. As you 
movethebrush,theCoordinates show positive numbers for the numberof pix els 
the brush has moved to the right or down from its original position. Negative 
numbers indicate the numberofpixels thebrush has moved to the left or up from 
its original position. 

PICKING COLORS FROM THE SCREEN 

So far you'vebeen selectingyourcolorsbyclicking the colors in the Palette. Ifyou 
like, you can also select your colors directly from the screen. This is useful if you 
are working on fine details, or ifyou are working with many shades of the same 
basic color. For example, ifyou are painting a rose and are using eight different 
shadesofred, it mightbeeasierto pick thecoloryouneed directly from the screen 
where you are working. 

• 	 To do this, click theColor Indicator and move the pointerback to the screen. 
The pointer is labeled "Pick." Point to a color on the screen and click either 
the left or the right mouse button to select a new foreground orbackground 
color. (An even easier way to select a color from the screen is to use the 
keyboard equivalent. Press the comma (,) key to get the Pick pointer and 
then click a color.) 

Practice painting with the mouse for a while and try selecting colors from the 
screen. Remember, you can always click UND to reverse your last action, or CLR 
to clear the screen and start afresh. As soon as you're ready, move on to the next 
section, where we will be examining Paint's collection of brushes and tools. 
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THE BUILT-IN BRUSHES 

So far you've been painting with the single pixel brush that's selected when you 
first load Paint (a pixel, short for picture element, is the smallest unit observable 
on the screen). Paint includes sixteen built-in brushes: four square ones, four 
round ones, and eight diagonal lines. The built-in brushes are in the Shapes 
option of the Brushes menu. This is an example of a menu item that presents a 
submenu. 

• 	 Open the Brushes menu and pull the highlight down to Shapes; a submenu 
of brush shapes appears. Now pull the highlight to the right and select one 
of the brushes. When you release the mouse button, the new brush is 
attached to the cross-hair. 
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Figure 2.4 The Built-In Brushes 

With your new brush selected, paint as before, using the left button to paint with 
the foreground color and the right button to paint (or erase) with the background 
color. In the next section we will look at the painting tools and how they interact 
with the brushes. 
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THE TOOLBOX 

The fourteen icons along the top right portion of the Painting Screen control the 
painting tools. Because any brush can operate with any given painting tool 
(except the Text too}), youhavea widevarietyofcombinationsatyour fingertips. 

• To select a tool, dick it with the left mouse button. 

,-,~----------------~--'--'----, 

Dotted Freehand 

Straight Line Airbrush Fil Clear 

Text 

Cu rYe UnfilledtFilled Rectangle MagnifylZoom 

Figure 2.5 The Toolbox 

We'll describe the tools in order, moving left to right: 

D THE DOTTED FREEHAND TOOL allows fast freehand painting with a built-in 
brush. No matter how fast you paint with this tool, it tries to keep up with you; 
this makes it ideal for sketching out a shape quickly before concentrating on the 
intricate details. Note, however, thatthe faster yougo, thebiggerthegapsin your 
painting. Once you have roughed out a shapewith the Dotted Freehand tool, you 
can then refine your image using some of the other tools. Try painting with it 
using different size brushes to get a feeling for how it works. 

THE CONTINUOUS FREEHAND TOOL. Because it produces unbroken lines, 
but doesn't keep up with you if you paint quickly, the Continuous Freehand tool 
is better suited for slower, more painstaking painting. Note, however, that the 
smaller the brush, the better it is at keeping up. Try it with different brushes to 
see how brush size affects speed. 

25 




PAINT: UI 

THE STRAIGHT LINE TOOL lets you paint straight lines just by clicking and 
dragging the mouse. Here's how it works: 

• 	 First, click the Straight Line tool to activate it. Then move the cross-hair to 
the point on the page where you would like the line to begin. 

• 	 Now press the left mouse button to anchor the line at that point, and, while 
holding the button down, drag the mouse to the point where you want the 
line to end. 

When you release the button, you have a straight line in your selected fore
ground color and brush size. 

THE CURVE TOOL paints curves that can be defined by four points, such as S
curves. It works much like the Straight Line tool except that it requires one 
additional mouse click to complete the curve. Here's how: 

• 	 First, anchor the first point of the curve by pressing the mouse button. Drag 
it to the point where you want the curve to end, and release the button. 

Now, you've defined the two endpoints of the curve. As you move the mouse 
away from the endpoints, you'll notice that the line is still IIactive," behaving as 
though it were a rubber band attached to the cross-hair. Accordingly, the line will 
curve to follow the cross-hair wherever you drag it. 

• 	 Drag the line until the arc for the end half of the S-curve is the shape you 
want. 

• 	 Then hold down the mouse button and move the cursor to the other side of 
the line, to form the beginning half oftheS-curve. Release the mouse button 
to complete the curve. 

With a little practice, you'll be able to make curves of any shape and size, giving 
you much more flexibility than any collection of plastic tern plates with their 
limited selection of shapes and sizes. Try joining a series of curves to make 
flowing shapes with changes in curve direction. 
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THE AIRBRUSH TOOL is a full-featured airbrush with adjustable tips and r;:l 
nozzles. By using the Airbrush in combination with the different brushes, you LQ.::J can create a variety of effects, ranging from a fine one-pixel spray to a coarse 
spray made with the big brushes. In the following chapter we will see how to 
adjust the width of the spray, but for now let's try it as is. 

• 	 Click the Airbrush tool with the left button, and then try painting with it 
using the various brushes. 

Try it with the single-pixel brush, and then try it with thebig brushes. Note tha t, 
just like a regular airbrush, if you keep the mouse button pressed without 
moving the mouse, the paint continues to build up in one spot. 

THE TEXT TOOL lets you enter lines oftext anywhere on the screen in whatever 
color you choose. 

• 	 Click the Text tool and place the small rectangular cursor on the page by 
clicking it down. Now type a line of text. 

The letters you type appear in the current foreground color. If you make a 
mistake, you can backspace on the same line and type again. You can press 
Return to start a new line directly below the point where you first placed the 
cursor. However, once you press Return, or dick the mouse again, your text 
becomes part of the picture, and you can no longer backspace over the text. I fyou 
type several lines by pressing Return between lines, and then find that you made 
a mistake in one of the lines, you can remove all of that text by clicking Undo 
before you click anywhere else on the screen. 

You can select different fonts and styles for your text by selecting them from the 
Fonts menu. We'll say more about this in Chapter Two, but ifyou like, experi
ment by selecting different fonts and styles from the menu. 

THE FILL TOOL fills any enclosed shape with the current foreground or 
background color. 

• 	 To use the Fill tool, click the icon with the left button, move the cursor 
(which now looks like a paint can)to an enclosed shape, and dick one ofthe 
mouse buttons. 
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Note that the Fill tool fills all the way to the boundaries ofan enclosed shape. If 
the shape is not completely enclosed (that is, if there is a hole in its perimeter), 
the paint will '1eak" through and fill the entire page. If this ever happens, you 
can stop the filling process by pressing the Spacebar. This aborts the current Fill 
command and returns the screen to its pre-command state. 

The paint can's spout-thepart you must putinsidetheenclosed shape-is the 
small (one-pixel) dot at the base of the icon. With careful maneuvering, you can 
fill a space as small as one pixel, so long as the spout coincides with that space. 

THE RECTANGLE TOOL lets you paint squares or rectangles, either unfilled or 
filled with the current foreground or background color. Note that the rectangle 
icon is painted in two halves when it is not selected. This is because it is actually 
two tools in one the top one creates unfilled shapes, while the bottom one 
creates shapes filled with the current foreground or background color. 

Let's try making a few rectangles. 

• 	 Click the top half of the icon with the left mouse button. Move the pointer 
onto the painting area (where it changes into a cross-hair), press the left 
mouse button to anchor one of the corners of the rectangle, and, while 
holding the mouse button down, drag the mouse away from the anchor 
point. 

You can drag the mouse down and to the right (in which case the first button 
press anchors the rectangle's top left corner), or in any other direction you wish. 
In any case, the rectangle is completed as soon as you release the button. Note 
that it is unfilled and bordered by the current foreground color. You can also 
create an unfilled rectangle bordered by the background color by using the right 
mouse button. First, click another color on the Palette with the right mouse 
button, and then make a rectangle using the right mouse button. 

• 	 To create a filled rectangle, click the bottom half of the Rectangle icon with 
the left mouse button and repeat the above procedure. 

This time, the rectangles you create will be filled with either the foreground or 
the background color, depending on which mouse button you press when you 
create the rectangle. Incidentally, ifyou hold down the Ctrl key as you paint, you 
can constrain the rectangle so that its height and width are equal. (Note: Because 
the Amiga's pixels are not perfectly square, "constrained" rectangles will not 
appear exactly square on the screen.) 
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THE OVAL TOOL works like the Rectangle tool: 

• 	 Click the top part of the icon with the left mouse button to get an unfilled 
shape, or the bottom part to get a filled shape. Move to the painting area, 
then press and drag with the left button to create an oval with the current 
foreground color, or with the right mouse button to create an oval bordered 
or filled with the current background color. 

Ifyou hold down the Ctrl key as you paint, you can constrain the oval so that it 
is a circle. 

When you first load Paint, ovals are painted from corner-to-corner as you drag 
the mouse. This means that the oval is painted to fit the rectangular area defined 
by your mouse movement. The Center Ovals option lets you paint your ovals 
and circles from the center outward. This option is located in the Preferences 
submenu of the Options menu. For more information on this option, see the 
discussion in the Paint Reference section under Options Menu. 

THE FREEFORM SHAPE TOOL lets you paint a filled freeform shape, or a filled 
polygon. Here's how it works: 

• 	 To paint a filled freeform shape, click the top half of the tool with the left 
mouse button to select a freeform shape. Paint your freeform shape just as 
you would with the Continuous Freehand tool. When you release the 
mouse button, the shape you drew is filled with either the current fore
ground color or the current background color, depending on which mouse 
button you used to draw the shape. 

Note that if the cross-hair is not at the starting point of your shape when you 
release the mouse button, the shape is completed with a straight line from the 
cursor position to the starting point. 

• 	 To paint a filled polygon shape, click the bottom halfof the tool with the left 
mouse button, move the cross-hair into the painting area, hold down the 
button and drag to paint the first line, as ifyou were using the Straight Line 
tool. This time, however, you will notice that your cross-hair is still con
nected to the first line by a second straight line. 
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• 	 Click the button again to finish that line, and so on until you have completed 
your polygon. The polygon is completed as soon as you click the button 
with the cross-hair on your starting point. 

Because it can sometimes be a little tricky to end up on the exact pixel you started 
with, you can complete a polygon at any time by clicking twice without moving 
the mouse button between the clicks. This automatically connects the current 
cursor position to the point of origin and fills the polygon with the current 
foreground or background color, depending on which mouse button you used 
to start drawing the polygon. 

• 	 Try painting some five-pointed stars with the Filled Polygon tool and see 
what happens. 

THE BRUSH SELECTOR lets you select any part of your picture as a brush. 

• 	 To see it in action, click the top half of the scissors icon with the left mouse 
button, then move the cursor over to the painting area. 

Notice that your cursor is now a large cross-hair that reaches to the edges of the 
screen. 

• 	 Selectoneofthe stars you made earlierbyputting the center of the cross-hair 
to the upper left of the star. Then, while holding down the left mouse button, 
drag the cursor to the lower right of the star, as if you were using the 
Rectangle tool to enclose the star in a box. When you release the mouse 
button, the cursor now has a copy of the star attached to it. 

This second star is your new brush! To stamp a star in a new location, click the 
left mouse button. There's no need to stop with one - go ahead and star-spangle 
the screen. We will be covering this powerful feature in greater depth in the next 
chapter. For now, however, there is one aspect of brush selection you should be 
aware of: if any parts of your brush consist of the current background color, 
those parts will be transparent. In other words, whenever you pick up a brush, 
it's as if you are picking up only the non-background colors; any background 
colors in the brush will remain invisible even after you change to a new 
background color. This means that you can create brushes with intricate outlines 
without fear of picking up a rectangle of the surroqnding background color. 
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(Note: Whether or not the background color is picked up with the brush is 
controlled by the Transparency option in the Preferences submenu of the 
Options menu. When you first start Paint, the Transparency option is on. Ifyou 
want to pick up the background color, tum the Transparency option off by 
selecting it.) 

Let's try one more trick. 

• 	 Click the Brush Selector again and select a star from the painting area, but 
this time use the right mouse button to drag the cross-hair over the star. 

Unlike the last exercise, which yielded two stars-oneunmoving original, plus 
the one on your brush - this time you are picking up and moving just the one 
star. While the first feature lets you copy and move anything on the screen, the 
second lets you move images from one part of the screen to another, while 
leaving no trace behind. 

THE MAGNIFY TOOL lets you magnify any section of your work, and view it 
alongside the standard-sized image. 

• 	 To magnify a section of your work, click the Magnifyicon. When you move 
the cursor onto the page, it becomes a rectangular outline. Move the outline 
to the part of the image you want to magnify, and click the mouse button. 

The part of the image included in the rectangle now appears magnified on the 
right part of the screen. The left part of the screen shows the image in its original, 
unmagnified form. Another way to enter the Magnify mode is to move your 
cursor to the area you want to magnify, and press the m key. 

You can now perform any function on either side of the screen using any of the 
tools in the Toolbox. Thus, you can paint circles and squares, fill in shapes using 
the Fill tool, and use any of the brushes normally available to you. Using the four 
arrow keys, you can move the image around under the "magnifying glass." In 
addition, by pointing your cursor anywhere on the unmagnified or magnified 
portion of the screen and pressing the n key, you can center that part of the 
picture in the magnified area. 

Once you've magnified a part of your picture, you can increase or decrease the 
amount of magnification by using the Zoom tool (the Zoom icon is the bottom 
half of the Magnify icon once magnify is activated). 
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• 	 Click Zoom with the left mousebutton to increase the magnification (zoom 
in); click with the right mouse button to decrease the magnification (zoom 
out). 

• 	 To quit Magnify mode when you have the magnified area on the screen, 
click the Magnify tool (the top half of the icon) a second time. 

SAVING YOUR WORK 

Before moving on to the next chapter, where you'll get a closer look at some of 
Paint's elements, let's see how to save and load the pictures (or "files") you 
create. 

In the Getting Started section of this manual, we showed you how to load a 
picture. Saving a picture works much the same way. 

• 	 The Save option for pictures is in the Project menu. Selecting Save brings up 
the Save Requester, which works exactly like the Load Requester, except 
that clicking Save saves your picture to disk. 

Path 
Gadget 

Save Cancel=:J 
PHOTOLAB: 

FILES -
Colo.. s 
P.aint 
Post.... s 
P.... t ........ nc..s 

Figure 2.6 Save Requester 
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If you want to save your current creation, this is your chance to do so. 

• 	 If you are using only one disk drive, eject your working copy of the 
DeluxePhotoLab disk and replace it with your data disk. Now click 
anywhere in the File gadget, type in the name you have chosen for your new 
file, and click Save. 

Ifyou are using two drives, put your data disk in the external drive, press v on 
the keyboard - this keyboard equivalent displays the volumes in the file list 
and click the volume name ofyour data disk. Now click the File gadget and type 
the name for your file. Oick Save to complete the process. 

The disk drive will spin for a few moments; when the red light goes out, the file 
is saved. 

The next time you save this file (it's a good idea to save work in progress every 
15 minutes or so, so that a power failure doesn't turn hours of work into a bitter 
memory), the Save requester uses this same information, which means you 
won't need to type anything more unless you want to change the file name. You 
might want to do this to save it under another name, if you want to save each 
version as a separate file. In that case, you would click the file gadget as before, 
backspace over the old file name (or over those parts you want to change) and 
type in the new name. Oryou could just keep adding suffixes, such as1, 2, 3, etc., 
to signify succeeding versions. 

OPENING ASECOND SCREEN 

One of the very useful features of Paint, is the ability to work on more than one 
screen at a time. Even more important, the screens can be in different display 
modes. At the beginning of this chapter, you started Paint and opened a screen 
in Low Resolution. With this screen still open, you can open a second screen by 
selecting New from the Project menu. 

• 	 New in the Project menu brings up the Display Mode Requester, for you to 
select the display mode for your new screen. Set the Screen Type to Hold 
and Modify, Interlaced mode and click Open. 
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In a second, you have a second screen open in Hold and Modify mode. You can 
confirm that youroriginal screen is still openby pointing to theTitle Bar, holding 
downthe left mouse button, and pullingdown the screen to see the onesbeneath 
it. Your original screen is behind the Palette Screen, so you'll need to pull thenew 
screen all the way to the bottom to see the old one. Click the Front and Back 
gadgets (the small overlapping squares in the upper right corner of each Amiga 
screen) to move to a different screen when you need to. 

The active screen is always the last screen you clicked on. So, if you wanted to 
makeyouroriginal Low Resolution screen thecurrently active screen, pulldown 
theHAM screen andclick theLow Resolution screen. Nowyour Low Resolution 
screen is thecurrent screen. This is particulary important when working with the 
Palette Screen, because changes to the Palette affect the currently active screen 
only. (We'll explain the Palette Screen in detail in the next chapter.) 

LOADING APICTURE 

Now that we've seen how to save a file, and how to open a new screen, let's see 
how to load one of the pictures on the Art Disk. Let's load the one called 
Astronaut. (Ifyou worked through Getting Started, you alreadyknow how to do 
this. Try it without following the instructions to see how much you remember. 
You can always check the instructions if you get stuck.) 

• 	 First, make the HAM screen the current screen by clicking on it, then insert 
your working copy of theDeluxePhotoLab art disk inyour drive and select 
Load from the Project menu. (If you have two disk drives, put the art disk 
in the second drive. When the Load Requester first appears, press Von the 
keyboard to display the volumes and click the volume PHOTOLAB ART. 

Note that the Load Requester is just like the Save Requester in almost every 
respect. 

• 	 To load a file, open the directoryyou wantbyclickingon thedirectory name 
(in this case, HAMx400). Then simply click the file name in the requester 
window to put that name into the File gadget. Try it. Oick any name and 
watch it appear in the File gadget. Now click another name and watch it 
change. When you're ready, click the file Astronaut, and then click Load. 
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The disk drive will spin for a few moments, and then the picture will appear on 
the screen. 

RESIZE DRAW 

Before we move on to the next chapter, where we'll take a closer look at the 
various elements of Paint, let's take a quic k look at one of Paint's powerful brush 
features. You've already seen how to select a custom brush. Right now, we'll 
select the astronaut as a custom brush and then paint a copy of him inside his 
helmet. Here's how it works: 

• 	 Click the bottom half of the Brush Selector tool to get the freehand selector. 

• 	 Press F9 and FlO on the keyboard to remove the Title Bar and Toolbox. 

• 	 Now, trace the outline of the astronaut while holding down the left mouse 
button to select the entire image as a brush. You don't need to be exact in 
your tracing, just cut him out quickly. When you release the mouse button, 
you have the astronaut as a brush. 

You probably won't be able to see the brush itself because the two screens and 
the brush are using up a lot of memory, but Paint allows you to select this large 
brush anyway, and shows you how big it is bydisplaying a rectangle ofthe same 
dimensions. In the next steps you'll paint the brush into the helmet. 

• 	 Press F9 again to bring back the Title Bar, and select Resize Draw from the 
Brushes menu. 

When you move the pointer back to the painting, you'll see that it is now a large 
cross-hair like the one you use to select a brush. It works the same way, except 
that this option lets you select the area you want to paint the brush into, and then 
puts the brush in that area in the proper size. 

• 	 Move the cross-hair inside the helmet, hold down the left mouse button, and 
drag down and to the right to form a rectangle with the cross-hair that fits 
inside the helmet. Release the mouse button. 
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In a moment, you'll see a small astronaut drawninside thehelmet. As though the 
large astronaut was looking at a companion astronaut, and you are seeing the 
companion's reflection in the faceplate of the helmet. 

This chapter showed you some of the basics of Paint. In the next chapter, we'll 
look at some ofthe more powerful features. In particular, we'll introduce you to 
the Painting Modes in the Mode menu and show you how to use the Palette to 
change your color selection. Before moving on, you might want to load each the 
pictures on the art disk to see what is there. Appendix C, About the Pictures, 
contains brief explanations of how some of the pictures were created. 
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In this chapter we examine the fundamental "elements" that make up Paint. If you have 
some experience with computer graphics software, you may want to use this chapter to 
learn how Paint handles features you may have encountered in other programs. As with 
any other part of this manual, however, you should feel free to skiparound and read only 
those sections that interest you at the time. 

We have classified the elements as follows: 

The Brushes examines Paint's custom brush capabilities. This part looks at the 
various techniques available for selecting and modifying a custom brush. 

The Screen deals with those techniques that affect the entire Paint screen, such 
as magnifying, zooming, screen resolutions, Page Size, and Show Page. 

The Palette looks at Paint's color mixing capabilities and explains the various 
operations you can perform in the Palette Screen. 

TheTools looks at advanced tool techniques, and shows how to customize some 
of the standard tools to create just the right tool for the job. 

The Paint Modes briefly introduces how the modes affect the way paint is 
applied to the page. 

Text shows how to enter text, and how to move it about the page. 

WHAT YOU'LL NEED 

To complete the examples in this section, you'll need your working copies of the 
DeluxePhotoLab program disk and art disk. If you want to save your work, 
you'll need an initialized disk with a fair amount of available space for saving 
large files. 

• 	 To begin this section, start Paint and open a single Hold And Modify 
Interlaced screen. Ifyou already have the program running, we recommend 
that you restart so that the tools and option settings are all set to their 
defaults. 
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a THE CUSTOM BRUSHES 


As you saw in the Guided Tour in Chapter One, Paint's "anything can be a 
brush" feature lets you select any image on the screen and define it as a brush. 
Thus, you can keep a selection of images on a dear area of the screen (or open a 
second screen for your brushes) and move them over to your work area by 
picking them up as brushes. In addition, you can load and save brushes in their 
own files, just as though they were pictures. 

CREATING ARECTANGULAR BRUSH 

To create a brush out of an on-screen image: 

• 	 Click the top half of the Brush Selector (the scissors tool) with the left mouse 
button. The icon changes to resemble a pair of facing backets ( ]. 

• 	 Hold down the left mouse button, and drag the large cross-hair to form a 
rectangle around the image. When you release the mouse button, an exact 
copy of the image is attached to your cross-hair. 

You can now paint with your new brush just as you would with any of the built
in brushes (though painting with a custom brush is noticeably slower). 

You can drag the Brush Selector cross-hair to select an on-screen image using 
either the left or the right mouse button. As we have already seen, when you use 
the left button, Paint makes a duplicate of the image and attaches it to the cross
hair, while leaving the original image in place on the page. We also saw that if 
you use the right mouse button to surround the image, the image itself becomes 
the brush, as if the original image had been lifted up off the page. This technique 
provides an ideal method for picking up images and moving them around the 
page as you experiment with different compositions. 
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CREATING AN IRREGULAR SHAPED BRUSH 

As we saw earlier, clicking the top half of the Brush Selector with the left button 
lets you drawa rectangle around any imageonthe page. Oickingthebottom half 
lets you corral any image, thereby letting you pick up shapes from a "crowded" 
background. To corral an image: 

• Click the bottom half of the Brush Selector. It becomes highlighted but the 
icon remains a pair of scissors. 

• Outline the image you want, just as if you were drawing around it with the 
Continuous Freehand tool (see ''The Toolbox" in Chapter One). As soon as 
you complete the outline, the complex shape becomes your new brush. 

Note thatthe left button-right button convention works here as well: corralling 
the shape with the left button duplicates the shape, while corralling with the 
right button lifts it up off the background. Note also that if you release the mouse 
button before you reach the starting point of your outline, a straight line from the 
cross-hair position back to the starting point completes the shape. 

DRAWING ABRUSH 

There is yet another way to select a custom brush for painting. The Grab Last 
option in the Brush menu takes whatever you drew in your last painting action 
and uses it as a custom brush. Try it out. 

• 	 Simply paint on the page and then select Grab Last from the Brush Menu. 
You can even paint with a custom brush and select Grab Last to create a 
more complex brush. 

That still isn't everything! If you hold down Shift when you select Grab Last, 
you'll select what is beneath the area you painted onto. This feature lets you 
select complex brushes using the tools as stencils. For example, you could paint 
over an area with the Filled Oval tool, then select Grab Last with the Shift key to 
select the area as a brush. Once you have your brush, simply click UND to 
remove the solid circle you painted. 
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THE BACKGROUND COLOR IS TRANSPARENT 

When you pick up a custom brush (with either the left or right button), you will 
notice that any part of the brush which matches the current background color 
appears transparent. For example, ifyou pick up a round image sitting on the 
background color, you pick up part ofthebackground as well (because the Brush 
Selector picks up rectangular shapes), but when you move your newbrush over 
to a contrasting image, the brush contours will appear round and not rectangu
lar. This is because Paint treats as transparent any color that was designated as 
the background color when the brush was created, which means you can create 
a brush out of a complex image (such as intricate lace, for example) and be able 
to see through it to other images behind the brush. The transparent parts of your 
brush remain transparent, even after you change background colors. 

There's a little more to the story than what we just told you. You can actually 
choose whether or not the background color in your brush will be transparent. 
Transparency is an option in the Preferences submenu in the Options menu. 
Normally, you will want to have Transparency selected as active (indicated by 
a check beside the option). Then you can make different parts transparent or not 
simply by changing the current background color. But if you are painting in 
HAM mode, it may be difficult to find a color that isn't used in the area you want 
to select. (This is especially true if you are working with a full-color digitized 
image.) In this case, it is much simpler to turn Transparency off, so that you can 
be sure of grabbing all of the image you want for your brush. 

ABRUSH IS ALlTILE PICTURE 

You can treat brushes just like full pictures. Brushes even have their own menu 
(the Brush menu, the second one from the left), from which you can Load and 
Save brushes just as you can other pictures. When you load a brush, it comes 
equipped with its own palette, the one that was in effect when the brush was 
saved. If the current picture is using a palette different from that of the newly
loaded brush, you can change the picture's palette to the brush's palette by 
selecting Use Brush from the Palette option of the Project menu. On the other 
hand, if you want to use the newly-loaded brush with the current palette, select 
Remap from the Brush menu. This is especially useful if you load a brush that 
was created in a display mode with a different number of colors. The other items 
in the Brush menu let you resize, rotate, and even print brushes. 
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• 	 To load a brush, select Load from the Brush menu. This brings up a Load 
Brush Requester, similar to the Load Picture Requester you used when you 
loaded a picture in the Guided Tour (see Chapter One). 

BRUSH ROTATIONS 

Once you've selected or loaded a custom brush, you can rotate it in oneofthe four 
ways listed in the Rotations submenu of the Brush menu. The four rotations are: 

Vert Flip (Vertical Flip) 
Horz Flip (Horizontal Flip) 
Rotate 90 

Rotate Free 


The first two options simply flip the brush either vertically or horizontally. 
Rotate 90, rotates the brush 90 degrees to the right. Rotate Free lets you rotate the 
brush any number of degrees to the right or left. Because Amiga pixels are not 
square, rotating the brush will also distort it. 

As an example of rotation, do the following: 

• 	 Select a brush that is asymmetrical so that you will be able to tell whether 
or not it has been flipped or rotated. A flag and the numeral 4 are good 
examples of images that display any change in orientation. 

• 	 Select Rotate Free from the Rotations submenu in the Brushes menu. 

Your brush changes to a rectangle with a triangle inside. The triangle indicates 
the top ofthe brush. The pointer is attached to the centerofthe rectangle by a line. 

• 	 Rotate the rectangle by pressing the left mouse button and moving the 
pointer down and to the left. 

As you rotate the rectangle, it stretches and contracts to indicate the distortion 
to the actual brush. 

• 	 Release the mouse button. 

Your brush is now attached to your pointer and ready for painting. 
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HANDLE 


This feature, which is available from the Brush menu, allows you to specify 
whether your cross-hair will sit at the center of your custom brush, or at some 
point offset from the brush. In the default setting, the cross-hair sits at the center 
of the custom brush. 

• 	 After you select Handle, you can press the mouse button and drag the cross
hair to any position you like; releasing the button sets the cross-hair in that 
position relative to the custom brush. 

B THESCREEN 


Some of Paint's features affect the entire screen, while others, such as the tools 
and the brushes, affect the screen selectively. This section considers those 
features that have a screen-wide effect. 

HIDING THE TOOLS, THE MENU BAR, AND THE POINTER 

Paint lets you paint on the entire screen, even under the Toolbox and the Menu 
Bar. 

• 	 To hide the Toolbox, press the FlO key. To hide the Menu Bar, press F9. 
Pressing these keys a second time displays the Toolbox or Menu Bar. By 
using these two keys, you can selectively display or hide either the Toolbox, 
the Menu Bar, or both. 

When the Menu Bar and Toolbox are hidden,you can still use many ofthe menu 
options and all of the tools through the keyboard equivalents. See the Reference 
section of this manual for a list of keyboard commands. 
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When you paint with a small brush for fine details, you'll often want to hide the 
cross-hair, so that you can see all of the area you are working on and the exact 
position of the brush. 

• 	 To hide the cross-hair press F8 on the keyboard. Press F8 again to bring it 
back. 

MAGNIFYING AND ZOOMING 

As we mentioned in the Guided Tour, youcan magnify anysection of yourwork, 
and view it alongside the standard-sized image. 

• 	 To magnify a section of your work, dick the Magnify tool (the one that looks 
like a magnifying glass). When you move the cursor onto the page, it 
becomes a rectangular outline. Move the outline to the part of the image you 
want to magnify, and click the mouse button. 

You can move around inside the magnified area by pressing the arrow (cursor) 
keys on the keyboard. And you can increase or decrease the amount of magni
fication byclicking on the lower half ofthe icon (now the Zoom tool) with the left 
or right mouse button. 

Another important feature of Magnify, is the ability to separate the pixels so you 
can easily identify how many pixels are in an area, or where one pixel stops and 
the next one starts. The Magnify option in the Options menu lets you set three 
magnification types: Normal sets no pixel indicator, so the pixels all merge 
together smoothly; tines sets a single-pixel line between the magnified pixels; 
and, Dots sets a dot in the corner between magnified pixels, in addition to 
separating the pixels with a single-pixel line. (Note that in HAM mode, there are 
no vertical lines between pixels.) 

• 	 To quit magnify mode, dick the Magnify icon a second time. 
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PAGE SIZE 

In addition to the preset page sizes (320 x 200; 320 X 400), Paint lets you specify 
any height and width through the New Page Size Requester. You can call up this 
requester by selecting Page Size from the Project menu. The largest page size you 
can specify depends on the display mode you are using and the amount of 
memory currently available in the computer. If you try to specify a size larger 
than memory can accommodate, the numbers in the requester revert to their 
previous setting, and the requester does not dose. 

Note: Ifyou are working on a page size larger than the screen, you can preview 
theentire page atany timeby selecting the Show Page command from the Project 
menu. Press the right mouse button or any key to exit Show Page. 

AFFECT 

The Affect option in the Modes men u lets you select which parts of the screen are 
affected by a painting operation. The Affect option presents a submenu with 
three options: All, Foreground, and Background. 

All is the default mode; when it is selected, all pixels in the picture are affected 
by your painting. Ifyou select Foreground, only portions of the picture that are 
not in the background color are affected by your painting. If you select Back
ground, only portions ofthe picture thatare in the background color are affected. 
Since you can change the background color simply by clicking that color in the 
palette with the right mouse button, it is easy to select exactly which pixels you 
want to change in the picture. This feature is especially useful for working on 
pictures with a lot of fine detail. 

Note that Affect does not work in combination with Resize Draw or Load At. 
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SHOW PAGE 

Ifyou are working on a page that is larger than the screen, Show Page lets you 
see a representation of the entire page at one time. There are three options for 
viewing the page. The first two options, Fast and Smooth, show you the entire 
page. You can viewit quickly, as a rough approximation of the page, or you can 
select smoothing, to get a better representation of the picture. The Overscan 
option shows the amount of the page that would appear in overscan mode. 

When you select the Fast or Smooth options, the area of the page that was 
displayed before you selected Show Page appears inside an outline. You can 
move this outline to another area of the page by dragging it with the left mouse 
button. When you return to the normal display, you will see the new outlined 
area on the screen. 

To exit the Show Page function, press the right mouse button or press any key 
on the keyboard. 

SCREEN RESOLUTIONS 

Paint gives you a total of eight different screen resolutions (four basic resolu
tions, each available in either Non-Interlaced or Interlaced mode). And you can 
have multiple screens open at the sametime in different resolutions. As we noted 
in the Guided Tour, you are prompted to select a screen format each time you 
start Paint, through the Display Mode Requester (see Figure 2.1). Each screen 
format has its own limitations and memory requirements. 

The four resolution formats are as follows: 

LOW RESOLUTION: This format uses a pixel array 320 wide by 200 high, and 
can accommodate up to 32 colors on the screen at one time. This level of screen 
resolution is adequate for most graphic purposes. 

HIGH RESOLUTION: This format uses a pixel array of 640 wide by 200 high, 
using pixels that are the same height as the Low Resolution pixels, but only half 
as wide. High Resolution is ideal for putting text on the screen. (See the 
discussion of Text mode below.) Because High Resolution uses pixels of a 
different size and shape, changing screen formats from Low Resolution to High 
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Resolution will affect the shape of your images. Thus, a Low Resolution picture 
loaded in High Resolution mode will look skinny, while a High Resolution 
picture loaded in Low Resolution mode will look fat (and take up two screen 
widths). In addition, High Resolution limits the number of colors available for 
a single picture to 16. 

EXTRA HALFBRITE: This display format uses the same size pixel array as Low 
Resolution (320 x 200), but it provides a palette of 64 colors. The first 32 colors in 
Extra Halfbrite are equivalent to the 32 color Low Resolution Palette. The second 
32 colors are halfbrite equivalents of the first 32 colors. The Palette in Extra 
Halfbrite gives you access to only the first 32 colors, and anychanges made to one 
of those colors is also reflected in the extra halfbrite equivalent. 

Note: Not all Amiga 1000 computers support Extra Halfbrite. The easiest way 
to find out whether or not your computer supports this display mode is to try it. 
Open an Extra Halfbrite screen and look at the Palette (make sure the pointer is 
not in the Menu Bar or Toolbox). If the last 32 colors are the same as the first 32, 
your computer doesn't support Extra Halfbrite. 

HOLD AND MODIFY (HAM); This powerful screen format lets you display all 
4,096 possible colors on the screen simultaneously. The pixel array is the same 
as in Low Resolution (320 x 200), but Paint makes it possible to use all of the 4,096 
colors at the same time instead of only 32. 

INTERLACE: The Interlace option doubles the vertical dimension of the pixel 
array in each ofthescreen formats. For example, Low Resolution Non-interlaced 
mode provides a 320x200 pixel array. Low Resolution Interlaced doubles the 
number of vertical pixels to provide a 320 x 400 pixel array. Interlace pixels are 
the same width but half as tall as non-interlaced pixels, which means that a Low 
Resolution Non-Interlaced picture loaded into Low Resolution Interlace mode 
will look fat. The advantage to Interlace is that it gives you greater vertical 
resolution without reducing the maximum number of available colors. The 
disadvantage is that with most monitors, Interlace produces a flickering effect, 
because it paints the screen in two passes and in each pass paints every other 
horizontal line. The lines painted in the first pass are already fading before the 
lines that were skipped can be painted in the second pass. Thus the lines seem 
to flicker. You can overcome this to some extent by using special "high persis
tence" monitors, which cause the image to persist longer than the rate of flicker. 
Turning down the contrast on a standard monitor also reduces the flicker 
somewhat. 
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II THE PALETIE 

THE PALETIE SCREEN 

The Palette Screen (see Figure 3.1) lets you mix your own custom set of colors 
from a universe of 4,096. 

• 	 To bring up the Palette Screen, press p on the keyboard, or select Adjust 
from the Palette option of the Project menu. 

Figure 3.1 Palette Screen 

As youcan see from Figure 3.1, the Palette Screen is made up of several parts. The 
following is a quick summaryof what each part of the Palette Screen does. In the 
next few pages, we'll explain how to use these features. 

The Title Bar shows the name of the screen, "Paint Palette," and, once you've 
selected a color, it also displays the RGB valuesofthecurrently selected color (the 
color you clicked most recently). 

The RGB or HSV sliders let you modify the currently selected color on any of 
these color components. Clicking the RGB/HSV button Oocated to the right of 
the sliders) toggles the sliders and Title Bar display between RGB (Red, Green, 
and Blue) color components and HSV (Hue, Saturation, and Value) color 
components. If these terms are new to you, don't worry. We'll explain them in 
a moment. 
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The Color Indicator displays the foreground and background color you most 
recently selected. As you change the RGB or HSV values of the color you most 
recently clicked, the new color is also shown in the Color Indicator. 

The 4,096 Color Palette displays all of the possible colors in a sixteen square 
array below the RGB/HSV sliders. You can select a color from this palette simply 
by clicking on the color you want. 

The Palette is a duplicate of the palette in your current picture. 

The Palette Gadgets let you copy and spread colors on the Palette Screen, undo 
th.~ last change you made, or cancel all of your changes. 

TIle Paint Set lets you create large spreads of color and experiment with color 
mixes before you copy the color into the Palette. In HAM mode you can also 
select one of the colors in the Paint Set to paint with directly on the painting 
screen. 

CREATING COLORS 

When you create new colors to paint with, you will usually want to start by 
creating your color in the Paint Set and then copy the color into the Palette. 
Changes you make to the Palette automatically affect the colors in your picture, 
but changes in the Paint Set have no effect onyour picture, so you can experiment 
with a color all you like. Here's how it works. 

• 	 Click a square in the Paint Set to select it. 

(When you click a square with the left mouse button, a solid white frame, called 
theEnd Range Marker, appears around the square. When youclick a square with 
the right mouse button, a dotted frame, the Begin Range Marker, appears. We'll 
explain these markers later in the discussion of ranges. But you should also 
notice that you can use them as a guide to which squares you most recently 
clicked on, and often what your current foreground and background colors are.) 

• 	 Drag the RGB sliders to mix red, green, and blue until you find thecolor you 
want. (Or click the RGB/HSV button to change the sliders to HSV and mix 
a color using Hue, Saturation, and Value.) 

48 




PAINT: THE ELEM 

In RGB color mixing, you combine red, green, and blue color components to 
create a new color. The HSV method provides an alternative approach to color 
mixing, but with identical results. The HSV method breaks each color down into 
its Hue, Saturation, and Value. Hue simply refers to the color's position on the 
color spectrum or rainbow - Red, Orange, Yellow, Green, Blue, or Violet, and 
the various shades in between. Saturation refers to the strength of a particular 
hue - whether it is relatively pure (and hence highly saturated), or whether it 
contains some proportion of white. Thus, the more white, the less saturated. 
Value refers to a color's relative lightness or darkness (sometimes refered to as 
Luminosity). A color with a high value would have little or no black, whereas 
colors with low value would contain more black. Irrespective of Hue and 
Saturation, a Value of zero produces a pure black. 

Another way to get a color into your Paint Set is to select it from the 4,096 Color 
Palette. 

• Click a square in the Paint Set with the left mouse button 

• Point to the 4,096 Color Palette, hold down the left mouse button and move 
the pointer around until you find a color that is approximately the color you 
want. Release the mouse button. 

You can perform this same praced ure by clicking a square with the right mouse 
button, and holding down the right mouse button in the 4,096 Color Palette. 

Once you have a basic color to work with, you can easily use the sliders to get 
exactly the right color. Remember, we showed you how to mix the color in the 
Paint Set because weexpect this is the way you will want to do it most often, but 
you could just as easily mix the color in the Palette portion of the Palette Screen. 

COPYING COLORS INTO THE PALETIE 

Once you've mixed your color with the RGB/HSV sliders, you might want to 
copy that color into your Palette. To copy a color: 

• Click the color square you want to copy from with the left mouse button. 
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This makes the color you clicked yourcurrent foreground color, as shown in the 
Color Indicator. 

• 	 Click Copy. 

• 	 Click the color square you want to copy to with the left mouse button. 

This Copies the current foreground color into the squareyouclicked. Ifyou click 
Copy and then click a square with the right mouse button, you will copy the 
current background color into the square. 

You can copy colors from any square in the Palette Screen to any other square in 
the Palette Screen. Since you are able to load and save Palettes and Paint Sets (as 
we'll explain in a moment) this is a very powerful feature. 

COPYING COLORS FROM THE PICTURE 

Copying colors from the picture into your palette or Paint Set is the same as 
copying another color in the Palette Screen, except that you replace the first step 
with picking the color off the screen. 

• 	 Click the Color Indicator in the picture's Palette to get the Pick pointer. 

• 	 Click a color in the picture using the left mouse button to pick a foreground 
color. Notice that both Color Indicators (the one on the picture screen and 
the one in the Palette Screen) show the new color you clicked. 

• 	 Now click Copy and click a box in the Paint Set to copy the color to. 

Thecolor you selected is nowin yourPaintSet. Therule to remember is thatCopy 
always copies the color that appears in the Color Indicator. Your first step is 
always to get the color you want into the Color Indicator, either by selecting it in 
the Palette Screen, or selecting it from the Picture. 
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PAINT: THE ELEMENTS 


INDICATING ARANGE OF COLORS 

The Palette Screen also lets you indicate a range, which is used in Paint's 
Gradient Fill function. A range is made up of all the colors between the Begin 
Range and End Range Marker. To select a range: 

• Click the first color in the range with the right mouse button to set the Begin 
Range Marker, which is a dotted frame around the color box 

• Click the last color with the left mouse button to set the End Range Marker, 
which is a solid frame around the color box. 

When youuse your range as a fill, therangeofcolors is always used inorder from 
beginning to end. This means that you can reverse the direction of the gradient 
by reversing the position of the markers. 

Note: your range cannot cross between the Palette and the Paint Set in the Palette 
Screen. Both the Begin and End colors must be selected from the same portion of 
the Palette Screen. 

CREATING ASPREAD OF COLORS 

Spread lets you quickly produce a spread of colors between the current Begin 
Range and End Range Markers. To do this, you define a range and select spread 
to create the spread between the two markers. 

• Click the first color for your spread with the right mouse button. 

• Click the last color for the spread with the left mouse button. 

• Then click the Spread gadget to create a spread between the two markers. 

You can create the spread either in RGB or HSV mode. The results of the two 
spreads differs due to the way the spreads are calculated. In RGB mode, the 
colors are spread based on the numerical values of each of the three color 
components without regard to the position of colors on the color wheel. In HSV 
the spread is cakulated based primarily on the hue component of thecolors, and 
the spread always moves clockwise around the color wheel. (SeeAppendix A for 
a brief discussion of color theory.) 
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For an example of how the two spreads differ, do the following: 

• 	 Set the mode to HSV. 

• 	 Click the first color in the Paint Set with the right mouse button. Set the Hue 
to 0 and the Saturation and Value each to 15. 

• 	 Now, dick the last color in the Paint Set with the left mouse button. Set it's 
Hue to 240 and the Saturation and Value to 15. Oick Spread. 

The resulting spread runs through the orange, yellow, and green hues to reach 
Blue. 

• 	 Change the mode to RGB and dick the Spread gadget. 

Note that your spread runs from Red to Blue without passing through anyof the 
other colors. 

PAINTING WITH PAINT SET COLORS 

Painting with colors in your Paint Set is as simple as painting with the Palette 
colors. Click the color you want and paint with it. (Remember that if the Palette 
Screen is not active, you have to dick once to activate the screen, and a second 
time to pick the color. The Begin Range or End Range marker will appeararound 
the color box when you dick it.) 

Ifyou are working in HAM mode, the Paint Set color you dicked is painted onto 
the picture. Ifyou are working in anyother mode, only Palette colors can be used 
in the picture; Paint will choose the Palette color that is dosest in shade to the 
Paint Set color you clicked and paint with that Palette color. 
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PAINT: THE ELEMENTS 


LOADING AND SAVING PALETTES AND PAINT SETS 

Ifyou create Palettes or Paint Sets that you especially like, you can save them on 
disk by using the Save option in the Palette or Paint Set submenus in the Project 
menu. Later, you can load the Palette or Paint Set to use with a different picture. 
(you can also load Palettes from other pictures or brushes, because the Palette is 
saved with pictures and brushes, and Paint can extract the Palette information 
from a picture or brush file.) 

Saving and loading Paint Sets is especially useful, because these colors do not 
automatically affect the picture. You can load a Paint Set and select only the 
colors you want to use, without inadvertently changing the colors you already 
have in the picture. 

THE THREE PALETTES 

When you are working in Paint, there are as many as three palettes available to 
be used with the picture. These three palettes are the picture palette, the brush 
palette, or Paint's default palette. The Palette submenu in the Project menu lets 
you choose which palette you want to use at any given time. 

When you first start Paint, you have only the default palette. Once you load in 
a picture (or load a palette separately), you have two palettes: the default palette 
and the picture palette. If you then load in a brush, you have three palettes: 
default, picture, and brush, and you can switch among them freely. 

THE COLOR PALETTE AND SCREEN FORMATS 

Aswe noted above, Paint contains a universe of 4,096 colors, from which you can 
useup to4,096 at any given time. This is the case with the HAM formats; the other 
formats (Low Resolution, High Resolution, and Extra Halfbrite) allow fewer 
colors on the screen at one time. Depending on your memory availability, Low 
Resolution lets you use up to 32 colors, High Resolution lets you use up to 16 
colors in one picture, and Extra Halfbrite lets you use up to 64 colors. See "Screen 
Resolutions" in this chapter for information on the various screen formats. 
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II 	THE TOOLS 


Paint's painting tools are available through theToolbox, the panel at the top area 
of the screen. As we have already seen, you can activate any tool by clicking its 
icon with the left mouse button. A tool remains active (and its icon highlighted) 
until you select another tool or, in the case of Magnify, deselect it by clicking the 
icon a second time. 

MODIFYING TOOLS 

In most cases, clicking a tool icon with the right mouse button lets you modify 
some fundamental aspect of that tool. The following summarizes the effects of 
right-button mouse clicks on the tools in the Toolbox: 

THE AIRBRUSH: The Airbrush works with any of Paint's built-in brushes, or 
with a custom brush of your own creation. 

• 	 You can adjustthe Airbrush's nozzle by clicking the Airbrush icon with the 
right mouse button, moving the cursor over to the painting area, and then 
pressing the left mouse button and dragging to adjust the size and shape of 
the solid oval, which represents the spray area. Release the mouse button 
when the solid circle is the desired size. 

OOITED AND CONTINUOUS FREEHAND, LINE, AND CURVE TOOLS: A 
right-button click any of these tools restores the built-in brush you used most 
recently. This is especially useful if you want to switch back and forth between 
a custom brush and a built-in brush. See Brush Selector later in this section. 

FILL AND FILLED SHAPE TOOLS: Clicking the Fill portion of these icons with 
the right mouse button brings up the Fill Control (see Figure 3.2), allowing you 
to specify the type of fill to be used by these tools. The following is a summary 
of the Fill Control's features: 

Solid Color fill is the default Fill Type and simply fills with either the foreground 
or the background color. 
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Brush Pattern fills shapes with a recurring pattern of your custom brush. (The 
affect is as though the screen were filled with a recurring pattern of the custom 
brush, but the pattern is hidden beneath your picture. The fill operation reveals 
the hiddden brush pattern.) The pattern is normally based on the original 
position of the brush you selected from the screen, but the Fill Offset option lets 
you set a new position for the pattern. 
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Figure 3.2 Fill Control 

Trace Edges, adds a one-pixel outline to every edge of the item being filled. 
Again, the tracing is done in either the foreground or background color depend
ing on the button pressed. 

You can also choose to lay down your custom brush or a range of colors in 
different ways. 

• 	 Click Gradient and then dick the box below Gradient Type until the name 
of the gradient type you want appears. (The gradient types are explained in 
full in the Reference section, but the best way to understand them is to use 
them.) 

Whichever kind of gradient type you choose, you can adjust its dither, the 
amount of random overlap between each shade, bydragging the dither slider left 
or right. You can monitor the current dither setting in the box below the slider. 

• 	 Whenyouare done selecting a Fill Type, click OK to use the current settings, 
or Cancel to return to your work without making any change. 
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BRUSH SELECTOR: Clicking the Brush Selector with the right mouse button 
restores the last captured brush. Thus, if you had created a custom brush (see 
Part 1 of this chapter for detail~) and then made some modifications (for example, 
rotating the brush), clicking the Brush Selector with the right mouse button 
would restore the previous (unrotated) custom brush. This feature is also useful 
if you create a custom brush and then select a built-in brush. 

TEXT TOOL: Clicking on the Text Tool with the right mouse button brings up 
the Load Font Requester for you to load a new font into your font list. To load a 
font, simply click it's name in the requester. Ifyou have more fonts available than 
can be displayed at one time, use the scroll bar to scroll through the list of 
available fonts. 

When you bring up the Load Font Requester, Paint looks in the directory 
Sys:Fonts on your start-up disk. Any fonts you wish to use must be in the Fonts 
directory of the disk you use to start the computer. The fonts provided with 
DeluxePhotoLab are kept in the Fonts directory of the DeluxePhotoLab pro
gram disk. If you have fonts you wish to add, be sure you add them to that 
directory. 

Load Font 
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Figure 3.3 Load Font Requester 
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PAINT: THE ELEMENTS 

II 	THE PAINT MODES 

The options in the Paint Mode submenu of the Modes menu let you make subtle 
changes to the way paint is laid down on the page. The default Paint Mode is 
Solid. This mode simply paints with the color as you selected it. The other modes 
(except HLF and B&W) use the color values of the brush and the picture to calculate a 
new color to be placed on the picture. 

For a quick example of one of the painting modes: 

• Check that Solid is the selected mode, click the second red in the default 
Palette with the right mouse button to make it the background color and 
click CLR to make the page solid red. 

• Click a green for the foreground color and draw a filled rectangle of green. 

Because Solid is the painting mode, the rectangle is painted in the green you 
selected. 

• 	 Nowselect A veragefrom the Paint Mode submenu and draw another green 
rectangle. This time the color values for the red and green colors you are 
using were averaged, and the rectangle was painted with the new average 
color. 

This example assumes you are following this chapter in HAM display mode as 
we suggested. Ifyou were using any other mode, the rectangle would be painted 
with the color in your Palette that most closely matched the average. 

The next chapter contains a tutorial which illustrates several of the painting 
modes, and the modes are also described in detail in the Reference section. See 
the section covering the Mode menu for more information. 
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Paint's text editor lets you place text anywhere on the page, and the Brush 
Selector lets you pick it up and reposition it if you didn't have it quite right the 
first time. 

• 	 To enter text on the screen, click the Text icon with the left mouse button. 
You can also choose to enter text in Italic, Bold or Underline, by making the 
appropriate choice from the Style submenu of the Fonts menu. 

• 	 When you move the pointer over to the painting area, it becomes a small 
rectangular cursor. Click either mouse button where you want the text to 
begin, and start typing. 

You can press Return to start a new line directly below the point where you first 
placed the cursor. Ifyou type pastthe edge ofthe screen, no letters are placed on 
the picture past the screen edge, but you can backspace or press Return to move 
the cursor back to the screen. You can delete text by using the Backspace key. 
Note, however, that if after entering a portion of text you click the cursor 
elsewhere on the screen, press Return, or select a tool from the Toolbox, that text 
becomes part of the picture, and no longer behaves as text. In other words, you 
cannot Backspace over it as you could when it was still active as text. 

Because HAM mode places colors onthe screen bymodifying the previous pixel, 
typing text on an area of the picture that is composed of HAM pixels may cause 
"fringing." This may make the text completely unreadable if the area is exclu
sively HAM pixels, since Paint can't go back and clean up the fringing created 
by the Text tool. However, if you place text onto the screen as a brush, Paint 
corrects thefringing automatically . Ifyou need to place text on an area ofHAM pixels, 
first type the text on an area ofregister colors, then cut out the text and paste it onto any 
area you like. The best method is to type the text in aLow Resolution 3/4 screen and paste 
it into HAM. 

In the next chapter you will learn a number of practical techniques, through a 
series of tutorials, to help you get the most out of Paint. The tutorials are simple, 
step-by-step exercises, designed with the assistance ofprofessional Paint artists. 
You won't know how powerful Paintcanbe until you try it for yourself. And you 
don't even have to get your hands dirty. 
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PAINT: TUTORIALS 

This chapter takes you through some step by step tutorials on some ofthe more advanced 
features ofPaint. We encourage you to follow the steps closely, and as soon as you think 
you understand what is happening, experiment on your own. Our explanations won't 
be exhaustive, and you will very likely find exciting things to do with the features you 
see here. 

WHAT YOU'LL NEED 

To complete these tutorials, you'll need your working copies of the DeJuxe
PhotoLab program disk and art disk. Ifyou want to save your work, you'll need 
an initialized disk with a fair amount of available space for saving large files. 

• 	 To begin these tutorials, start Paint and open a single Hold and Modify 
Interlaced screen. If you already have the program running, we recommend 
that you restart so that the tools and option settings are all set to their 
defaults. 

II THE PAINT MODES 

As we explained in the previous chapter, The Elements, the Paint Modes affect 
the way paint is applied to the picture. These modes affect all drawing tools 
(though they will not affect a Resize Draw). Usually, you will want to use a Paint 
Mode to achieve an unusual affect with a custom brush. Sometimes you will 
simply want to subtly color an area of the picture. The mode you choose will 
depend on many factors, the most important being the desired outcome, the 
original colors in the picture, and the colors in the brush. 

In this tutorial, we'll take you through some simple Paint Mode effects. Hope
fully these will give you some ideas of your own. 

• 	 To begin/load the picture Pinball from the art disk. You'll find this picture 
in the HAMx400 drawer. 

This picture offers some good opportunities for changing the colors ofa picture. 
We'll use three colorizing techniques. The first ofwhich is to add a flesh color to 
the hands. 
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ADDING COLOR TO THE HANDS 

• 	 Select Add from the Paint Modes submenu. 

Add takes thecolorofthebrushand adds it to thecolorofthe picture. This means 
that everything in the area you paint will become slightly lighter. (As you add 
one color to another, the color approaches white, which has the values R15 GIS 
B15. Usually you will want to add a dark brush color - one with very low color 
values - so that you don't wash out the picture.) 

• 	 Press P on the keyboard to bring up the Palette Screen. 

• 	 Click the first color in the Paint Set with the left mouse button. 

• 	 Use the sliders to set the RGB color values to R3, Gl, BO. 

• 	 Press P again to hide the Palette Screen. 

Nowyou have a color readyto paint with. Notice that as expected, wechosevery 
low color values. 

• Select the Freeform Shape Tool (If you've been using the program, be sure 
your fill is set to Solid.) Carefully outline each hand so it is filled with the new 
color. 

The pair ofhands nowhas a light flesh tone that preserves the detail ofthe hands. 

COLORING THE TABLE 

"And" is also an effective colorizing mode. We'll use this mode to add color to 
the grid-like table. 

Select And from the Paint Modes submenu. 

• 	 Press P to open the Palette Screen. Oick the first color in the Paint Set with 
the left mouse button and set the RGB values to RO GIS BO. Press P to hide 
the Palette Screen. 
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• 	 Select the Filled Polygon tool, and outline the grid-like table. (Since this is 
only an example, don't wony about being exact as you outline.) 

In a moment, the table is colored green, but the detail of the grid lines is 
preserved. The And mode usually works best with fully saturated colors. Try 
some different colors to see the results ofother combinations. Remember, seeing 
is the best test when working with Paint Modes. The Repeat command makes it 
easy to try many combinations. Here's how: 

• 	 Click Undo. Bring up the Palette Screen and change your color. Hide the 
Palette Screen. Press R on the keyboard to repeat your most recent painting 
operation (which was to fJ11 the table). 

When you've found a color you like, just leave it as it is, and move on to the next 
example. 

AGOLD BALL 

Sometimes you'll want to usemore than one Paint Mode toachieve theeffectyou 
want. In this example we'll use three together to change the pinball to a gold 
color. We'll start by removing all of the color from the ball. 

• 	 Select the B&W Paint Mode. 

(Wi th Black and White, itdoesn't matter what color you select, because the brush 
is not used to calculate the new colors in the picture. Black and White simply 
removes the color from the area you paint on.) 

• 	 Use either the Freehand Shape tool or the Filled Oval tool to paint over the 
Pinball. 

This simple step changes the pinball to black and white. Now we'll mix in some 
yellow. 

• 	 Press Ptobring up the Palette.Seta Paint Set color to R15G15 BO. This is pure 
yellow. Hide the Palette. 

• 	 Select Mix from the Paint Modes submenu. 

61 




PAINT: TUTORIALS 

• 	 Press Ron the keyboard for repeat. 

Remember, if you want to paint an area more than once. Just press R to repeat 
your last painting action. Now we'll turn down the brightness of the ball by 
subtracting a gray level. In HSV terms, this reduces the Value of the color. 

• 	 Bring upthepalette. Set a color Rl Gl B1. (This is the lowest level gray.) Hide 
the Palette. 

• 	 Select Sub from the Paint Modes menu. 

• 	 Press R to paint over the area again. 

This is the last change we'll make to the Pinball picture. Now that you have an 
idea of how the Paint Modes work, you might want to load some of the other 
pictures and experiment. For example, you could load PackageCover and 
achieve an interesting effect by using B&W on the window and the light cast on 
the floor in the picture. 

B 	THE SHADE CONTROL 

Shade mode is a special case of the Paint Modes. This mode lets you customize 
the mode so that the paint is applied in gradual shades. As with most of the 
tutorial matter, this is difficult to understand without seeing it on the screen. 
We'll start with a few simple examples, and then show you a practical use for this 
feature. 

• 	 Select Use Default Palette from the Palette Submenu. Select black (Color 0) 
as your background color, and clear the screen to black. 

• 	 Select Shade from the Paint Mode submenu. 

When you first start the program, theShade Control has default settings in place, 
so you'll be seeing the effect of these default settings in this first example. 

• 	 Select bright red (Color 2) as your foreground color. Select the Filled 
Rectangle tool and paint a large rectangle (at least one quarter the screen 
size) on the left side of the screen. 
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Paint takes a moment to paint this rectangle on the screen. When it is complete, 
you see a rectangle with manybands of different red shades in it. The red shades 
are darkest at the outer edge of the rectangle; they become gradually light eruntil 
they reach the original shade you selected, which appears as an irregular shape 
in the upper right quarter of the rectangle. Figure 4.1 shows a black and white 
representation of what you should see on the screen. Ifyou move the pointer up 
into the Menu Bar,the division between shades becomes very obvious. 

Figure 4.1 Filled Rectangle Using Shade Mode 
(black and white representation) 

Now that you've seen what the Shade Control does, let's take a look at how it 
does it. 

• Select Shade Control from the Options menu. 

This brings up the Shade Control. (SeeFigure 4.2 below.) Before you do anything 
else, take a close look at the gadgets in the Shade ControL 
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Shade Control 

Highlight: 

IPoint
• _.Di the!'; 8 
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Figure 4.2 The Shade Control 

HIGHLIGHT POSITION 

Notice that the dot in the upper right comer of the Highlight Position gadget of 
the Shade Control corresponds to the bright area in the rectangle you painted. 
You can move this to change the position of the highlight when you paint with 
Shade. Let's do it now to see how it works. 

• Point to the dot in the Highlight Position gadget. Hold down the left mouse 
button and drag the dot down to the lower left comer of the gadget. Click 
OK in the Shade Control. 

• Paint another large rectangle. (If there is enough room, leave the original 
rectangle in place; otherwise clear the screen to make room for your new 
rectangle. 

Once again you have a rectangle painted in several shades of red. But this time 
the brightest area ofthe rectangle is in the lower left comer, just as you indicated 
in the Shade Control. 

DITHER 

So far you have been working with distinct bands of color. The Shade Control 
also lets you vary the amount of dither between bands in your shaded area. 

• 	 Select Shade Control from the Options menu. 

• 	 Drag the Dither scroll box one fourth of the way to the right. (The number 
above the scroll bar should be about 25.) Oick OK. 
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• 	 Paint another large rectangle. 

Dither is the random mixing ofcolors. You instructed the Shade mode to mix the 
colors at the edges of your shades. The result is a smoother look to the fill. One 
area is still brighter than the outer edges, but the separation between shades is 
not very noticeable. If you'd like to see the dither, select the Magnify tool and 
magnify the area near where youexpect the edge of the brightest shade to be. Be 
sure to turn off Magnify when you're done. 

HOW HIGH AND HOW LOW 

• 	 Select Shade Control from the Options menu. 

Below the Dither slider in the Shade Control, there are two sliders for setting the 
amount of paint to be applied at the Highlight and the amount of paint to be 
applied at the points farthest from the Highlight. The shades are calculated as 
bands of color between these two extremes. 

Take a look at the settings for the High and Low sliders. At the moment, High is 
set to 100%, which means that at the Highlight, the full value of the color is 
applied to the picture. The Low slider is set to 0%, which means that at the points 
farthest from the Highlight, 0% of the color is applied to the picture. The shades 
are calculated as intermediate values between 100% and 0% of the color. 

Let's try an illustration of what the lasttwo paragraphs above are trying to say. 

• 	 Drag the Low slider all the way to the right so that the number beside Low 
is 100%. 

• 	 Drag the High slider all the way to the right so that the number is 0%. 

• 	 Click OK. 

• 	 Paint another large rectangle. 

Your rectangle should be brightest in color in the upper right corner and darkest 
in the lower left. Remember that the Highlight point was placed. in the lower left 
corner. This last rectangle dearly shows that High sets the amount of color used 
at the HighIight, and that thesettingcan befor less color than at the outer regions. 
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MORE HIGHLIGHTS 

Throughout this discussion, you've been looking at the Shade Control with the 
Highlight set to Point. There are three other highlight types you should know 
about. 

• 	 Select Shade Control from the Options menu. 

• 	 Click Point to change the setting to Vertical. 

Vertical changes the Highlight to a bar across the Highlight Position gadget. The 
bar runs horizontally, but the setting is Vertical, because the shades will radiate 
outward from the bar in a Vertical fashion. 

• 	 Click Vertical to change the setting to Horizontal. 

Now the Highlight is a vertical bar, and the resulting shade would radiate 
outward from the bar in a Horizontal fashion. 

• 	 Click Horizontal to change the setting to All. 

All changes the Highlight so that the entire Highlight Position gadget is high
lighted. In this setting, the area you paint receives an even amount of the color 
value, and the amount of color applied is the average of the High and Low slider 
settings. The result is that you have complete control over what percent of the 
color is applied to the picture. (Note that because the entire area is highlighted, 
there are no bands of shading when you paint.) 

ATTACK OF THE HUNTERS 

Now that you've seen how the Shade Control works, this section quickly runs 
through a practical example. In this example, you'll combine a picture and a 
brush from the art disk using the Shade requester. 

• 	 From the DeluxePhotoLab art disk, load the picture The Hunters. (It is in 
the HAM x 400 directory.) 
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• 	 Select Load from the Brush menu and load Godzilla.Brush. (Also in the 
HAM x 400 directory on the art disk.) 

Now you have the picture and the brush you want to combine. The trick is to set 
the Shade control so that when you stamp down the Godzilla brush, he appears 
to be in the douds, just as theGodzilla in the picture seems to be up in the douds. 

• 	 Select Shade Control from the Options menu. 

• 	 Set theHighlightto Vertical and placethe bar in the middle ofthe Highlight 
Position gadget. Set Dither to O. Set Lowto 75%. Set High to 45%. Click OK. 

• 	 Position the Godzilla brush along the bottom of the mountain on the left, so 
that the head is over the douds. (If you haven't put a handle on your brush, 
the coordinates are 0072 and 0091; the brush has been cut out to roughly 
match the contours of the mountain in the correct spot.) Stamp down the 
brush. 

Now the picture contains a second Godzilla coming from around the mountain. 
The Shade mode let some ofthe clouds mix with thebrush so that thehead seems 
to be in the douds. You can add more clouds if you like. 

Thiswas a simple example ofShade. You can see that theoriginal Godzilla in this 
picture was also added to the picture using shade. If you would like to see 
another example,load the picture PhotoGirl; the fading at thebottom ofthegirl's 
dress was done using Shade. 

This tutorial looks at one of the brush fills available in the Fill Control. Brush 
Warp is especially interesting because of the bizarre effects it can produce; DaIi 
should havehad itso good. After you work through this example, feel free to try 
some ofyourown; the Fill Control is one feature that can never be fully explored. 

• 	 Before you begin the example, make sure that your Paint Mode is set to 
Solid. 
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BRUSH WARP 

• 	 Load The Hunters from the DeluxePhotoLab art disk. 

• 	 Select the hunter (including his gun and the small reptile) as a brush using 
the rectangle Brush Selector. 

• 	 Click the Fill tool with the right mouse button to open the Fill Control. 

• 	 Select Gradient as your Fill type and click the Gradient Type gadget until it 
is set to Brush Warp. Oick OK. 

Now the Fill type is set to use your custom brush. We'll paint some different 
shapes using the brush to see how it reacts. 

• 	 Select the Filled Oval tool and paint a filled circle about two inches in 
diameter. 

Painting the hunter into a circle with Brush Warp makes it appear as though he 
is trapped inside a bubble. Ifyou draw a series of bubbles with the largest one 
near the bottom ofthe screen and the others shrinking gradually as you move up 
the screen, it will look as though he is floating away. 
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PAINT: REFERENCE 

This chapter sumrtlllrizes all of the commands and functions in Paint. Because this 
chapter is intendedfor referenceonlyand notas afIJfl}f to learn thefundRmentalsofPaint, 
the descriptionsare as concise as possible. Ifyou read an entry in this chapter, but don't 
fully understand how the feature works, check the Index to see ifthe feature is explained 
with eXllmples in one of the earlier chapters. 

The information in this reference is grouped into several general categories: 

Starting Paint explains the three ways you can start the program from the 
Workbench and how to select a display mode. 

The Painting Screen explains the basic parts of the Painting Screen. 

The Palette Screen explains each part of the Palette Screen and how to use it. 

The Toolboxbrieflyexplains each of the tools in order reading from left to right 
across the Painting Screen. 

The Menus covers each of the menu items in order working from left to right 
across the screen and top to bottom down each menu and submenu. 

Memory Management gives tips on how to recognize a low memory condition 
when working with Paint, and suggests ways to free memory . 

There are three ways that you can start Paint from the Workbench. 


Method 1: Double-click the Paint icon and then choose a display mode. 


Method 2: Click a Picture icon to select itj then hold Shift and double-click the 

Paint icon. This starts Paint and loads the selected picture in the proper display 

mode and page size. 


Method 3: Double-click a Picture icon. 
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Method 3 is identical to Method 2 except that Workbench win look for Paint on 
the volume named "PHOTOLAB:".1f "PHOTOLAB:" is nota currently assigned 
volume, you are prompted to insert a disk with that name. If you are running 
DeluxePhotoLab from a hard disk or from a floppy with some other name, you 
can issue an "ASSIGN PHOTOLAB: <hard disk name>:<directory name>" 
command from either the CLI (Command Line Interface) or in your ST ARTUP
SEQUENCE file. (For example, ifyou are running Paint from the DeluxePhoto
Lab directory on your hard disk DHO:, you would add the line: 

ASSIGN PHOTOLAB: DHO:DeluxePhotol..ab 

to your STARTUP-SEQUENCE file. 

EJ THE DISPLAY MODE REQUESTER 

. When you first start Paint, you see the DisplayMode Requester for selecting the 
display mode in which you want to createor load your pictures. You can change 
the settings in this requester simply by clicking on the appropriate area. Once 
you'veselected the display modeyou want, click Open to open a painting screen 
with those settings. 

Figure S.l Display Mode Requester 

NotethattheDisplay Mode Requester appears onaseparate screen, which is also 
the screen for the Palette. If you select New from the Project menu, but do not 
click Cancel or Open in the DisplayMode Requester, you will not have a Palette 
Screen for your existing picture. 
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SCREEN TYPE 

The Screen Type gadget is divided into two sections. 

Clicking on the top half of the Screen Type gadget cycles you through the 
possible screen resolutions; the options are Low Resolution, High Resolution, 
Extra HalfBrite, and Hold and Modify. 

Clicking on the bottom half of the Screen Type gadget toggles the selection 
between Non-Interlaced and Interlaced. 

DEPTH 

TheDepth gadget lets you selecthow manybit planes the display mode will use. 
(The number of bit planes determines how many colors a Screen Type can 
support. Appendix B, IIAmiga Display Modes" explains the relationship be
tween the numberofbit planes and the number ofcolors available.) The number 
of planes you can select depends on the Screen Type you selected. For example, 
Low Resolution allows any depth setting between 1 and 5. Hold and Modify 
normally uses 6 bit planes, but will support 5. The depth gadget restricts you to 
the acceptable settings, so once you've selected the Screen Type, you can choose 
any number of bit planes that appears in the Depth gadget. 

SIZE 

Lets you select whether the page size will use the full screen or the top 3/4 of the 
screen. The 3/4 screen setting is useful for conserving memory, particularly if 
you want to have two screens open for cutting and pasting. 
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II THE PAINTING SCREEN 


Once you start Paint, select your screen format, and click Open, the Paint screen 
appears. Along the top ofthe screen is the TItle Bar, Palette, and Toolbox. When 
you point to the Title Bar and press the right mouse button, the Menu Bar 
appears. The Menu Bar and menus are explained in detail later in this chapter. 

Figure 5.2 The Painting Screen 

The area below the Toolbox is where you work on your pictures. This area is 
called the page. The normal page size is the same as the screen size. When you're 
page is larger than the screen, you can scroll the page by pressing the arrow 
(cursor) keys on the keyboard. When you use the arrow keys, think of them as 
moving the screen rather than the picture; pressing the down arrow moves the 
screen down, so it looks like the page is moving up. 
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THE TITLE BAR 

The Title Bar lists the name of your picture (in this case Untitled A). It also lists 
the current settings in the Modes menu and whether you are using a custom 
brush (0 or a built-in brush (I). 

AlfedMode 
Paint Mode Brush Mode I Brush Type 

,.,.,~,.....,..."..--=-...."..-----=-I..."....".-,:--..",..I---I
[Untitled A Solid Col All II~I~I 

Figure53 The Title Bar 

THE PALETTE 

The upper left corner ofthe Painting Screen contains the Palette, where you select 
the color you want to paint with. Oicking on a color in the Palette with the left 
mouse button selects that color as the foreground color, which you then paint 
with using the left mouse button. Clicking on a color with the right mouse button 
selects the background color, which you then paint with using the right mouse 
button. 

RGBValuas 

Untitled A 
"'W!II!!III~ 

Palate Color Indicator Coordinates 

Figure 5.4 The Palette and Indicators 
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COLOR INDICATOR 

The Color Indicator is to the right ofthe Palette. The left rectangle ofthe indicator 
shows the foreground color. The right rectangle shows the current background 
color. The numbers above the Color Indicator show the Red, Green, and Blue 
values of the color you clicked most recently. 

The Color Indicator also lets you pick colors from the screen. To do this, click the 
Color Indicator and move the pointer back to the screen. The pointer is labeled 
"Pick." Point to a color on the screen and click either the left or the right mouse 
button to select a new foreground orbackground color. The keyboard equivalent 
for clicking the Color Indicator is the comma (,) key. 

COORDINATES 

These numbers showyou the current position <thecoordinates) of the cross-hair, 
and thus the position of your brush. 

When you are not pressing a mouse button, the Coordinates show the position 
of the brush relative to the upper left corner of your page. The top number shows 
you the number of pixels from the left side of the page. The bottom number 
shows you the number of pixels from the top of the page. 

If you press a mouse button, the Coordinates reset to +DOO and +000. As you 
move the brush, the Coordinates shows positive numbers for the number of 
pixels the brush has moved to the right or down from it's original position. 
Negative numbers indicate the number of pixels the brush has moved to the left 
or up from it's original position. 
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II THE PALETTE SCREEN 

The Palette Screen allows you to change the colors in your Palette. The Palette 
Screen is actually opened at the same time you start Paint, but it is a separate 
screen behind the Painting Screen. You can display the Palette byusing the Back 
Gadget on each screen until you reach the Palette, by selecting Ad just from the 
Palette submenu in the Project menu, or by pressing p on the keyboard. To 
activate the Palette Screen as the current screen, click on it. (This is true of all 
screens in Paint: you must click the screen before it becomes active. This is 
especially important to remember if you are working with multiple pictures.) 

Palelte Gadgets 

Figure 5.5 The PaleHe Screen 

The Palette is divided into seven sections and gadgets. 

The Title Bar shows the name of the screen, "Paint Palette," and, once you've 
selected a color, it also displays the RGBvalues of the currently selected color (the 
color you clicked most recently). You can change the display in the Title Bar to 
show the HSV values for the current color by clicking the RGB button below the 
Title Bar on the right hand side. The button then changes to HSV. 

The RGB or HSV sliders below the Title Bar let you modify the currently 
selected color on any of these color components. To change a component's 
numeric value, drag the slider to the left or right or click to the left or right side 
of the slider to move it one step at a time. As you move the slider, the new value 
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for that color component is shown in the Title Bar. (1n HSV mode, you mayhave 
to click more than once to change the value.) You can toggle the sliders between 
RGB and HSV by clicking the button to the right of the sliders. 

The Color Indicator, located just below the RGB/HSV button, displays the 
foreground andbackground color you most recently selected. As youchangethe 
RGBorHSV values of thecoloryoumost recently clicked on, the newcolor is also 
shown in the Color Indicator. 

The 4,096 Color Palette displays all of the colors possible on the Amiga display. 
Each squareofthedisplayis 16 x 16 pixels to showthe 16 values oftwo ofthecolor 
components. There are sixteen squares to show the 16 values of the third 
component. In essence, this display is a 16x16x16 color cube that has been sliced 
into planes as shown in Figure 5.6. 

When you first open the palette, the squares are arranged so that, in each square, 
the Green component increments moving from left to right and the Red compo
nent increments from top to bottom. The Blue component increments by one for 
each ofthe 16 squares moving from left to right. You can change the direction in 
which each color increments in this display by pressing the Help key on the 
keyboard. 

(0,0,15) 
Blue 

(0. 0,0) lJO_-+---L1 
Black 

L 

..
Green 

iRed 
~__+--l!!.¥") (15,15.15) 7 

White(15.0,Olc.r____--" '------.... 
R~ ~~ 

Figure 5.6 The RGB Color Cube 
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You can select a color from this palette by clicking on the color you want. Ifyou 
hold down the mouse button and move the pointer, the RGB or HSV values in 
the Title Bar change continuously to show values for the color under the pointer, 
and thecolor itself is shown in the Color Indicator of the Palette Screen. Clicking 
on the 4,096 Color Palette with the left mouse button changes the currently 
selected foreground color. Clicking with the right mouse button changes the 
currently selected background color. 

The Palette is below the 4,096-Color Palette and to the left of the Copy, Spread, 
Undo, and Cancel gadgets. This palette is a duplicate of the palette in your 
current picture. The number of colors depends on the display mode you are 
using. Any changes to the Palette in the Palette Screen also change the colors in 
the current picture's Palette and thus the colors in the picture itself. You can load 
and save palettes from other pictures using the options in the Palette submenu 
in the Project menu. 

The Palette Gadgets let you copy and spread colors on the Palette Screen, undo 
the last change you made, or cancel all of your changes. 

Copy lets you copy the current foreground or background color to any other 
color box in the palette, either in the Palette or in the Paint Set. Simply click the 
Copy gadget, and click the color register you want to copy to. If you click the 
color register with the left mouse button, you copy the foreground color; ifyou 
click with the right mouse button, you copy the background color 

Spread lets you quickly produce a spread of colors between the current Range 
Markers. (Ranges are explained later in this section.) Qick the first color for your 
spread with the right mouse button to place the Begin Range Marker, click the 
last color for the spread with the left mouse button to place the End Range 
Marker. Then click the Spread gadget to create a spread between the two colors. 

You can create the spread either in RGB or HSV mode. The results of the two 
spreads will differ due to the way the spreads are calculated. In RGB mode, the 
colors are spread based on each of the three components without regard to the 
position of colors on the color wheel. In HSV the spread is calculated based 
primarily on the hue component of the colors, and the spread always moves 
clockwise around the color wheel. (See Appendix A, Color Theory for an 
illustration of the color wheel.) 
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Undo reverses all changes made to a single color in the Palette Screen until 
another color is selected. Undo also reverses a Spread or Copy unless you select 
another color before you select Undo. 

Cancel reverses all changes made in the Palette Screen since the Palette Screen 
became active. This means that you can make many changes in the Palette 
Screen, but the changes can all be reversed until you make the picture screen 
active by clicking on it. 

The Paint Set is made up of4 rows of 32 colors each. You can use this area of the 
paletteto create large spreads ofcolorand to experiment with color mixes before 
you copy the colorinto the Register Palette. In HAM modeyou can also select one 
of the colors in thePaint Set to paint with directly on the painting screen. In other 
modes, painting with colors in the Paint Set actually paints with the color in the 
Register Palette that most closely matches the Paint Set color. You can load and 
save Paint Sets using the options in the Paint Set submenu of the Project menu. 

Ranges: The Spread operation and several of the Gradient Fill options in the Fill 
Control use a "range" of colors to perform their function. You ind kate the colors 
in the range by marking the beginning and ending points with the Begin Range 
and End Range Markers. 

To create a range: click the first color in the range with the right mouse button 
to place the Begin Range Marker, a dotted frame around the color box; click the 
last color in the range with the left mouse button to place the End Range Marker, 
a solid frame around the color box. 

Note: your range cannot cross between the Palette and the Paint Set in the 
Palette Screen. 

78 



B THE TOOLBOX 


Like some of the menu items above, most ofthe tools in theToolbox areavailable 
though keyboard equivalents. As you become proficient with DeluxePhotoLab, 
you will find it more efficient to use these equivalents, using one hand for the 
mouse and the other for the keyboard. The following descriptions of the tools 
include the keyboard equivalents, where appropriate. To help you learn these, 
we have suggested a mnemonic for most of them. 

The painting tools paint with the current foreground color if you use the left 
mouse button, and they paint with the current background color if you use the 
right mouse button. 

D DOTTED FREEHAND TOOL 
(Keyboard Equivalent: ;) 

Paints the current brush shape in a series of "splats." The spacing between the 
splats depends on how fast you move the mouse and what mode you are in. 
HAM mode takes much longer to paint when you have a complex brush, so, to 
produce narrowly spaced "splats" in this mode, you will need to move the 
mouse much more slowly. 

CONTINUOUS FREEHAND TOOL 

(Keyboard Equivalent: ') 


Paints a continuous freehand line. Depending on thecomplexityofthe brushand 
the display mode you are using, you may need to move the mouse slowly to 
produce smooth curves, because the brush may have difficulty keeping up with 
the mouse. 

Ifyou hold down Shift while painting with the Continuous Freehand tool, your 
brush movement is constrained to straight lines running either horizontally or 
vertically, depending on the direction you move the brush immediately after 
pressing Shift. 
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STRAIGHT LINE TOOL (Keyboard Equivalent: f) 

Paints a straight line. 

Click the Straight Line tool with the left mouse button; then position the cursor 
at the beginning of the line, hold down the appropriate mouse button, drag the 
mouse to the end of the line, and release the mouse button. 

Ifyou hold down Shift while painting a straight line, the line is constrained to 
be either horizontal or vertical, depending on the direction you move immedi
ately after pressing Shift. 

CURVE TOOL (Keyboard Equivalent: J) 

Lets you paint a 4-point curve (an 5-curve), or any sort of curve that can be 
defined by four points. 

Click with the left mouse button on the Curve tool to select it. Then, positioning 
the cursor where you want the curve to begin, hold down the left mouse button, 
drag the mouse to the place where you want the curve to end, and release the 
button. The straight line, which is still connected to the cursor, stretches into a 
curve as you move the cursor away. Drag it until the arc for the end half of the 
5-curve is the shape you want. Then hold down the mouse button and move the 
cursor to the other side of the line, to form the beginning half of the 5-curve. 
Release the mouse button to complete it. (Note that you can create a three-point 
curve byclicking the mouse button to place the middle points of thecurve in the 
same position.) 

[ ~ ::••':] AIRBRUSH TOOL 
[J (Keyboard Equivalent: I accent grave) 

Simulates the action of an air brush. 

Click the Airbrush tool with the left mouse button to select it. Position the cross
hair on the page and press either mouse button. 

Clickingon the Airbrush tool with the right mouse button lets you size its nozzle. 
Afterdickingwith the right mouse button to select the tool, move the cursor onto 
the page and and hold down the left mouse button. Now drag the mouse until 
the nozzle is the shape and size you want, and release the mouse button to fix it. 

80 




TEXT TOOL (Keyboard Equivalent: n 

Lets you type text onto your picture. 

Click the Text tool with the left mousebutton to select it. Position the text cursor 
on the page by clicking where you want the text to begin. Select a font from the 
Font menu and a type style from the Style option of the Font menu. Type your 
text. Use the Backspace key to erase and the Return key to begina new line. Note 
that you can only backspace to erase on the current line; once you press Return, 
the lineoftext becomes part of the picture, and can onlybe erased the same way 
you'd erase a graphic element. 

Clicking on the Text tool with the right mouse button brings up the Load Font 
requester where you can load a font into your fonts list. See, Load New Font in 
the Fonts menu for more information on the Load Font requester. 

FILL TOOL (Keyboard Equivalent: L) 

Fills an enclosed area with the current color or pattern as set in the Fill Control. 

Click the Fill tool with the left mousebutton to select it. Move thepaint can cursor 
over the enclosed area to be filled, so that the spout is within the shape you want 
to fill; then click the mouse button to fill it. 

Clicking on the Fill tool with the right mouse button brings up the Fill Control. 
This is the same requester that appears when you select Fill Control from the 
Options menu. See Fill Control in this reference section for an explanation ofthe 
options available in this requester. 

UNFILLEDIFILLED RECTANGLE TOOL 

(Keyboard Equivalent: [ - unfilled, and Shift-[ - filled) 


Lets you paint a rectangle shape using any brush. The top half of the tool paints 
a rectangle outline, while the bottom half paints a filled rectangle using the 
current settings of the Fill Control. 

Click the Rectangle tool with the leftmousebutton to select it. Position thecursor 
on the page where you want the rectangle to begin; then hold down the mouse 
button and drag the diagonally to form a rectangle. When the rectangle is the 
right size, release the mouse button. 
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If you hold down Ctrl while painting a rectangle, it is constrained to a square. 
Holding down the Shift key constrains the sizing of your rectangle to either 
horizontal or vertical movement, depending on the direction you move the 
brush immediately after pressing Shift. 

Clicking on the bottom half of the Rectangle tool with the right mouse button 
brings up the Fill Control. 

UNFILLEDIFILLED OVAL TOOL 
(Keyboard Equivalent: E - unfilled, and Shift-E - filled) 

Lets you paint an oval shape using any brush. The top half of the tool paints an 
oval outline, and the bottom half paints a filled oval using the current settings of 
the Fill Control. 

Click the Oval tool with the left mouse button to selectit. Then poSition the cursor 
where you want the oval to appear on the page, hold down the mouse button, 
and drag the mouse diagonally to form an oval. If corner-to-corner is set in the 
Options menu, then the oval is painted within the two comers defined by the 
beginning and ending points of your mouse click. If center-out is selected in the 
Options menu, the oval is painted from the center outward, with the center 
defined by your initial press of the mouse button. When the oval is the size you 
want, release the mouse button. 

If you hold down Orl while painting an oval, it is constrained to a circle. 

Clicking on the bottom half of the Oval tool with the right mouse button brings 
up the Fill Control. 

FREEFORM SHAPE TOOL 

(Keyboard Equivalents: F - freeform, and Shift-F - polygon) 


Lets you paint a freeform shape using the current settings of the Fill Control. 
Selecting the top half ofthe tool paints a completely freeform shape; selecting the 
bottom half paints a freeform polygon. 

Click the top half of the Freeform Shape tool to select it as a freeform shape; 
position the cursor on the page and hold down the mouse button to paint 
whatever freeform shape you want. When you release the mouse button, the 
shape is filled using the current fill settings. 
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If you release the mouse button before the cursor has reached starting point of 
your freeform shape, the shape is automatically completed with a straight line 
from the cursor's last position to the starting point. 

Click the bottom half of the Freeform Shape tool to select a freeform polygon. 
Move the cursor onto the page and click the mouse button as many times as you 
want to define the polygonal shape you want to fill. Each pair of clicks is joined 
bya straight line. To dose the polygon, dick the starting point, orclick the mouse 
button twice without moving the mouse. 

Clicking on the Freeform Shape tool with the right mouse button brings up the 
Fill Control. 

BRUSH SELECfOR 
(Keyboard Equivalent: B - rectangular; Shllt-B - freeform) 

Lets you create a custom brush from any image on the page, or recall your most 
recent custom brush. 

To select a rectangular brush area, dickthe top halfofthe Brush Selector tool with 
the left mouse button; once you move it to the page, the cursor changes to a large 
cross-hair. Hold down the mouse button and drag diagonally to endosethe area 
you want to use as a brush. Release the mouse button to select it. 

To select a freeform brush area, click the bottom half of the Brush Selector tool 
with the left mouse button; once you move it to the page, a single pixel marker 
appears in the center of the cursor. Holding down the mouse button, trace a 
boundary around the area you want to use as a brush and release the mouse 
button to select it. Ifyou release the mouse button before the cursor reaches the 
starting point of your freeform shape, the shape is automatically completed with 
a straight line from the cursor position to the starting point. 

Using the left button to select the brush simply copies the selected area onto the 
brush. Using the right button to select it cuts the selected area from the page to 
make the brush, and replaces the area with the current background color. 

Clicking on the Brush Selector tool with the right mouse button restores your 
most recent custom brush (if possible). 
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MAGNIFY (Keyboard Equivalent: M) 
IZOOM (Keyboard Equivalent: I and 0) 

Lets you magnify an area of the screen and increase or decrease the amount of 
magnification. Magnify is especially useful for detailed work on small areas of 
your painting. While the painting is magnified, all other commands are avail
able. To turn off the Magnify tool, dick the top half of the tool a second time. 

Click the Magnify tool with the left mouse button to select it. When you move the 
cursor onto the page, it changes to a rectangle, and the lower half of the Magnify 
tool changes to the Zoom tool. Move the rectangle over the area you want to 
magnifyand click themouse button. The screen splits into two sections, showing 
the normal picture on the left and the magnified area on the right. 

To increase the magnification, click the Zoom tool with the left mouse button, or 
press I on the keyboard. To decrease the magnification, click the Zoom tool with 
the right mouse button, or press 0 on the keyboard. 

When in magnify mode, pressing N on the keyboard centers the area under your 
cursor within the magnified area. You can also scroll the magnified area using 
the arrow keys. 

§ CLEAR (Keyboard Equivalent: K) 

Clears the visible portion of the page to the current background color. 

~ UNDO (Keyboard Equivalent: U) 

Reverses your last painting operation, provided there have been no intervening 
mouse dicks. 

84 




II MENU ITEMS 


PROJECT MENU 


The menus in Paint work just like other Amiga menus: point to the Title Bar and 
press the right mouse button to display the Menu Bar. Then, point to a menu 
name to open that menu. Finally, drag the arrow down to one of the menu 
options and release the mouse button to select that option. 

Some menu options present submenus to the right side of the option. In these 
cases, you can drag the highlight down to the option to display the submenu, 
then drag the highlight to the right and down again to select an option from the 
submenu. 

In many cases, you can select a menu item by using its keyboard equivalent. A 
table of keyboard equivalents is included as Appendix D at the back of this 
manual. 

The menus, reading from left to right across the Menu Bar, are as follows: 

Pr-oject 

~r:se II~ 
Load mL 
Load At mA 
Saye mS 
Saye Fr-ol1 
Pr-int 
Palette 
Paint Set 
Page Size mZ 
Show Page
Delete 
About 
Quit 

Figure 5.7 The Project Menu 
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NEW (Keyboard Equivalent: Right Amiga-N> 

Lets you set a new display mode and create a Paint screen. 

Select New from the Project menu. The Display Mode requester appears, asking 
you to select a display mode for the new picture. (See "Display Mode Requester" 
at the beginning of this chapter for an explanation of selecting a display mode.) 
Select a display mode and click Open. In a moment the screen clears and the 
Palette and Tools are displayed. You are now ready to begin your new creation 
or to load a picture. 

Note that New creates a new painting screen rather than replacing the previous 
screen. This means that you can work on more than one picture at a time. 

CLOSE (Keyboard Equivalent: Right Amiga-C) 

Closes the current picture screen and releases that portion of memory. If the 
current picture has been modified since it last was saved, a requester appears 
giving you the option to save the picture before dosing. 

LOAD (Keyboard Equivalent: Right Amiga-L) 

Brings up the Load Requester. See Figure 5.8. The requester contains Load and 
Cancel buttons, a field to display the current directory path, a file list window 
(with arrows and a slider for scrolling it), and an edit field displaying the 
currently selected file. 

===L::O==:aI:::d==::!' I Ca. nee 1 
PHOTOLAB: 

- FILES -
Col OJ's 
Paint 
Postel's 
P:ret'e:r..no.s 

Figure 5.S Load Requester 
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To load a picture, click the name of the file you want to open; then click the Load 

button at the top of the requester. 


In addition to files, the window displays Directories, Volumes, and Clipboards. 

Ifyou click a subdirectory name, the window displays all of the files contained 

in that subdirectory. Clicking the listing "/ (parent)" moves you into the parent 

directory of the current subdirectory. Ifyou click a Volume name, the contents 

of that volume are displayed. Also, if you place a different disk in a drive while 

the Load Requester is displayed, the Volume list is updated to show the new 

disk. Ifyou inserted the disk in the current drive, the window displays the files 

from the new disk. 


SHORTCUTS 

Several shortcuts are available in the Load Requester. 


Double-clicking on a file name is the same as clicking the file name and clicking 

Load. 


Clicking on a section title in the display window, such as 

"-Files--," will skip the window display down to the next section. 


You can load a specific file byclicking on the file edit field, backspacing over the 

previously listed file, typing the name of the file you want (including it's path), 

and pressing Return. 


KEYBOARD SHORTCUTS IN THE LOAD REQUESTER 


Key Function 

ESC Cancel 
UpArrow Move display up one line 
Down Arrow Move display down one line 
Shift-Up Arrow Move display up one section 
Shift-Down Arrow Move display down one section 
Return Same as clicking on Load 
D Shows the directories 
F Shows the files 
V Shows the volumes 
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"" 	 TIP: Ifyou don't know the size of the picture you want to load, use Load 
At to see the size of the picture. The Width and Height gadgets in the Load 
At Requester default to the size of the picture you selected. Once you know 
the size of the picture, you can Cancel the Load At operation, change your 
page size, and then load the picture. 

LOAD AT (Keyboard Equivalent: Right Amiga-A) 

Lets you load a picture file at a specific poSition in a larger picture. You can also 
specify the size at which you want the picture loaded. 

When you select Load At, the Load Requester appears for you to se1ect the 
picture to be loaded. (See Load in the Picture menu for a description of the Load 
Requester.) 

After you have selected the file you want, and clicked Load, a second requester 
appears, so you can specify exactly where the picture should be loaded, as well 
as the size you want it loaded at. 

X Pos: 

y Pos: 8 

Width: 328 


Height: I 488 

Load 


Cancel 


Figure 5.9 Load At Requester 

The edit fields for X Pos and Y Pos are used to indicate the position of the upper 
left corner oftheareayou want to load. The Width and Heightedit fields are used 
to indicate the dimensions of the area you want to load. This means that you can 
actually resize the image as you load it. Note that the X and Y coordinates are 
based on the poSition on the page and easily can be found using the Coordinates 
display in the Toolbox. 

Note that the X Pos and Y Pos numbers can be negative; this allows you to crop 
the picture along the left or top side as you load it. 
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SAVE (Keyboard Equivalent: Right Amiga-S) 

Brings up a requester for you to save a picture to disk. This requester functions 
just like the Load Requester (described underload in the Picture menu), except 
that clicking Save saves the picture to disk. Be careful that you do not use a file 
name that already exists on your disk, unless you want to replace that file. You 
are not warned if you use an existing file name. 

When you save a picture, that picture's Palette is saved with it. However, the 
Paint Set is not saved. If you want to save a Paint Set, you must save it as a 
separate file using the Save option in the Paint Set submenu of the Project menu. 

SAVE FROM 

Lets you save a partial picture file from a larger picture. 

Selecting Save From brings up the Save File Requester, so you can save your file. 
Onceyou have Specified the path and file name under which to save the picture, 
clicking Save brings up a second requester, in which you specify the portion of 
the picture you want saved. 

X Pos: 
y Pos: B 
Width: 33B 

"eisht: I 111 
Saye 


Canoel 


Figure S.10 Save From Requester 

The edit fields for X Pos and Y Pos are used to indicate the position of the upper 
left corner ofthearea youwantto save.The Widthand Height editfieldsareused 
to indicate the dimensions of the area you want to save. Note that the X and Y 
coordinates are based on the position on the page and easily can be found using 
the coordinates display in the Toolbox, which also shows the cursor coordinates 
relative to the upper left comer of the page. 
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PRINT 

Brings up the Picture Print Control, in which you select print settings, and choose 
to print the current picture. 

PIcture Print Control 
NOl'Mai 

Pl'int I Cancel I 

Figure 5.11 Picture Print Control 

The options in this requester function as follows: 

ORIENTATION: lets you set whether the printed picture is printed so that it is 
upright when the page is held upright (Normal) or so that the picture is upright 
when the page is held sideways (Sideways). The default setting is Normal. 

SHADE: lets you choose one of three printing shades. The default setting is 
Color. 

B&W prints only the pixels that use color register 0 (zero) in the picture's 
palette. These pixels are printed in black. 

Grey prints the picture as a grey scale image. This lets you print any picture 
with a black ribbon. 

Color prints the picture in full color. Though obviously this option will 
work correctly only on color printers. 

SIZE FACTOR: lets you set whether the size of the printed picture is measured 
in inches (Inches), printer pixels (Pixels), or as a percent of your page size 
(Percent). The default setting is Percent. 
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WIDTH and HEIGHT: let you set the width and height of the printed picture. 
If you place a 0 in either of these gadgets, only the other setting is used to 
determine the size of the printout, and the picture is printed proportionally. 
Otherwise, both numbers are used, and the printout may not be proportional. 

Depending on the setting in the Size Factor gadget, the number in these gadgets 
can representinches, pixels, orpercent ofthe page size. The default setting is 100 
so that the Size Factor and Width combine to print the picture at 100% the width 
of your page. 

COPIES: lets you set the numberofcopies tobe printed. Note thatPaintdoes not 
send line-orpage-feedsto theprinter, soeachcopy ofyourpictureprintsdirectly 
below the previous copy. 

CENTER: sets whether the picture is printed along the left side of the page, or 
centered between the left and right side of the page. Center always centers 
between the left and right sideofthe page, regardless of whetherthe Orientation 
setting is Normal or Sideways. 

PRINT: Once you have set your print settings, check that your printer is 
powered on and on-line. Click Print to print the picture. While the picture is 
printing, a requester appears to tell you which copy is printing. This requester 
also contains a button to cancel printing. Note, however, that clicking Cancel or 
pressing the Spacebar to abort a print sometimes leaves garbage printing at the 
beginningofthefollowing printout. Ifthis happens, you need to reset the printer. 
Ifyour printer doesn't have a reset option, turn the power to the printer off and 
then on again. 

CANCEL: closes the Picture Print Control without printing the picture. Your 
most recent print setting are remembered even though you did not use them. 

PALETTE 

This option presentsa submenu containing options for altering the color palette. 

ADJUST (Keyboard Equivalent: P) 

Brings up thePalette Screen. Or, if the Palette Screen is alreadydisplayed, Adjust 

closes it. See the discussion of the Palette Screen near the beginning of this 

reference section. 
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LOAD 

Brings up the Load Requester, which lets you load a palette from another picture. 

(For a full explanation of the gadgets in this requester, see Load in the Picture 

menu.) 


You can load either a palette that was saved separately (using the Palette Save 

command) or you can load a palette directly from a picture file. When you load 

a new palette, the colors in the current picture and Palette are replaced with the 

corresponding colors from the palette you loaded. 


SAVE 

Brings up the Save Requester, which allows you to save the palette ofthe current 

picture. (For a full explanation ofthe gadgets in this requester, see Load and Save 

in the Picture menu.) 


USE PICTURE 

Causes the most recently loaded color palette to be used for the current picture. 

Ifno palette has been loaded separately, this option causes the current picture's 

palette to be used. 


USE BRUSH 

Causes the paletteof the current custom brush to be used for the current picture. 


USE DEFAULT 

Causes the "Default" palette to be used for the current picture. 


PAINT SET 

This option presents a submenu containing options for loading or saving Paint 
Sets. 

LOAD 
Brings up the Load Requester, which lets you load a Paint Set from disk. (For a 
full explanation of the gadgets in this requester, see Load in the Picture menu.) 
Note that you can only load Paint Sets that have been saved as separate files. The 
Paint Set is not saved when you save a picture. 
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SAVE 
Brings up the Save Requester, which allows you to save the current Paint Set to 
disk. (For a full explanation of the gadgets in this requester, see Load and Save 
in the Picture menu.) 

PAGE SIZE (Keyboard Equivalent: Right Amiga-Z) 

Brings up the New Page Size Requester, which lets you change the width and 
height of the current picture. 

To change the size of your page, select Page Size from the Project menu. In the 
requester, click in the Width gadget, press Backspace or Delete to remove the 
current width setting, type the value for the new width (measured in pixels), and 
press Return. Use the same steps to replace the Height setting. Finally, click New 
Size to use the new settings, or Cancel to close the requester without using the 
new settings. The page size will increase or decrease by adding to or subtracting 
from the bottom and right sides ofthe page. Note that the upper left corner of the 
screen is assumed to be the upper left corner of the newpage. lfpan of yourpicture 
is off the screen to the left or above, that pan is lost when you change the size. 

SHOW PAGE 

This option presents a submenu that contains options displaying the full page if 
it is larger than the screen. To return to the page after selecting one of these 
options, click the right mouse button or press a key on the keyboard. When you 
select the Fast or Smooth options, the area of the page that was displayed before 
you selected Show Page appears inside an outline. You can move this outline to 
another area of the page by dragging it with the left mouse button. When you 
return to the normal display, you will see the new outlined area on the screen. 

FAST (Keyboard Equivalent: S) 
Shows the page quickly, without smoothing or overscan. The area of the page 
that was displayed before you selected Show Page appears inside an outline. You 
can move this outline to another area of the page by dragging it with the left 
mouse button. When you return to the normal display, you will see the new 
outlined area on the screen. 
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SMOOTH (Keyboard Equivalent: Shift-S) 
Shows the page with smoothing. The area of the page that was displayed before 
you selected Show Page appears inside an outline. You can move this outline to 
another area of the page by dragging it with the left mouse button. When you 
return to the normal display, you will see the new outlined area on the screen. 

OVERSCAN (Keyboard Equivalent: D) 
Shows the page as it would appear in overscan display mode. The display is 
always aligned to the top left comer of the page. You can adjust the position of 
theoverscan imagebyusing thearrow keyson the keyboard. Note thatOverscan 
only works if the page is large enough. 

DELETE 

Brings up a requester for deleting files from a disk. This requester functions just 
like the Load Requester described under Load in the Picture menu, except that 
clicking Delete deletes the selected file. 

ABOUT 

Brings up a requester that gives the name of the program, date and version 
number, copyright information and the developers' names. 

QUIT 

Exits Paint. Ifyou have made changes to a picture since it was last saved, Paint 
prompts you to save the picture before quitting. 
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BRUSHES MENU 

Brushes 
Load 
Save 
Shapes 
.,J' CustOH Bvush 
Rotations 
Pvint 
Resize 
Resize Dvaw 
Ovab Last 
Handle 
ReMap 

Figure 5.12 The Brushes Menu 

LOAD (Keyboard Equivalent: Right Amiga-G) 

Brings up the Load Brush Requester, which lets you load custom brushes from 
a disk. (For a full explanation of the gadgets in this requester, see Load in the 
Picture menu.) Note: ifa picture can fit in chip memory, you can load it as a brush. 

SAVE (Keyboard Equivalent: Right Amiga-P) 

Brings up the Save Brush Requester, which lets you save your current custom 
brush to disk. (For a full explanation of the gadgets in this requester, see Load in 
the Picture menu.) 

SHAPES 

Displays a pictorial list of built-in brushes, so you can select one quickly for use. 

Select Shapes, then select whichever brush you want from the built-in brushes 
displayed. When you release the mouse button, your new brush will be the one 
you selected. 
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CUSTOM BRUSH 

Restores themost recent custom brush. The brushis restored in its modified form 
rather than in the form that itwas selected. For example, ifyou select a brush and 
rotate it, then select a built in brush, selecting Custom Brush will restore your 
custombrush in its rotated form. (You can also restore the original custom brush 
by clicking the Brush Selector with the right mouse button.) 

ROTATIONS 

This option presents a submenu containing options for rotating the current 
custom brush. 

VERT FLIP (Keyboard Equivalent: Y) 

Flips the current brush vertically. 

HORZ PUP (Keyboard Equivalent: X) 
Flips the current brush horizontally. 

ROTATE 90 (Keyboard Equivalent: Z clockwise; Shift-Z counter-clockwise) 
Rotates the current brush 90 degrees clockwise. If you hold down Shift while 
selecting the option, the brush will rotate 90 degrees counter-clockwise. Because 
pixels on the Amiga display are not square, rotating the brush also distorts it. 

ROTATE FREE (Keyboard Equivalent: W) 

Lets you rotate the current brush to any angle. 

Select Rotate Free from the Rotations submenu in the Brushes menu. Your brush 
changes to a rectangle with a triangle inside. The triangle indicates the top ofthe 
brush. The pointer is attached to the center of the rectangle by a line. Rotate the 
rectangle by pressing the left mouse button and moving the pointer. Because 
pixelson the Amiga display arenot square, rotating the brush also distorts it. As 
you rotate the rectangle, it stretches and contracts to indicate the distortion to the 
actual brush. Release the mouse button. 
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PRINT 

Brings up the Brush Print Control, which lets you select print settings and print 
the current brush. 

The options in this requester function as follows: 

ORIENTATION: lets you set whether the brush is printed so that it is upright 
when the page is held upright (Normal) or so that the brush is upright when the 
page is held sideways (Sideways). The default setting is Normal. 

SHADE: lets you choose one of three printing shades. The default setting is 
Color. 

B&W prints only the pixels that use color register 0 (zero) in the brush's 
palette. These pixels are printed in black. 

Grey prints the brush as a grey scale image. This lets you print any brush 
with a black ribbon. 

Color prints the brush in full color. Though obviously this option will work 
correctly only on color printers. 

SIZE FACfOR: lets you set whether the size of the printed brush is measured in 
inches (Inches), printer pixels (Pixels), or as a percent ofyour page size (Percent). 
The default setting is Percent. 

WIDTH and HEIGHT: let you set the width and height of the printed brush. If 
you place a 0 in either of these gadgets, only the other setting is used to determine 
the size of the printout, and the brush is printed proportionally. Otherwise, both 
numbers are used, and the printout may not be proportional. 

Dependingon the setting in theSize Factor gadget, the number in these gadgets 
can represent inches, printer pixels, or percent of the page size. The default 
setting is 100 so that the Size Factor and Width combine to print the picture at 
100% the width of your page. 

COPIES: lets you set thenumberofcopies to be printed. Note that Paint does not 
send line- or page-feeds to the printer, so each copy ofyour brush prints directly 
below the previous copy. 
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CENTER: sets whether the brush is printed along the left side of the page, or 
centered between the left and right side of the page. Center always centers 
between the left and right side ofthe page, regardless of whether the Orientation 
setting is Normal or Sideways. 

PRINT: Once you have set your print settings, check that your printer is 
powered on and on-line. Click Print to print the brush. While the brush is 
printing, a requester appears to tell you which copy is printing. This requester 
also contains a button to cancel printing. 

CANCEL: doses the Print Brush Control without printing the brush. Your most 
recent print settings are remembered even though you did not use them. 

RESIZE 

Lets you resize your custom brush. 

Select Resize. When you move the cursor back onto the page, it is a large cross
hair. Hold down the left mouse button, drag the mouse to form a rectangle that 
is the size you want your brush to be, and release the mouse button. The brush 
will be resized to the size of the rectangle you created. 

Holding down the Ctrl button while draging the mouse to define the new brush 
size constrains the resizing to the same aspect ratio as the original brush. 

RESIZE DRAW (Keyboard Equivalent: Right Amiga-D) 

Lets you paint the brush onto the picture in whatever size you select, without 
resizing the original brush first. Note, however, that Resize Draw does not work 
with any of the modes in the Modes menu. 

Select Resize Draw. When you move the cursor back onto the page, it is a large 
cross-hair. Place the cross-hair in one corner of the area you want to paint over; 
then hold down the left mouse button, drag the cross-hair to the opposite corner 
of the area you want to paint, and release the mouse button. The current brush 
will be painted in the area you indicated, and it will be the size you defined with 
the cross-hair cursor . (Oickon any tool to remove the cross-hair from the screen.) 

98 



MODES MENU 


PAINT: REFERE 

Holding down the etrlbutton while dragging the mouse to define the size ofthe 
painted image constrains fhe resizing to the same aspect ratio as the original 
brush. 

GRAB LAST (Keyboard Equivalent: G) 

Grabs the last area painted on the screen and uses it as a brush. This means that 
you can paint a shape with a built-in brush and then select Grab Last to use that 
shape as a custom brush. You can also paint witha custom brush and select Grab 
Last to select an even more complex brush. 

HANDLE (Keyboard Equivalent: Right Amiga-H) 

Lets you offset the cursor from the current custom brush in any direction. 

Select Handle, move the cursor/brush onto the page, hold down the left mouse 
button and drag the mouse in any direction. When the cursor is offset by the 
desired amount, release the mouse button. 

REMAP (Keyboard Equivalent: Right Amiga-R) 

Remap looks at the colors used in the brush and finds the closest match in the 
current picture's Palette. This is important ifyou are using a display mode other 
than Hold And Modify. Paint automatically remaps brushes in HAM mode 
when you paint them onto the picture. The Remap option lets you see the brush 
as it will appear when you paint with it. 

BruS''' Hod. 
Paint Hode 
ACCect 

Figure 5.13 The Modes Menu 
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BRUSH MODE 


This option presents a submenu containing brush mode options. These options 

affect the way a custom brush is used to paint. 


MATIE (Keyboard Equivalent: Fl) 

Uses the brush in its original form. Those areas of the brush that match the 

current background color are transparent. 


This is the default mode when you create a custom brush using the Brush 

Selector. If you use your brush with Color or Pattern, and then re-select Matte, 

your brush will be restored to its previous multi-color form. 


COLOR (Keyboard Equivalent: F2) 

Uses the shape of the custom brush, but paints with the current foreground or 

background color depending on the mouse button you use. Those areas of the 

brush that were transparent in the original brush remain transparent. 


PATIERN (Keyboard Equivalent: F3) 

Uses the current custom brush as a pattern behind the picture. 


When you paint on the picture with the Dotted Freehand, Continuous Freehand, 

Line,Curve,orAirbrush tools, you effectivelyremovetheexistingpainttoreveal 

the pattern beneath. The position of the pattern is based on the original poSition 

of the area you selected as a brush, unless you offset the pattern using the Fill 

Offset option in the Fill Control. 


Ifyou selected an irregularly shaped brush, painting with the left mousebutton 

reveals only the selected brush area. Painting with the right mouse button 

reveals the selected brush and the bounding rectangle that defines the brush 

pattern. In Hold and Modify mode, the bounding rectangle is the same as ifyou 

had selected the brush with the standard. rectangular Brush Selector. Indisplay 

modes other than Hold And Modify, the bounding rectangular area is filled with 

the current background color. 
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Figure 5.14 Brush and bounding rectangle 


STORE (Keyboard Equivalent: F4) 

Replaces the bounding rectangle of an irregular shaped brush as though you had 

selected the brush using the rectangular Brush Selector. In HAM mode, the 

rectangular area appears exactly as though you selected the brush using the 

Brush Selector. In other modes, the area around the brush is filled with the 

current background color. 


PAINT MODES 


Paint Modes presents a submenu of options that let you specify how the colors 

of an object (brush, circle, etc.) are combined with the picture colors while 

painting. These modes are available in every display mode, though display 

modes other than HAM can only paint with colors in the Palette. The Paint 

Modes can also be used with any painting tool, and with the Fill Types. 


In the descriptions that follow, the RGB values for the calculations are included 

for those who might better understand the mode by seeing it's mathematical 

implications. Most users will learn the modes more readily by simply trying 

them under various circumstances 


soLIn (Keyboard Equivalent: Left All-Fl; Left or Right All-flO) 

Applies the full value of the object color without regard to the color beneath it on 

the painting. This is the default painting mode. 


Object Picture Result 

R G B R G B R G B 
4 9 6 7 3 8 496 
1 2 3 3 2 1 123 
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LOW MIX (Keyboard Equivalent: Left Alt-F2) 

Applies the lightest amount of object color to the picture color. This is a very 

useful mode ifyou are not sure how much ofthe object color you want to apply. 

Paint one application of Low Mix and use Repeat to add more color until you 

reach the desired level. 


Object Picture Result 

R G B R G B R G B 
1 9 6 7 3 8 6 4 7 
1 2 3 3 2 1 2 2 2 

MIX (Keyboard Equivalent: Left Alt-F3) 

Applies one-fourth of the object color to the picture. 


Object Picture Result 


R G B R G B R G B 

1 9 6 7 3 8 5 4 7 

1 2 3 3 2 1 2 2 2 


AVERAGE (Keyboard EqUivalent: Left Alt-F4) 

Applies one-half of the object color to the picture. 


Object Picture Result 


R G B R G B R G B 

4 9 6 7 3 8 5 6 7 

1 2 3 3 2 1 2 2 2 


BLEND (Keyboard Equivalent: Left Alt-F5) 

Applies three-fourths of the object color to the picture. 


Object Picture Result 


R G B R G B R G B 
4 9 6 7 3 8 476 
1 2 3 321 122 
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SHADE (Keyboard Equivalent: Left Alt-F6) 

Applies a proportional amount of the object color to the picture. You can set the 

amount of object color applied by using the Shade option in the Options menu. 

This mode also lets you apply the object color in a gradual shading effect. 


SUB PICT (Keyboard Equivalent: Left Alt-F7) 

Applies the color value equal to the object color value minus the picture color 

value. Ifthe resultingvaluedrops below 0, the minimum, thevalueOi sused.(For 

example, ifyou have an object color value of 4 and a picture color value of8, the 

color value used will be 0, since 4 minus 8 equals -4, which isbelow the minimum 

value.) 

Object 

R G 
4 9 
1 2 

B 
6 
3 

Pic

R 
7 
3 

ture 

G 
3 
2 

B 
8 
1 

Result 

R G B 
o 6 0 
002 

SCALE (Keyboard Equivalent: Left Alt-FS) 
Applies the color that results from multiplying the picture color value by the 
object color value, and then dividing by 15. By doing this, you are scaling the 
picture color by the object color painted over it. You might think of this option 
as "embossing" the object into the picture. 

Object Picture Result 

R G B R G B R G B 
4 9 6 7 3 8 223 
1 2 3 321 000 

SCALE2 (Keyboard Equivalent: Left Alt-F9) 
Applies the color that is the product of multiplying the picture color value bythe 
object color value, and dividing the result by 8. You can reduce contrast in the 
picture by using a gray brush with a value less than 8, or increase contrast by 
using a gray brush with a value greater than 8. 

Object Picture Result 

R G B R G B R G B 
4 9 6 7 3 8 4 3 6 
1 2 3 321 010 
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ADD (Keyboard Equivalent: Right AU-Fl) 

Applies the color that is the sum of the object color value and the picture color 

value. If the result exceeds 15, the maximum color value, then 15 is used. (For 

exam pIe, ifyou have an object color value of 6 and a picture color value of11, the 

color value used will be 15, since 6 plus 11 equals 17, which is above the max

imum color value.) 


Object Picture Result 


R G B R G B R G B 
4 9 6 738 11 12 14 
1 2 3 3 2 1 444 

SUB (Keyboard Equivalent: Right Alt-F2) 
Applies the color that is equal to the picture color value minus the object color 
value. The general effect is to darken the picture. If the color value drops below 
0, the minimum, 0 is used (For example, if you have a picturecolorvalueof4and 
an object color value of 8, the color value used will be 0, since 4 minus 8 equals 
-4, below the minimum color value.) 

Object Picture Result 

R G B R G B R G B 
4 9 6 738 3 0 2 
1 2 3 3 2 1 200 

MAX (Keyboard Equivalent: Right Alt-F3) 

Applies the color that results from combining the highest RGB value compo

nents of the object color and the picture color. 


Object Picture Result 


R G B R G B R G B 
4 9 6 738 798 
1 2 3 3 2 1 323 
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MIN (Keyboard Equivalent: Right Alt-F4) 

Applies the color that results from combining the lowest RGBvaluecomponents 

of the object color and the picture color. 


Object Picture Result 

R G B R G B R G B 
4 9 6 738 4 3 6 
1 2 3 3 2 1 1 2 1 

XOR (Keyboard Equivalent: Right Alt-FS) 
Applies the color that results from the logical operation "exclusive-or" between 
the object color value and the picture color value. Applying a gray with a value 
less than 8 tends to move the colors toward gray. Applying a gray with a value 
greater than 8 moves secondary and primary colors to their complements. Ifyou 
apply white to the picture using this mode, the resulting colors are the comple
ments of theoriginal picture colors. In other words, this modeused with a white 
brush produces a negative image. 

Object Picture Result 

R G B R G B R G B 
4 9 6 7 3 8 3 10 14 
1 2 3 3 2 1 202 

OR (Keyboard Equivalent: Right Alt-F6) 

Applies the color that results from the logical operation "or" between the object 

color value and the picture color value. (The result is a little like Max.) 


Object Picture Result 

R G B R G B R G B 
4 9 6 738 7 11 14 
1 2 3 3 2 1 3 2 3 
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AND (Keyboard Equivalent: Right Alt-F7) 

Applies the color that resu1ts from the logical operation "and" betweentheobject 

color value and the picture color value. (The result is a little like Min, described 

above.) 


Object Picture Result 

R G B R G B R G B 
4 9 6 7 3 8 4 1 0 
1 2 3 3 2 1 1 2 1 

HLF (Keyboard Equivalent: Right All·F8) 

At those positions where theobject color would normally take effect, reduces the 

picture color by half. 


Object Picture Result 

R G B R G B R G B 
any any any 7 3 8 3 1 4 
any any any 3 2 1 1 1 0 

B&W (Keyboard Equivalent: Right Alt-F9) 
At those positions where the object color would normally take effect, converts 
the picture color to its gray level. The effect on the painted area is the same as 
turning the color knob all the way down on a television set. Note that unless the 
Palette contains the full range of grays, Paint may not be able to convert the 
painted area entirely to grays. 

Object Picture Result 

R G B R G B R G B 
any any any 7 3 8 5 5 5 
any any any 3 2 1 2 2 2 

AFFECf 

Presents a submenu that contains options for selecting which pixels in the 
picture are affected by a painting operation. 
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ALL (Keyboard Equivalent: F5) 

A painting operation effects all pixels in the picture. 


FOREGROUND (Keyboard Equivalent: F6) 

A painting operation effects only those pixels that are not of the background 

color. 


BACKGROUND (Keyboard Equivalent: F7) 

A painting operation effects only pixels of the background color. 


OPTIONS MENU 

U ;a, 

Repea t ':ro' 
Shade Cont:rool 
Fill Cont:rool 
Hasni£!J,II 
P:roe£e:roences 

Figure 5.15 The Options Menu 

REPEAT (Keyboard Equivalent: R) 

Repeats the last painting action using the current Paint Mode, Affect Mode, and 
either Color or Pattern Brush Mode. If the currently selected tool is a fill tool (Fill, 
Filled Rectangle, etc.), it also uses the Fill Control settings. If the currently 
selected tool is not a fill tool, Matte and Store Brush Modes work like Color Brush 
Mode. Note, however, that when you use Repeat, thecolor is applied tothe pixels 
that were last painted. So if you last painted with Store mode active, Repeat will 
act like Color plus Store mode. 

This lets you paint an area, then change colors or mode settings and repaint the 
exact same area in a single keystroke. This is useful with Paint Modes such as 
Low Mix, because it allows you to apply the brush color in gradual increments 
until you reach the color you want, without your having to manually paint over 
the area several times. 
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SHADE CONTROL (Keyboard Equivalent: V) 

Bringsup theShade Control, where you select the shade settings tobe used when 
painting in the Shade Paint Mode. How Shade is applied depends somewhat on 
the painting operation you've chosen. Ifyou paint a filled shape, or fill a shape 
with a solid color, the Shade effect is applied over the area of the shape. If you 
paint witha custombrush, theShade effect is applied over the area of thecustom 
brush. Ifyou paint with a built-in brush, the Shade effect is applied over the area 
of the screen. 

Shade Control 

Highlight: 

IPoint
• ])1 the:r: 8 
Iii 
Low 8Y.I. 
High i.88Y.oR I CNiCEL I WI 

Figure 5.16 Shade Control 

HIGHLIGHT POSITION: Positions the highlight (the area of the Shade effect 
controlled by the High setting) relative to the total affected area. The affected 
area is represented by the square box (though your actual affected area may be 
any shape). The type of highlight to be used is set in the Highlight gadget and is 
represented by a dot, a bar, or the entire highlight position area. 

When the highlight type is set to anything other than All, you can position the 
highlight by dragging it around in the box. 

HIGHLIGHT: Determines the type of highlight to be used in the shade opera
tion. aicking on the Highlight box cycles you through the four possible 
highlight types: Point, Vertical, Horizontal, and All. 

As you click the Highlight box to change the setting, the box to the left shows a 
graphic representation of the highlight. For example, if you set the highlight to 
point, the highlight area is shown in the large box as a point. The highlight area 
of the box is the area that will receive the maximum effect of the brush. The 
maximum effect is set using the High slider. 
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If the Highlight is set to AI~ the object color is applied evenly across the area of 
the object. The level of color that is applied is the average of the High and Low 
slider settings. 

DITHER: Lets youset theamountof randomness betweenbands in the shading. 
Note that the number ofbands is determined by the difference between the Low 
and High settings. 

LOW: Lets you set the percent ofbrush color applied to the painting in the area 
farthest from the highlight in shaded area. 

HIGH: Lets you set the percent of brush color applied to the painting in 
highlight area. 

FILL CONTROL 

Brings up the Fill Control, which lets you set the type of fill to be used by fill 
commands. The four basic types of fill available are Solid Color, Trace Edges, 
Brush Pattern" and Gradient. Thecurrently selected fill type is highlighted in the 
window. To select a different one, click its gadget. Each of the fill types is 
explained in detail below. 

Solid Colo... 
IBrusb Pattern! ....1___"-'Ilol~........x.-..... 

Gradient T~pe 
IHor iz Borier 1 

HAM Closeness Dither 8 

I • 15 I ~'.~ii~:~~' 
I Fi 11 Ottset II OJ( IICANCELI 

Figure 5.17 Fill Control 

SOLID COLOR: Fills the area with the current color. There are no additionai 
gadgets associated with this fill type in the Fill Control. 

TRACE EDGES: Traces the edges of the area with a single pixel layer of the 
current color. This is useful for outlining text. 
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BRUSH PATTERN: Fills the area with a pattern of the current custom brush. 
You can realign the position of the pattern by using the Fill Offset gadget. 

GRADIENT: Fills all shapes using the currently selected gradient typeand color 
range. 

GRADIENT TYPE: Clicking the box below Gradient Type cycles you through 
the thirteen available gradient types listed below. 

Options that use a rangeofcolors take their range from the Palette Screen, where 
the range is defined as the colors between the Begin Range Marker and End 
Range Marker. (For information on selecting ranges, see Palette Screen in this 
chapter.) The thickness of the bands of color used in the fill depends on the 
number of colors in the range and the area that those colors are spread over. 
Figure 5.18 shows the four bounding areas used to determine the width of the 
bands of color used in fills. 

Page Width 

1: 
,2> 
:r:
(l) 1: 

Cl 

l 
(l) 'iii 

:r: 

i 
ts 

C/) 

Screen Width 

Object Width 

Figure 5.18 Filled Object and Fill Areas 
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Figure 5.19 shows the result of filling the same circle with the same six color 
range, based on the seven different fill types that use ranges. Notice that the fills 
assume that the page is larger than the screen. 

Horizontal 
Border 

Horizontal Horizontal Horizontal 
Width Screen Page 

Vertical Vertical Vertical 
Height Screen Page 

Figure 5.19 The Seven Range Fills 

Horizontal Border: Fills the area with the current range of colors within the 
borders of each individual horizontal line in the areas, so that the gradient 
follows the contours of the area being filled. This lets you create "pseudo
shaded" objects, if you choose low-contrast colors. 

Horizontal Width: Fills the area with the current range of colors, using bands 
of color wide enough to spread one full set over the rectangle defined by the 
area's widest point - the object width. The effect is as though the rectangle 
defined by the object width were filled with bands of color, and then the filled 
area was cut from within that rectangle. 
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Horizontal Screen: Fills the area with the current range of colors, using bands 
of color wide enough to spread one full set over the screen width. This is a good 
way to paint a background pattern into an area of the picture that is the width 
of the screen. Also, it allows you to use multiple fills, with all of them fitting the 
same pattern of colors. 

Horizontal Page: Fills the area with the current range of colors, using bands 
wide enough to spread one full set over the page width. The filled area will 
contain only the colors that would be used in that area of the screen if the entire 
page were filled. 

Vertical Height: Fills the area with the current range of colors, using bands of 
colors fitted to the area's height, as though it were enclosed in a rectangle. This 
lets you create bounded areas that are smoothly textured, as though lit from 
above or below. 

Vertical Screen: Fills the area with the current range ofcolors spread uniformly 
across the height of the screen. This is a good way to paint a background pattern 
into an area of the picture the same height as the screen. Also, it allows you to use 
multiple fills, with all of them fitting the same pattern of colors. 

Vertical Page: Fills the area with the current range of colors in bands wide 
enough to spread a full set over the page height. The filled area will contain only 
the colors that would be used in that area of the screen if it were filled. This lets 
you create a background pattern that spans the full picture vertically. 

In addition to the range fills, there are six fills that use the current brush and 
either distort it to fill the area, or fill with a pattern made from the brush. As with 
the range fills, each of the brush fills can also be used with a level of Dither to mix 
the colors in the filled area. 

Brush Border: Fills the area using the current brush pattern, fitting the lines of 
the brush within each horizontal line segment found in the area. In the resulting 
fill, the brush pattern may be unusually stretched or shrunk. You can adjust the 
vertical positioning of the brush pattern by using the Fill Offset option. 

Brush Pattern: Fills the area with the current brush pattern. With Dither set to 
its minimum value(fornodither), this gives you the same fill as the Brush Pattern 
gadget at the top of the requester. As you increase the amount of Dither, the 
pixels in the brush pattern move random distances from their normal position. 

112 



This lets you create patterned backgrounds that are not entirely regular. It's also 
a nice way to paint a background with a pattern that's fuzzy, but still recogniz
able. 

Brush Stretch: Stretches the current brush both horizontally and vertically to fit 
the rectangle defined by the object. Brush Stretch fills the area with the current 
brush pattern fitted to thearea's width and height, as though it were enclosed in 
a rectangle. 

Brush Warp: Fills the area with the current brush pattern, resized to match the 
brush edges to the edges of the filled area. This fiII often results in distortion of 
the brush. Used creatively, this can produce surrealistic effects. 

Horizontal Brush: Stretches the current brush horizontally to match the object 
width and then fits the brush between the area's vertical borders. 

Vert Brush: Stretches thecurrent brush vertically to match the object height and 
then fits the brush between the area's horizontal borders. 

DITHER: lets you set the amount of random overlap between colors. To set the 
dither, drag the dither slider left or right. When the slider is at the far left, dither 
is turned off. You can see a representation of the current dither setting in the box 
below the slider. 

HAM CLOSENESS: lets you set how different from each other two shades must 
be before they are considered separate shades. This slider operates only in Hold 
And Modify mode, where two colors can be so similar that it is difficult to 
distinguish them, and yet the differnces in their color values might prevent you 
from filling an area in one fill. 

Ifyou fill an area, and many of the pixels do nottake thecolor of your fill, set the 
slider farther to the right to increase the amount of difference necessary to 
distinguish between thecolors.lf you fill an area and the fill bleeds out ofthearea 
you want to fill, set the slider farther to the left to decrease the amount of 
difference necessary to distinguish between the colors. 

The values for the slider range from 0 to SO. The default setting when you start 
Paint is 15. 
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FILL OFFSET: lets you seta new position for the pattern in BrushPattern modes. 


Brush Pattern modes are normally based on the original position from which 

your custom brush was selected. To change that position, and thus move the 

pattern, click Fill Offset. The Fill Control will disappear. Stampdown thecustom 

brush where you want it to appear in the pattern. The brush is not painted, but 

this poSition is now remembered as the brushes origin. The Fill Control reap

pears after you stamp the brush. Oick OK in the Fill Control to accept your new 

setting. 


MAGNIFY 


Presents a submenu ofoptions that letyou select how the pixels in magnify mode 

are separated from one another. (Note: no vertical break lines appear in HAM 

mode.) 


NORMAL sets no pixel indicator, so the pixels all merge together smoothly. This 

is the default mode when you start Paint. 


LINES sets a single-pixel linebetween the magnified pixels. (Note that in HAM 

mode, there are no vertical lines between pixels.) 


OOTS sets a dotin thecomerbetween magnified pixels, in addition to separating 

the pixels with a single-pixel line. 


PREFERENCES 


Presents a submenu of options that can be toggled on or off. When an option is 

toggled on, a check mark appears beside it. 


WORKBENCH 

Lets you choose whether to display the workbench. When Workbench is 

selected, theWorkbench is opened; this is the default setting when you first start 

the program. Oosing the Workbench frees up additional memory for use by 

Paint. 


TRANSPARENCY (Keyboard Equivalent: Q - on; Shift-Q - off) 

Lets you choose whether the background color is treated as transparent when a 

custom brush is selected. On treats thecurrent background color as transparent. 

Notethat pressing lowercase q on thekeyboard turnsTransparencyon. Pressing 

uppercase Q on the keyboard turns Transparency off. 
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SMOOTH (Keyboard Equivalent: \) 

Lets you choose the degree to which the edges of a shape are smoothed (using 

the anti-aliasing algorithm) when it is sized. This option affects resizing func

tions such as Resize, Resize Draw, and Load At. If Smooth is checked in the 

menu, Paint applies a higher degree of smoothing than when the option is not 

checked. However, some degree of smoothing is always applied. 


CENTER OVALS (Keyboard Equivalents: C - oni Shift-C - off.) 

Lets you choose how to paint ovals. On lets you paint them from the center 

outward as you drag the mouseioff paints them in the area defined bythe cross

hair as you drag the mouse from corner to corner. 


NO BACKGROUND 

Lets you choose whether the Paint Modes can select Color 0, the background 

color, when painting. On prevents a painting mode from selecting Color Oi off 

allows a painting mode to select it. (This mode is especially useful when using 

Genlocks.) 


FONTS MENU 

,i . 
Load New Font ~F 

Stlo'le 
! oJ' topaz 8 ~1 

topaz 9 ~2 
~3 
~4 
~S 
~6 

Figure 5.20 The Fonts Menu 


LOAD NEW FONT (Keylxlard Equivalent: Right Amiga-F) 


Brings up the Load Font Requester, which lets you select a font to be added to the 

font list. 
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Load Font 
diaMond 1.2 
diaMond 28 
eMepald 1.7 
eMepald 28 
gapnet 9 
gapnet 1.6 
opal 9 
opal 1.2 

I CANCEL 

Figure 5.21 The Load Font Requester 

Select Load New Font and dick in the font requester on the name of the font you 
want. If its name is not visible, use the scroll gadget on the left to scroll through 
the listings. New fonts are added at the top of the list. You can have only six fonts 
in the Fonts menu at a time. Ifyou have six fonts already and you load in a new 
one, it is added to the top of the list, with the font at the bottom removed 
automatically. 

• 	 TIP: A handy way to use custom fonts from a font directory other than the 
system's: Open a new screen in Paint; Use the CLI (sorry) to reassign your 
fonts path (for example, ASSIGN Fonts: df1:fonts); then use the fonts menu 
of the new screen to select your custom font. 

STYLE 

Presents a submenu of text styles. With the exception of Plain, selecting a style 
from the submenu turns it on, with a check mark appearing beside its name on 
the list. You can apply any combination of styles to your text. Selecting Plain 
turns all of them off. 

PLAIN (Keyboard Equivalent: Ctrl-P) 
UNDERLINE (Keyboard Equivalent: Ctrl-U) 
ITALIC <Keyboard Equivalent: Ctrl-I) 
BOLD (Keyboard Equivalent: Ctrl-B) 

Note: Using the Italic style with a font larger than 50 points will greatly distort 
the font. 
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[FONT NAMES) 

(Keyboard Equivalent: Right Amiga-l through 6) 


The lower portion of the Fonts menu lists the last six fonts used in Paint. You can 

select a font by choosing it from the menu, or by typing its keyboard equivalent. 


II MEMORY MANAGEMENT 

To giveyou the flexibility oflarge pagesizes, custom brushes, Affect Modes, and 
Paint Modes, Paint uses a large amount of memory. As a result, you may occa
sionally encounter memory shortage while perfonning a memory-intensive 
operation. 

Memory shortage can manifest itself in various ways. For example, ifyou are at 
the limits of available memory, and you select a large brush, Paint conserves 
memory by displaying just the outline of the brush rather than the brush itself. 
When you paint with the brush, the image will appear on the screen as usual, 
even though it may not be visible as you move it around the screen. When this 
happens, you should take some action to free some memory. Other symptoms 
oflow memory are: the menus or submenus don't open; you can't select a custom 
brush; you can't rotate a brush; you can't open a new screen. 

Some ways to free memory are: Close the Workbench; select a smaller custom 
brush; ordose some open screens. When all else fails, restart the computer so that 
memory isn't fragmented. 

Ifyou ever select a custom brush and then can't display the Brushes menu to 
save the brush, use the keyboard equivalent Right Amiga-P. 
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This chapter takes you through aquick tour ofPosters. In the process, you'll learn about 
almost every feature of the program, and you'll finish by printing a poster. 

THE POSTERS SCREEN 

When you first start Posters, the Posters Screen appears. The screen is made up 
of a Title/Menu Bar, the Page Grid, Poster Size gadgets, and Page Size gadgets 
as shown in Figure 6.1 below. 

P05te~S IIiIIOI 
SIERlinTH 
8.1 inches 

POSTER HEIGHt 
B.I inches 

PAGE limNI 
1.5 inchesi ,='• 

PAGE HEIGHT 
I !~I[!) 11.1 illches 

Pasts Midt U 
Pasts Hish U 
rotal PagfS 
Past •• 

Figure 6.1 The Posters Screen 
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SETIING YOUR PAGE SIZE 

Each rectangle in the Page Grid represents one page. When you first start 
Posters, the program uses your current Preferences setting. (If you are not 
familiar with Preferences, see your Amiga User's GUide.) 

• 	 To change the page size to match the size of the paper you are using, click 
the arrows of the Page Width and Page Height gadgets. 

As youchangethe sizeofthe pages, you'll see thatthe rectangles in the Page Grid 
adjust to reflect the new page size and the number settings show the new size in 
inches. Clicking thePage Width arrow that points left makes the pages in the grid 
narrower. Oicking the arrow that points right makes the pages wider. The 
arrows beside Page Height work the same way: the top arrow (pointing up) 
makesthe pages shorter, and thebottom arrow (pointing down) makes the pages 
longer. 

• 	 Use the Page Width and Page Height arrows to set the page size to match 
the size of your paper. (You won't have to do this step if your Amiga 
Preferences were already set to the correct paper size.) 

This is the first step you'll want to do every time you use Posters. 

LOADING A PICTURE 

• To load a picture, select Load from theProject menu. (To do this, hold down 
the right mouse button to display the menus, point to theProject menu, pull 
the highlight down to Load, and release the mouse button.) 

The Load Requester appears for you to select a file to load. The requester works 
exactly like the requester described in the Getting Started section of this manual. 

• 	 Press V to display the volumes. Click the volume PhotoLab Art to display 
the contents of the art disk. Click the directory HAMx400 to display the 
contents of that directory. Click the file ComicPoster and click Open to load 
that picture. 
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The picture appears as a gray rectangle in the upper half of the first page in the 
Page Grid. 

SIZING YOUR POSTER 

When you first load a picture, it is sized to fit the current Page Width. Poster 
Width and Page Width are now the same. There are two ways to change the size 
of your poster. One way is to drag the lower right corner of the gray picture 
rectangle with the pointer. The other is to click the arrows beside Poster Width 
and Poster Height. You will usually want to use both of these methods. 

DRAGGING THE POSTER 

• 	 Place the pointer anywhere on the Page Grid and pressdown the left mouse 
button. 

The poster size adjusts so that either the right or bottom side of the poster aligns 
with the position of the pointer. (The other edge of the poster may not meet the 
pointer, because at the moment PosteN is set to maintain the aspect ratio of the 
picture.) 

• 	 With the mouse button held down, drag thepointer around in the Page Grid 
to see how the poster size responds. 

CLICKING THE ARROWS 

• 	 To fine tune the size ofyour poster, click the Poster Width or Poster Height 
arrow gadgets. 

Notice how clicking the arrows changes the poster size. The numbers for Poster 
Width and Poster Height also change one tenth of an inch for each click. This 
allows you to carefully size your poster to make the best use of your page size. 
Ifyou point to one ofthe arrows and hold down the mouse button, the poster size 
changes continually until you release the mouse button. 
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ASPECf RATIO 

As you changed the poster size above, the picture's aspect ratio was always 
maintained. Ifyou like, you can size the poster to any dimensions by turning off 
the Aspect Ratio option in the Mode menu. 

• 	 Select Aspect Ratio from the Mode menu to remove the check mark beside 
the option. 

Now you can set t he width and height of the poster independently, so the poster 
can be any size. (Though selecting a size that is not a multiple of the normal 
picture size will result in a distorted printout.) Try sizing the poster now,and you 
will see that the lower right comerofyour poster always meets the pointer as you 
drag. 

When you tum Aspect Ratio back on, the poster height automatically adjusts to 
the proper size to preserve the aspect ratio. 

• 	 Select Aspect Ratio from the Mode menu now and watch the Poster Height 
adjust. 

PREVIEW 

The Preview option in the Mode menu replaces the standard gray poster 
rectangle with a representation of the picture you are working with. 

• 	 Make the picture fairly large and then select Preview from the Mode menu 
to see how this works. 

This function is useful ifyou want toseehowthe printed pages will becombined, 
or if you want to print an area that is smaller than the total picture. Note that 
Posten displays the picture representation only until you select another func
tion. 
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HORIZONTAL PRINTING 

Posters lets you choose how the picture is oriented on the pages in the printed 
poster. At the moment, the Horizontal Printing option in the Mode menu is 
selected, so the poster prints horizontally across upright pages. You can see this 
is true if you select Preview to see the picture in relationship to the pages. 

• 	 Select Horizontal Printing from the Mode menu to tum the option off. 

The Page Grid turns sideways in relation to the picture. Now you can see that if 
you held one ofthe 81/2by 11 inch pages upright, the picture would be printed 
vertically in relation to the page. 

Whether it is advantageous to have Horizontal Printing on or offdepends on the 
original size of your picture and the finished size you want your posterto be. For 
example, if you want to create the largest poster of ComicPoster that you can fit 
on a single 8.5 x 11.0 inch page without changing the aspect ratio, you want 
Horizontal Printing off. If you want to create the largest poster of ComicPoster 
that you can fit on eight pages, you would want Horizontal Printing on. 

Remember that the best combination of printing orientation and poster size 
depend on the size of your original picture, so you should always try different 
settings for Horizontal printing to see which is best. 

WHICH PAGE IS NEXT? 

As you look at the Page Grid, it might not be apparent to you what order the 
pages print in. Posters provides a simple way to see the page ordering scheme: 

• 	 Place the pointer over a page ofthe poster and look in the bottom left comer 
of the screen; the number beside Page is the number of the page you are 
pointing to. 

• 	 Now move the pointer around to see how the page numbers change. The 
upper left comer ofthe poster is always page one, and page two is either to 
the right or down. 
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If you ever want to print an area of your picture that is smaller than the total 
poster, you can identify the pages for that area by selecting Preview and using 
the pointer to find the page numbers. In a moment, you'll see that the Print 
Requester lets you specify exactly which pages you want to print. So you can 
print a small section, or start over in the middle ifyou run outof paperor ribbon 
while you are printing. 

THE PRINT REQUESTER 

Right now, let's set up the poster size and print a small poster. The instructions 
that follow assume that you are using paper that is 8.5 x 11 inches and in 
continuous form rather than single sheets. 

• 	 Open theMode menu to confirm that Aspect Ratio and Horizontal Printing 
are both checked as on. 

• 	 Check that your Page Width is 8.5 and Page Height is 11.0. 

• 	 Drag the poster to be approximately two pages wide. Then use the Poster 
Width and Height arrows to set the poster size to exactly 17.0 inches wide 
and 10.6 inches high. Look in the lower right corner of the screen to confirm 
that the poster takes two pages to print. 

• 	 Now select Print from the Project menu. 

The Print Requester will appear and look something like this: 
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I HUM!!!' or COli!!s (I I 

I Stal't !II Stop • I 


Pause billte. At: 


I Pages I I C.IUI'II5 II 

I 

Eject Papl!l' At: 


I Pages I I C.lUl'lls I 

I Sl'IOotll I 
I WIIi te BackEound I

••• .!iMIJ. 
Figure 6.2 Posters Print Requester 

The function of most of the gadgets in this requester are probably dear to you 
without explanation, but just in case, we'll quickly run though each of them. 
Don't change anysettings yet, we'll tell you which options to change after werun 
through the explanations. 

Number of Copies: simply lets you set the number of copies you want to print 
of your poster. To change the number of copies, click the number, press Del or 
Backspace to remove the old number, then type the new number and press 
Return. When you select more than one copy, Posters prints the poster the 
number of times you requested. 

Start and Stop: let you specify which page in the poster should be the first page 
printed and which should be the last. As wementioned above, this is useful ifyou 
want to print a poster-size image that is only a small part of a picture, or if you 
run out of paper or ribbon in the middle of printing a poster, you can start over 
from where you left off. 

Pause Printer At: lets you pause the printer after each page oreach column. The 
default setting is for the printer to print continuously without pausing. Ifyou are 
using single sheets, you'll want to pause after each page, or if you're printer 
doesn't hold the alignment very well, youmight want to pause after each column 
to adjust the alignment. To select one of these options, simply dick that button. 
Ifyou want to tum off a selection, dick the button again. 
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Eject PaperAt: lets you set the paper to eject after each page or each column. The 
default is for the printer to print without intervening paper ejects. If you want 
each strip of your poster to line up identically, you probably want to eject after 
each column to reset the top of form. 

Smooth: reduces the "jaggedness" of the image as the poster is printed using a 
function known as anti-aliasing. This is similar to the smooth function in Paint. 
Note that smooth requires additional memory to perform the smoothing calcu
lations. Depending on the amount of memory in your computer, you may not be 
able to use smooth if you are trying to print a large poster. 

White Background: When this option is set, any area of your picture that uses 
Color 0 will not be printed. Thus, if yourbackground color is Color 0 and you are 
printing on white paper, the result is a white background. This is a great ribbon 
and ink saver and also speeds up the printing. 

Now let's actually print the poster. 

• Make sure that your printer is properly connected to the computer and is 
turned on. 

• If you are using continuous paper, don't change any of the settings in the 
Print Requester. Just click Print. 

• If you are using single sheets of paper, click Pages in the Pause Printer At: 
option and then click Print. 

A requester appears to tell you which column is being printed This requester also 
contains a Stop button for you to cancel printing if you wish. How long it takes 
to print a poster will depend mainly on how fast your printer can print. In any 
case, we think you'll find the results are worth the wait. 

This chapter walked you through almost every function of Posters. If you 1uroe specific 
questions about how a particular feature works, you may find mnre information in the 
Posters Reference section. The Posters Reference will come in handy later, when you 
just want to look something up quickly. 
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This chapter summarizes the commands and functions in Posters. Because this chapter 
is intended for reference only and not as away to learn the program, the descriptions are 
as concise as possible. If you read an entry in this chapter and don't fully understand how 
the feature works, look through the Posters Guided Tour to see if there is a step-by-step 
example. 

a THE POSTERS SCREEN 

When you start Posters, the first thing you will see is the Posters Screen. See 
Figure 7.1. This screen consists of a Title Bar /Menu Bar, a Page Grid, gadgets for 
setting your Poster Size and Page Size, and a display to showyou the current size 
of your poster. 

Figure 7.1 The Posters Screen 

TITLE BAR 

The Title Bar at the top ofthe Posters Screen shows the name of the program and 
the name of the last flie you loaded, if any. The Front Gadget and Back Gadget 
on the right side of the title bar work as they do on normal Amiga screens. 
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MENU BAR 

When you press the right mouse button, the Menu Bar displays the menu names. 
Then pointing to the menu name opens that menu. 

THE PAGE GRID 

The large checkerboard area ofthe screen is the Page Grid. Each rectangle in the 
grid represents one page. The size of each page (and thus each rectangle) is set 
using the Page Size gadgets. The page size is initially set to the same size 
indicated in Preferences. 

When you load a picture to be printed, it is represented on the grid as a solid 
rectangle on the first page (in the upper left corner of the Page Grid). When the 
picture is first loaded, the poster width is sized to fit the current page width and 
the poster height is sized to maintain the picture's aspect ratio. 

You can size the poster by placing the pointer on the Page Grid and holding 
down the mouse button. The solid rectangle representing the poster enlarges or 
shrinks sothatthe lower right corner aligns with the pointer. (If youhave Aspect 
Ratio in the Mode menu selected on, either the right or bottom edge of the poster 
aligns with the pointer position, but the poster sizes to maintain the picture's 
aspect ratio.) When you release the mouse button, the poster stays the size you 
selected with the pointer. Notice thatthe numbers in thePoster Wid th and Poster 
Height gadgets show the new poster size. 

You can also size the poster by using the Poster Width and Poster Height 
gadgets. 

POSTER SIZE GADGETS 

Clicking on the arrows beside Poster Width and Poster Height changes the size 
of the poster by one tenth of an inch for each dick. Ifyou point to an arrow and 
hold down the mouse button, the poster size increases continuously until the 
maximum size is reached. Notice that the numbers in thegadgets showthe new 
poster size as it changes. 
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PAGE SIZE GADGETS 


fJ MENU rrEMS 

The Page Size gadgets allow you to change the size ofthe paper you use, without 
changing the settings in Preferences. Oicking on the arrows beside Page Width 
and Page Height changes the size of the pages by one tenth of an inch for each 
click. If you point to an arrow and hold down the mouse button, the page size 
increases continuously until the maximum size is reached. (The maximum 
width or height is 120 inches.) The rectangles in the Page Grid immediately 
adjust to represent the new page size. The numbers in the Page Width and Page 
Height gadgets display the new size in inches. 

Posters's menu items remain hidden until you move the cursor to the top of the 
screen and press the right mouse button. As you move the cursor horizontally 
across the Menu Bar, one after another of the menus drops down to reveal its 
selection of options. Moving the cursor down the selection ofoptions highlights 
each one. Releasing the mouse button when a menu option is highlighted selects 
that option. 

In many cases, you can select a menu item by using its keyboard equivalent. 
Keyboard equivalents, where available, are shown next to the corresponding 
item in the menus and in the descriptions that follow. You can find a table of 
keyboard equivalents at the end of this reference section. 

The menus, reading from left to right across the Menu Bar, are as follows: 
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PROJECT MENU 


Load. e:::JL 
P:r in t e:::JP 
About 
Qui t e:::JQ 

Figure 7.2 Project Menu 

LOAD_. (Keyboard Equivalent: Right Amiga-L) 

Brings up the Loade File requester. See FIgure 7.3. The requester contains Open 
and Cancel buttons, a field to display the current directory path, a file list 
window with arrows and a slider for scrolling the window, and an edit field that 
displays the currently selected file. 

O,rn II Cancel 

"IlOTOLAB: 

Figure 7.3 Load File Requester 

To load a picture, click the name of the file you want to open and then click the 
Open button at the top of the requester. 

In addition to files, the window displays Directories, Volumes, and Clipboards. 
If you click a subdirectory name, the window displays all of the files contained 
in that subdirectory. Qicking the listing I (parent) moves you into the parent 
directory of the current subdirectory. Ifyou click a Volume name, the contents 
of that volume are displayed. Also, if you place a different disk in a drive while 
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the Load File requester is displayed, the Volume list is updated to show the new 

disk. If that drive was the current drive, the window displays the files in the new 

disk. 


Shortcuts 

Several shortcuts are available in the Load File Requester. 


Double clicking on a file name is the same as clicking the file name and clicking 

Open. 


Clicking ona section title in the displaywindow such as "-Files-" will skip the 

window display down to the next section. 


Keyboard shortcuts 

Key Function 

ESC Cancel 
UpArrow Move display up one line 
Down Arrow Move display down one line 
Shift Up Arrow Move display up one section 
Shift Down Arrow Move display down one section 
Return Same as clicking on Open 
D Shows the directories 
F Shows the files 
V Shows the volumes 

PRINT (Keyboard Equivalent: Right Amiga-P) 

Brings up the Print requester, which contains various printing options and lets 
you print your poster. (Note that you cannot select Print until you have opened 
a picture file.) The options in this requester are as follows: 

NUMBER OF COPIES 

Lets you set the number of copies you want to print of a single poster. To change 
the setting, click in the gadget, backspace to erase the current setting and type a 
new number. 
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START and STOP 

These gadgets let you set the range of pages to be printed. When you first select 
the Print option these gadgets are set to print the whole poster (Start is set to 1, 
and Stop is set to the last page number). Ifyou want to print a section smaller than 
the total poster, you can change the settings to print any range. To change each 
setting, dick in the number box, use Backspace or Delete to remove the existing 
number, type the new number of copies, and press Enter. 

PAUSE PRINTER AT: 

This feature lets you pause the printing at either page or column boundaries. 
With continuous feed paper, this feature lets you adjust the paper occasionally 
to ensure that the alignment is correct. If you are printing on single sheets of 
paper, select Page. This interrupts printing after each page so you can insert the 
next sheet of paper. 

EJECT PAPER AT: 

This feature lets you eject the paper at the end of each page or column. Ejecting 
the paper ensures that the next page or col umn will begin at the top of a sheet of 
paper. 

SMOOTH 

When Smooth is not selected, the individual pixels ofenlarged pictures print as 
small rectangular areas. With Smooth selected the contents ofadjacent pixels are 
considered during the printing process and the edges between pixels are 
"smoothed" (in a process known as anti-aliaSing). This smoothing increases the 
apparent resolution ofthe picture. (Note that theeffectivenessofthis feature will 
vary from printer to printer. Also, the extra calculations required for the 
smoothing effect will noticeably slow the printing process.) 

WHITE BACKGROUND 

When White Background is selected, areas of the picture that use color register 
o(zero) are not printed. For example, ifyou had a picture of a bird on a solid blue 
background, only the bird would be printed if the blue background color was in 
color register O. 
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CANCEL 


Closes the Print requester without printing the poster. 


PRINT 

Prints the poster. Once printing has started, a requester box appears to tell you 
what range of pages is printing. This requester contains a Stop button soyou can 
abort printing at any time. 

Note: Do not change the Amiga printer preferences while you are printing. Any 
changes could adversely affect the poster. 

ABOUT 

Brings up a requester that gives the name of the program, copyright information 
and the developers' names. 

QUIT (Keyboard Equivalent: Right Amiga-Q) 

Exits Posters. 

MODE MENU 

Preview f'!JV 
""Aspect Ratio f'!JA 
""Horizontal Pl'inting (l'DH 

Figure 1.4 Mode Menu 

PREVIEW (Keyboard Equivalent: Right Amiga-V) 

Changes the rectangle in the Page Grid from a solid color into a representation 
of the picture you are working with. This lets you see the relationship between 
the individual strips of paper and the completed poster. 
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ASPECT RATIO (Keyboard Equivalent: Right Amiga-A) 


When this option is selected, the poster can only be enlarged or reduced to a 

width and height combination that maintains the picture's original aspect ratio. 

This means that when you try to resize the poster by dragging the pointer on the 

Page Grid, the right edge of the poster moves to align with the pointer, but the 

height adjusts to a setting that maintains the picture's aspect ratio. If you use the 

arrows beside Poster Width or Poster Height to change the size ofthe poster, any 

arrow will change both the width and height. 


When this option is not selected, you can change the poster's width and height 

independently, and Posters will not attempt to maintain the aspect ratio. 


HORIZONTAL PRINTING 

(Keyboard Equivalent: Right Amiga-H) 


When Horizontal Printing is selected, the poster is printed horizontally in 

relation to the paper. In other words, ifyou are printingon81 /2by 11 inch paper 

andyou have Horizontal Printing selected, the finished poster is assembled from 

sheets of paper that are upright, and the poster will have printed horizontally 

across each page from left to right. 


When Horizontal Printing is not selected, the poster is printed vertically in 

relation to the paper. Ifyou are using 81 /2by 11 inch paper, the finished poster 

is assembled from sheets of paper that are sideways, and the poster will have 

printed vertically across each page from top to bottom. 


To see the order in which the pages will be printed, place the pointer in the 

upper left corner of the poster and look at the number to the right of Page in 

the botton right corner of the screen. (The upper left corner of the Page Grid 

is always the first page to print.) Next, move the pointer one page down or 

one page to the right and check the page numbers. You'll quickly find the or

der in which the pages are printed. This feature is also important if you want 

to print only a small section of the picture. Using the pointer, you can find the 

starting and ending page numbers for the section you want to print. 
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This chapter takes you through a quick tour of Colors's primary features. Although it 
doesn't cover every aspect ofthe program, the tour will show you how each ofthe gadgets 
on the Command Screen work with step-by-step examples. Once you've completed this 
tour, you'll be well equipped to use the program on your own. If you need information 
about a feature not specifically covered in the Guided Tour, take a look in the Colors 
Reference Section. There you'll find each feature of the program explained in detaIl 

WHEN YOU START 

When you first start Colors, the Colors Command Screen opens in the lower half 
of your monitor and the upper halfof the monitor shows the Workbench screen 
below the Command Screen. The gadgets on the command screen are not active 
until you load a picture with which to work. So let's do that now. 

LOADING A PICTURE 

• To load a picture, select Load from the Project menu. (To do this, move the 
cursor onto the Command Screen, hold down the right mouse button to 
display the menus, point to the Project menu, pull the highlight down to 
Load, and release the mouse button.) 

The Load Requester appears for selecting a picture to load. This requester works 
exactly like the requester described in the Getting Started section of this manual. 

• 	 Press V to display the volumes. Click the volume PhotoLab Art to display 
the contents of that disk. Click the directory HAMx400 to display the 
contentsofthat directory. Click the file PhotoGirl and dick Load to load that 
picture. 

In a moment, a picture of the photo girl holding a camera appears behind the 
Command screen. 
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THE COMMAND SCREEN 

Now that you have a picture loaded, more infonnation appears in the Colors 
Command Screen. As you can see, there are many gadgets on this screen. Figure 
8.1 below shows the Command Screen with each of the parts labeled for easy 
reference. In the rest of this chapter, we'll take a qUick look at all parts of the 
screen. Then we'll use a few options in the menus. 

Color Statistics Display 

Aegislar Graph 	 Flags (Mined) 

Figure 8.1 The Colors Command Screen 

WHICH SCREEN IS ACTIVE? 

When you have two screens open in addition to the Workbench, it's important 
to know which screen is the active screen. The Colors Command Screen helps 
you with this by displaying the name of the active screen on the right side of the 
Title Bar. At the moment, the Title Bar displays"Active: Command" to tell you 
that the Command Screen is the currently active screen. 

• 	 To make a screen the active screen, you sim ply dick on it with the left mouse 
button. Oick on the picture screen now to see how this works. 
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The Title Bar on the Command Screen now displays "Active: Picture". When the 
Colors Palette is active (you will seethe Palette laterin this chapter), the Title Bar 
displays "Active: Palette." If a screen other than one of these three is active, 
Colors cannot identify the screen and displays "Active Unknown" in the Title 
Bar. 

MOVING THE SCREEN OR PICTURE 

You can move Colors screens just as you would any other Amiga screen. 

• 	 Point to the title bar of the screen you want to move, hold down the left 
mouse button and drag the screen up or down. 

You can also move the picture inside its screen. Here's how: 

• 	 Make the Picture Screen current by clicking on it, then point to the picture, 
hold down the right mouse button and drag up or down. (lfit doesn't move, 
you're at the top or bottom of the picture.) 

If the picture is wider than the Picture Screen <PhotoGirl is the same size as the 
screen), you can also drag the picture to the left or right in the same way. 

THE COLOR STATISTICS DISPLAY 

Directly below the Title Bar in the Command Screen, you see the Color Statistics 
Display. This area shows information about the components of any color in the 
picture. 

• 	 To obtain information about a color, place the cross-hair on that color in the 
Picture Screen and press the left mouse button. 

Ifyou hold down the mouse button and move the cross-hair around, the Color 
Statistics Display will continually update to show information for the color 
under the cross-hair. 
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CO LO R : 

• 	 To get a closer look at the pixels you are pointing to, press Shift while you 
hold the mouse button down. 

This brings up a small grid of magnified pixels, which shows the area around the 
cross~hair. The pixel in the center of the grid is the selected pixel, the one directly 
in thecenterofthecross-hair. !fyouhold down Shift, the grid ofmagnified pixels 
remains beneath the cross-hair. Ifyou release Shift, the grid remains at the point 
where you released Shift, but the grid continues to show the pixels under the 
cross-hair. 

The Color Statistics Display gives values for the following color components: 

Red, Green, and Blue (RGB) 
Hue, Saturation, and Value (H5V) 
Yellow, Cyan, and Magenta (YCM) 

These values identify a color more exactly than you can by looking at it on the 
screen. This is particularly true if you are working with fine shadings of what 
appears to be the same basic color. !fyou aren't familiar with color theory, take 
a look at AppendiX A: A Little Color Theory, where you'll find information 
about how Red, Green, and Blue are combined to form a color in additive color 
theory. 

In addition to information about a color's components, you can determine the 
number ofpixels on the screen that are using that color. This pixel count is called 
the Population (P) of the color. You can also see the percent (%) ofthe total pixels 
that the Population number represents. At the moment, all of the colors show a 
zero population, because this pixel count is not calculated until you click the P 
button in the lower left corner ofthe Command Screen. (We'll explain this button 
in a moment.) 

The area on the left side of the Color Statistics Display shows the currently 
selected color and the color register number that the color is assigned to. 

• 	 For example, if you hold down the mouse button and move the cross-hair 
around in the red lettering of the slogan, you'll find that this color area is 
entirely dark red and the dark red color is assigned to color register 10. 
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In HAM display modes, colors that are not register colors (called HAM colors) 
are labeled by the color component that was changed, and the value to which it 
was changed. For example, R3 would indicate that the current HAM pixel is the 
same color as the pixel before it (to the left), except that the Red component has 
been changed to a value of 3. This means that HAM pixels with the same 
identifying number could be different colors depending on the color that 
preceded them. If you'd like a more detailed explanation of how Hold and 
Modify modes work, take a look at Appendix B: Amiga Display Modes. 

THE REGISTER GRAPH 

The large bar graph below the Color Statistics Display is the Register Graph. It 
shows the relative content of a color component in each ofthe color registers. At 
the moment it displays the relative red content of each register. 

The leftmost bar in the Register Graph is always Color Register 0, the next bar to 
the right is Color 1, and so on. You can see which color is assigned to a particular 
register by clicking on that register. 

• 	 Click the first bar to see the color that is assigned to Color O. (Clicking 
anywhere in the space above a bar is the same as clicking on the bar.) 

The information for Color 0 appears in the Color Statistics display. (The bar also 
turned red to indicate that the register is now locked, we'll explain what that 
means in a moment.) The bars in the register graph also help you to see which 
areas of the picture are using a particular color register. 

• 	 Point to the bar representing Color 0 and hold down the left mouse button. 

This causes all of the pixels that use Color 0 to flash. 

RGBHSVPBUTfONS 

The buttons to the left of the Register Graph determine which color component 
is represented by the graph. There are buttons for Red (R), Green (G), Blue (B), 
Hue (H), Saturation (5), Value (V), and Population <Pl. When you first start 
Colors and load a picture, the Register Graph displays the relative red content 
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of each register. (The word Red just below the Register Graph reminds you that 
the red content is being displayed.) If you click the G button, the relative green 
content of the registers is displayed. 

The Population button (P) is particularly important. 

• 	 Click P now. 

When you click P, Colors counts the pixels in the picture and displays the relative 
pixel count for each register in the graph. Also, the Color Statistics Display now 
shows the pixel count for the current color and the percent of the total that this 
count represents. 

ARROW BUTIONS 

The arrow buttons to the right of the Register Graph let you change the color 
content of pixels. For example: 

• 	 Click the R button to display the red content of the pixels. Finally, click the 
up arrow twice (wait for the first change to complete before clicking the 
arrow the second time). 

You'll see that the picture becomes very slightly redder and the bars in the graph 
increase in height. (Notice that the bars change proportionally. That is, tall bars 
grow or shrink faster than short bars in order to retain the relative heights). 

• 	 Click the down arrow twice to return the picture to its original state. 

Finally, click somewhere else in the Command Screen. 

You'll see the message "Commit Changes" in the Progress Display. After you've 
made changes to the Red, Green, or Blue color values with the arrow buttons, 
clicking on an area of the screen other than the RGB buttons, the arrows, or the 
Undo button "commits" your changes. (This extra step isn't necessary when you 
use HSV. You'll find more information about this in Chapter 10, Colors Refer
ence.) 
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LOCKING REGISTERS 

You've already seen that a register can be locked or unlocked. This is an 
important distinction, because locked registers arenot affected by changes to the 
Register Graph. This means that you can change the values in selected registers, 
and thus change only selected colors of a picture. Let's see how that works by 
changing everything except the slogan and the word PHOTOLAB at the bottom 
of the picture. 

• 	 First you need to identify the register colors that you want to lock. You can 
do this by pointing to each of the register bars and holding down the left 
mouse button to see which areas of the picture flash. You want to lock the 
red that is used in the slogan and the blue of PHOTOLAB. (We'll tell you 
right nowthat you want to lock registers 5 and 10-remember that the first 
bar on the left is register 0.) 

• 	 Once youhave identified the registers you want to change, and have locked 
the others, click the G button. 

• 	 Click the Up-arrow three times (wait for each change to complete before 
clicking again) and watch as the picture becomes greener while the slogan 
and PHOTOLAB remain the same. 

• 	 Now click the Down-arrow three times to return the picture to its original 
colors. 

In addition to locking and unlocking registers individually, you can lock all of 
them at once by clicking Set or unlock all of them by clicking Clr. 

SORTING THE GRAPH 

You can sort the Register Graph by selecting a sort from the menus. Here's how 
it works: 

• 	 Click Clr to unlock all of the registers. 

• 	 Select Sort On from the Color menu and select Population from the 
submenu presented by Sort On. 
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In a moment your Register Graph is sorted based on the pixel count ofeach color 
register. Notice that the Register Graph automatically changed over from 
displaying the Green content to displaying the Population. 

Whenyou sort the Register Graph, youare also sorting the picture's palette and, 
as a result, pixels in the picture may receive their color from a different color 
register. The colors in the picture don't change, but the register number they use 
does. For example, when we explained howlocking a register works, wehad you 
lock register 5 to keep the word PHOTOLAB from changing color. Ifyou check 
now, you'll see that the blue in PHOTOLAB is now assigned to register 6 as a 
result of sorting on Population. If you sorted the picture on Red content, this 
color blue would be assigned to color register 14. 

Sorting the picture on Population is especially useful because it allows you to 
quickly determine which colors in your picture are using the fewest pixels. This 
is important if you need to reduce the numberof color registers being used in the 
picture. In the next chapter, we'll show you how to use the Sort option and the 
Palette to reduce the number of color registers used by a picture. 

You can sort the graph on anyone of the attributes, in the Sort On submenu. 
You'll notice that the first seven options are the same as the attributes repre
sented by the RGBHSVP buttons. The last option, Locks, sorts the graph so that 
all locked registers are moved to one end of the graph. 

OOPS, THAT'S NOT WHAT I WANTED 

There is one very important gadget on the Command Screen that you need to 
know about now; it's the Undo button in the lower right comer. Oicking Undo 
reverses the last operation you performed, as long as there was not an interven
ing mouse click or keyboard command. 

• Click Undo now. 

Ifyoudidn'tclick anything after se1ectingPopulation from the Sort Onsubmenu, 
the Register Graph returns to it's unsorted state. Note that you can't Undo an 
Undo. 
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THE FLAGS 

The black buttons around Undo are the Flags. Each of these buttons has two 
settings. 

• 	 Click the Srt HiLo button, above the Undo button. 

When you click this button it changes to Srt LoHi. This button controls whether 
your sort of the registers is arranged from the highest value to the lowest (Srt 
HiLo) or from the lowest value to the highest (Srt LoHO. To see how this works 
do the following: 

• 	 Set the button toSrt HiLo and select Red in the Sort Onsubmenu of the Color 
menu. 

The result is a Register Graph displaying color registers in descending order 
based on their red content. 

• 	 Now set the button to Srt LoHi and select Red sort again. 

This time the Register Graph displays the registers in ascending order based on 
their red content. 

The other flags work in a similar fashion: each has two settings, and the setting 
determines how some other operation is performed. You'll find information 
about all of these flags in the Reference section for Colors. In that section, each 
flag description lists the operations that are affected by the flag. 

REAUfEST 

The most important flag for you to understand right now is the Real/Test flag. 
Whileyou'vebeen working with Colors, you've been working with the Real flag 
set, so that yourchangesand operations have actually affected the picture. Ifyou 
change the setting to Test, most operations will only affect the appearance on the 
screen, and changes that might otherwise be permanent can now be reversed. 

• 	 Set the Real/Test button to Test now so that you will be able to undo the 
operations we'll show you next. 
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THE OPERATIONS 


Above the Flags there are three red Operation buttons. These buttons perform 
some operation on the picture that requires you to set values before you select 
theoperation. The three Operation buttons are Mosaic, Resize, and Reduce. Let's 
take a quick look at Mosaic to see how the Operations work. 

Mosaic breaks the picture up into regions and changes all of the pixels in each 
region to a single color. <Thecolor used fora region dependson the colors in the 
region, and on whether the Sample/Smooth flag is set to Sample or Smooth. 
You'll find more information in the Reference section aboutSampleandSmooth. 
For now, leave the flag set to Sample.> 

The firstthingyou need todo is to set the numbers beside Mosaic. These numbers 
determine the horizontal and vertical dimensions for each region. The regions 
are measured in pixels. 

• 	 Place the pointer on the top half of the number 1 beside Mosaic and click the 
left mouse button three times to set the number to 4. Do the same with the 
other number. 

Clicking with the pointer on the top half of a number increments the number. 
Clickingon thebottom half of the number decrements the number. You can also 
position thepointerand hold down the mouse button to increment ordecrement 
the number continuously until you release the mouse button. 

• 	 Once you've set both numbers beside the Mosaic button to 4, click Mosaic. 

In a second, the picture changes to a mosaic of rectangles. 

• 	 Click Undo to reverse this change and try some other Mosaic settings. Be 
sure to Undo after each change so that the picture will be back to normal 
when you move on to the next section. 
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THE PALETTE 

• 	 Select Palette from the Color menu to bring up the Palette window. 

The Palette is a color coded version of the Register Graph, but it has a different 
function. The Palette gives you control over the arrangement of registers and 
howcolors are mapped to the registers. This is important ifyou want to combine 
elements from different pictures. You'll learn more about the Palette in the next 
chapter if you work through the Palette tutorial or you could simply use the 
Colors Reference section to learn how the Palette functions work. 

Figure 8.2 The Colors Palette 

• 	 To dose the Palette, click the close box in the upper left comerofthe Palette 
window. 

SOME QUICK EFFECTS 

In this section you'll get a quick look at some powerful features ofColors that are 
available through simple menu selections. The best way to understand these 
features is to see them work, so we'll have you select them one by one and then 
Undo the change. 

• 	 Make sure that the Test flag is set before you perform these operations, 
because some of them are not undoable otherwise. 
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SEPARATE: 

The Separate option in the color menu offers a submenu of options to separate 
the colors of your picture on Red, Green, Blue, Yellow, Cyan, Magenta, and 
Black. Selecting Green, for example, will provide a "green-only" separation of 
the picture. 

• 	 To understand how this works, click any color in the picture and lookat the 
RGB values shown in the Color Statistics Display. 

• 	 Now, select Green from the Separate submenu of the Color Menu. 

The picture turns completely Green, and you'll notice that Red and Blue values 
for the color you clicked are now zero, but the Green value is the same as it was 
before the separation. 

• 	 Click Undo to reverse this change. 

MATCH PALETTE 

This option lets you match the current picture to the Palette of another picture. 
In effect, your current picture will use the colors from the other picture, but 
attempt to preserve the appearance of the current picture as closely as possible 
using the new colors. In HAM mode, the results can be surprisingly good. Let's 
see how it works: 

• 	 First, select Palette from the Color menu to bring up the palette, and look at 
the colors that appear there. 

You'll see that the register colors aremostlydull greensand browns with a single 
red register and a single blue register. 

• 	 Now, select Match from the Color menu. 

This brings up the Match Requester, which works just like the Load Requester, 
except that it loads only the Palette of the file you select. 

• 	 Click the volume PHOTLAB ART: to display the contents of the art disk. 
Click the directory HAMx400 to open it. Click the file Astronaut and click 
Match. 
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It will take a minute or two for Colors to remap the PhotoGirl picture to the 
Palette from Astronaut. As theoperationisunderway, theRegisterGraph shows 
you the progress ofthe operation. Notice that the picture looks almost exactly as 
it did before. Some of the detail at the edges of the lettering was lost, but it takes 
a good eye to notice this. Notice that the palette contains no medium blues, and 
yet the blue lettering ofPHOTOLAB is preserved. (Drag the picture up to see for 
yourself.) Colors was able to duplicate the medium blue pixels by using HAM 
colors instead of register colors from the Palette. 

• 	 Click Undo to reverse the Match operation. 

MAKEBIW 

The Make B/W command converts your picture to a Black & White image. 

• 	 Simply select Make B/W from the Color menu and watch as the picture is 
converted. 

When the operation is complete, the Palette will consist exclusively of grays. 
Click Undo to return to a color image. 

NEGATIVE 

The Negative option instantly converts your color picture to a negative image. 

• 	 Select Negative from the Color menu. 

Notice that the reddish areas of the picture change to cyan and the blue areas 
become orange. The resulting colors are the colors that appear on the opposite 
sideof the color wheel. The blue lettering would have become yellow if it were 
a true blue, but the blue that is used contains a large amount of green. 

• 	 Click Undo to return to the color image. 
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CHANGING DISPLAY MODES 

With Colors, you no longer have to worry about whether your pictures are in 
compatible display modes. In one simple step, Colors will convert a picture in 
any mode, to any other mode. You'll probably want to convert Low Resolution 
and High Resolution pictures to HAM mode, but, as an example, we'll convert 
the PhotoGirl picture to a Low Resolution Interlaced picture. 

• 	 Open the View Modes menu to see the options there. 

This menu contains only one option. Set To. Below the Set To option, the menu 
lists the Current Info for the picture you have loaded. Notice that our picture is 
in HAM Interlaced mode. 

• 	 Select Set To from the menu. 

This option presents a list of all the possible display modes. We want to covert 
to Low Resolution Interlaced. 

• 	 Select 32Ox400 from the submenu. 

You receive a warning that this operation may not be undoable. 

• 	 Click Okay to proceed. 

Next you are asked to select the color reduction sensitivity for the operation. 
There are three options. Essentially, Colors performs more precise calculations 
ifyou select High, but the trade off is that a Iarge picture may take a long time 
to convert. 

• 	 Right now, click Low so that the operation takes as little time as possible. 

You can come back later and choose one of the other options to see how much it 
improves the conversion. As the conversion proceeds, you'I1 see the messages 
Counting Pixels, Reducing Colors, and Redraw Pictures appear in the left side 
oftheColor Statistics Display, and theRegisterGraph will change to theProgress 
Display to show you how much of the process is completed. 

• 	 When you're picture is completely converted, open the View Modes menu 
to see the Current Info for the picture. 
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Keep in mind that this conversion only affects the picture in memory, it does not 
affect the disk file. Right now, we'll show you how to revert to the disk version 
of PhotoGir!' 

REVERT 

When you use Colors, you'll probably want to experiment with different Flag 
settings and Operations. To make it easier to experiment, Colors includes a 
Revert option. This option automatically loads themost recently saved or loaded 
file. Let's use it now to get the original PhotoGirl picture back. 

• Select Revert from the Project menu. 

A requester displays the nameofthe file you last saved or loaded and asks if you 
want to revert to the old version from disk. 

• Click Okay. 

In a second, you have the original picture back, without having to use the Load 
Requester. 

This chapter introduced some of the primary features of Colors and explained 
how the gadgets in the Command Screen work. This is probably enough to get 
you started, but it is byno means a complete introduction to Colors. For example, 
this chapter only briefly mentioned the Palette, but the next chapter will show 
you how it's used. You'll find information about other features in the Reference 
section. Here are some of the features we particularly recommend reading more 
about: 

Save options in the Project menu. (In particular, you may want to enlarge a 
picture to a size much larger than Colors can hold in.memory. To do this, you 
would use the Save Resized option.) 

Planes option in the Color menu. (This option lets you reduce the number of bit 
planes used by the picture, and Colors recalculates the picture to give you the 
best possible image with fewer colors.) 
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The Resize and Reduce operations. (These options let you changethe size ofthe 
picture or the number of colors the picture uses.) 

The BstfitITrunc, Sample/Smooth..and Resize/SizeOK flags. (Since these flags 
affect how the Operations and menu options are performed, you'll want to be 
familiar with which commands each Flag affects.) 
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This chapter takes you through step-by-step exercises that rover some of the major 
futures of Colors. You'll learn how to reduce the number of rolor registers used by II 
picture, how to change the display mcde ofthe picture, how to manipulatethePa1ette,llnd 
how to change the size of the picture. 

WHAT YOU'LL NEED 

To complete these tutorials, you'll need yourworking copies of the DeluxePho
toLab program disk and art disk. Ifyou want to save your work, you'll need an 
initialized disk with a fair amount of available space for saving large files. 
Finally,you'll need a little time ifyouwant tocomplete this chapter inonesitting. 
We estimate this tutorial takes twenty minutes to complete, because the opera
tions you11 perform give the Amiga a number-crunchlng workout. 

To begin these tutorials: 

• Start Colors and load PackageCover from the HAMx400 directory on the 
DeluxePhotoLab art disk. 

• Select Sort On: Population from the Color menu. 

Wehave you sorton population to place the least used color registers at the right 
end of the Register Graph and Palette. This way, we know exactly whlch colors 
are where, and the Reduce operation will clear the two registers with the lowest 
population count. 
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.. REDUCING THE NUMBER OF COLOR REGISTERS USED 


There are three ways you can reduce the number of color registers used by the 
picture: 

Use the Reduce operation on the Control Screen, which performs the color 
reduction in a completely automatic fashion. 

Strip away bit planes, which also automatically reduces the number of color 
registers. 

Meld registers in the Palette Window. 

W e'lliook at each one of these methods. And in the course of the tutorial, we'll 
also change the display mode of a picture. 

THE REDUCE OPERATION 

Before you do anything else, take a look at some of the RCB values for color 
registers in the graph. After you perform the color reduction, only the last two 
registers will retain the same values (but no pixels in the picture will use them). 
The other color registers will change RGB values as Colors tries to maintain the 
look of the picture. Here's how to reduce the colors automatically: 

• Click CLR so that no color registers are locked. 

• Set the number beside Reduce to 14. 

• Click Reduce. 


A message reminds you that this operation cannot be undone. 


• Click Okay. 
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A second message asks which level of color reduction sensitivity you want to 
use. 

• 	 Click Low. 

This operation will take a moment; we had you click Low because it takes the 
least time, though it generally doesn't produce the best results. The Progress 
Display flashes the messagesCount Pixels, Filter Colors, ReduceColors, Redraw 
Picture as it performs the reduction. 

• 	 When the Reduce operation is complete, click P so the Register Graph 
displays the population of each register. 

Notethat thegraph is no longersorted onPopulation. Also, ifyoucheckthecolor 
values oftheregisters, you'll find thatnoneofthe registers maintained theircolor 
values (except the last two which are no longer being used by the picture). This 
is because Colon tries to preserve the appearance of the picture with fewer 
registers, and todo so, it needed tochangethecolors in the registers that a:reused. 

• 	 Select Sort On: Population from the Color menu. 

Now the graph is once again sorted by population, and you can dearly see that 
no pixels are using the last two color registers. Note that although the color 
registers are not used in the picture, they still exist, so if you loaded the picture 
into Paint, you could set new colors in these color registers without affecting the 
rest of the picture. 

Another important point to remember is that, although the number of color 
registers used by the picture is now reduced, the number of colors in the picture 
is the same. This is because we are working with a Hold and Modify picture. In 
Hold and Modify display mode, Reduce converts the register colors to HAM 
colors when it empties a color register. If this were a Low Resolution picture, 
Reduce would only have register colors to work with, and the number of colors 
in the picture would be equal to the number of color registers being used. 
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SETTING ANEW DISPLAY MODE 

Changingthedisplay modeofPackageCover from HAM to Low Resolution will 
result in an increase in the number of color registers (from 16 in HAM to 32 in 
Low Resolution), but a decrease in the number of colors actually in the picture, 
(because HAM can use colors that do not come from color registers, but Low 
Resolution uses only colors from color registers.) 

• 	 Select Revert from the Project menu to get back the original PackageCover 
picture. 

• 	 Select Sort On Population from theColor menu to sort thecolor registers on 
population. 

• 	 Select Set To: 320x400 from the View Modes menu to convert the picture to 
Low Resolution Interlaced mode. 

A message appears to remind you that this operation cannot be undone. 

• 	 Click Okay. 

A second message asks which level of color reductions sensitivity you want to 
use. 

• 	 Click Low. 

The Progress Display flashes the messages Count Pixels, Ftlter Colors, Reduce 
Colors, Redraw Picture as it performs the display mode conversion. 

Now the picture has twice as many color registers, but it uses far fewer colors 
thanbefore. You11 usethe picturein the next section to seehow stripping planes 
from the picture affects the number of color registers available. 
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STRIPPING AWAY BIT PLANES 

The number of bit planes used by a picture determines the number of color 
registers available in the picture. (See Appendix B: Amiga Display Modes for 
more information about the relationship between bit planes and color registers.) 
Colors lets you remove or add bit planes. Right now we'll reduce the number of 
colors ina picture bystripping away a bitplane. In the case of ourLow Resolution 
Interlace picture, removing one bit plane will reduce the number of color 
registers from 32 to 16. 

• 	 Select Planes: 4 Planes from the Color menu. 

• 	 Answer Okay and Low to the messages that appear. 

In a moment, your picture is reduced to sixteen colors. Notice that reducing the 
number of bit planes both removes the colors from the picture and deletes the 
color registers from the Palette. The Reduce operation removed the colors from 
the picture but left the color registers in the Palette. 

PAlETIE MANIPULATIONS 

If you simply want to rearrange color registers, or if you want to make a very 
specific color reduction, the Palette Window is a good place to do it. Before you 
begin this series of Palette manipulations, do the following: 

• 	 Revert to the original picture from disk. 

• 	 Click P to display the Register Graph based on Population. 

• 	 Select Palette from the Color menu. 

• 	 Press F5 on the keyboard to hide the Command Screen. Now drag the 
Palette Window down to the lower half of the screen so you can see the 
upper area of the picture dearly. 

As you briefly saw in the Colors Guided Tour, the Palette Window presents 
another graph of the color registers. Each bar in the graph is drawn in the color 
of the register it represents. This helps you make decisions about which registers 
to manipulate. 
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Below the graph in the Palette Window, you see six operations that can be 
performed with the Palette. These are fairly easy to understand, but we'll run 
through them quickly anyway. If you are confident you already understand any 
of these operations, feel free to skip the explanation and move to the next. The 
Meld operations are most important to this exercise. They let you reduce the 
number of registers used, without making global changes to the color values as 
the Reduce operation does. 

SWAP COLORS 

This operation simply swaps the color values assigned to two registers. 

• 	 Click Color 1, the second register from the left in the Palette Window. Ot's 
color should be white at the moment.) 

When you click a register in the Palette Window, a small rectangle at the bottom 
of the register bar marks marks it as the currently selected register. 

• 	 Click Swap Colors. 

• 	 Click Color 15 , the last register in the Palette Window. 

When you swap colors in the Palette, the colors in the picture also change, 
because the pixels arepointing to the same registers as before, but those registers 
now contain different colors. In our case, the skylight in the ceiling above the 
world now has a yellow light rather than white, and the bright area behind the 
world is white instead of yellow. 

You can undo changes in the Palette as long as you don't perform any other 
operation before you click Undo. 

• 	 Press F4 on the keyboard to bring up the Command Screen. 

• 	 Click Undo. 

• 	 Press FS to hide the Command Screen again. 

Nowyourpictureand the colors in the palette are restored to their original order. 
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SWAP REGISTERS 

This operation changes the order of colors in the Palette without changing your 
picture. 

• 	 Click Color 1 (white). 

• 	 Click Swap Registers. 

• 	 Click Color 15 (yellow). 

Now Color 1 is yellow and color Color 15 is white. (You can't actually see the 
color of Color 1 because the rectangular marker is covering it. Click another 
register to move the marker.) 

The ability to swap color registers is important, because the Reduce operation 
always reduces by eliminating the color registers at the right end of the graph 
(the highest register numbers). This gives you some control over which color 
registers are eliminated in a reduction. 

• 	 Reverse this last change by clicking Undo in the Command Screen. (Press 
F4. Oick Undo in the Command Screen. Press F5.) 

COPY COLORS 

This operation copies the current color into the register you select. 

• 	 Click Color 1 (white) 

• 	 Click Copy Color. 

• Click Color 15 (yellow). 


Color 15 becomes white, so you have two white registers. 


• 	 Reverse this last change by clicking Undo in the Command Screen. 
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MELD BY AVERAGE 

This operation lets you change two colors to a third color that is the average of 
the first two. In the Palette for PackageCover, Color 0 is black and Color 1 is 
almost white. We'll meld these two together to make them the same color. 

• Click Color 0 

• Click Meld By Average. 

• Click Color l. 

The resulting color is gray. And both registers contain grey because you per
formed a meld. 

• Reverse this change by clicking Undo in the Command Screen. 

MELD BY WEIGHT 

Meld By Weight works exactly like Meld By Average. But instead of combining 
the colors in a simple Average, Colors uses the population (number of pixels) of 
each register to determine which should receive the most weight when mixing 
the two colors. 

• Click Color O. 

• Click Meld By Weight. 

• Click Color 1. 

This time the resulting color is black, because Color 0 (black) is used by many 
more pixels in the picture than Color 1 (white). 

MELD REGISTERS 

Meld Registers takes all of the pixels from one register and points them to a 
different register, so that no pixelsare using the first register. The register is now 
free to be used by any other color, without affecting the picture. 
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• 	 Click Color 1. 

• 	 Click Meld Registers. 

• 	 Click Color O. 

Now Color 1 is not used by any pixels in the picture. If you click another color 
register to move the rectangular marker, you'll see that Color 1 is crossed by 
diagonal slashes to indicate that it is not in use. 

Remember, if you ever need to free up a single color register without changing 
the colors assigned to the other registers, use Meld Registers in the Palette 
Window. 

IJ 	RESIZING THE PICTURE 

Colors is especially good at resizing pictures, and it's Save Resized option lets 
you create pictures that are larger than can fit in the computer's memory. Right 
now we just want to take a quick look at the Resize operation on the Command 
Screen and say a word or two about Save Resized. 

THE RESIZE OPERATION 

To resize a picture in the computer's memory, and continue to work on it 
afterward, use Resize. The Resize operation is affected by the Sample/Smooth 
flag. Ifthis flag is set to Sample, the resize operation is donewithout anti-aliasing, 
and resizing the picture larger results in some '1aggedness." When the flag is set 
to Smooth, Colors removes the "jaggedness" through anti-aliasing. In our 
example, we'll size the picture only slightly larger, since the image is in HAM 
Interlace mode and therefore takes up a great deal of memory already. 

• 	 Bring up the Command Screen and select Revert from the Project menu to 
restore the original picture. 

• 	 Set the Sample/Smooth flag to Smooth. 
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• 	 Set the first number to the right of Resize to 352. (point to the upper half of 
each digit and click to raise the number.) Set the second number to the right 
of Resize to 440. 

• 	 Click Resize. Then click Okay when the message reminds you that this 
process is not undoable. 

This operation is going to take a while, but ifyou ever need to enlarge a picture, 
you'll happily spend the extra time for the remarkably sharp result it produces. 
WhentheResize operation is complete, make the picture screen active, then click 
the picture with the right mouse button and drag it back and forth to prove to 
yourselfthat iUs in fact wider. We doubt that you can see anydegradation in the 
picture quality. 

SAVE RESIZED 

We won't haveyou perform this operation, but we thought we should mention 
that the Save Resized option works exactly like the Resize operation. The 
Sample/Smooth flag determines whetherornot the picture should be smoothed 
when sized larger, and you set the width and height dimensions using the 
numbers beside Resize on the Command Screen. 

Try it out if you like. Resize the picture to twice it's normal size and load it into 
Paint to prove that it is larger. One caution though, be sure there is enough room 
on your disk to hold the picture file. 

These tutorials showedyou two ofthe imporlllntfeatures ofColors. We couldn't tell you 
eve:rytmngthough.lfyou everneed info77l1lltionRbout an option, be sure tocheckthe next 
chP:pter, &ference. There you'll find a complete explanation ofall features. 
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This chapter summarizes all of the commands and functions in Colors. Because this 
chapter is intended for reference only and not Q$ a way to learn the fundamentals of 
Colors, the descriptions are Q$ concise Q$ possible. Ifyou read an entry in this chapter, 
but don't fully understand how the feature works, check the Index to see if the feature is 
explained with examples in one of the earlier chapters. 

The infonnation in this reference is organized into two major sections. The first 
halfofthe chapter explains thegadgets on the CommandScreen. The second half 
of the chapter describes the function of each of the menu options working 
through the menus from left to right and top to bottom. 

a THE PICTURE SCREEN 

When you load a picture in Colors, the picture is held ona separate screen behind 
the Command Screen. You won'tbe able to see all ofthe screen at one time. Ifyou 
want to see a part of the screen that isn't visible, you can scroll the screen using 
the arrow (cursor) keys. Holding down Shift with the arrow keys moves the 
screen in larger jumps. You also can point to the picture, click the left mouse 
button to make the picture screen active, hold down the right mouse button (the 
pointer changes to a four arrowcursor),and drag the picture in anydirection you 
like. Once you have reached an edge ofthe picture, you can not drag any further. 

II THE COMMAND SCREEN 

When you first start Colors you see theCommand Screen. This screen has several 
parts with different functions, asyou can see in Figure 10.1. The following pages 
describe the functions of each part of the Command Screen. 

There is one important thing you should understand about working with the 
Command Screenand a Picture Screen. The first time youclickon a screen, it will 
have no effect. The first click only makes the screen active. Then you can work 
with that screen. In the case of the Command Screen, you can then use one of the 
functions. In thecase ofthe Picture screen, you can then move the picture around 
with the right mouse button as explained above. To be on the safe side, it is 
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advisable always to click on the Color Statistics Display when you want to make 
the Command Screen active. Since the Color Statistics Display doesn't perform 
any function other than to display information, you can click there without any 
fear of changing your picture inadvertently. 

Color Stalisti:s Display 

Flags (outlined) 

Figure 10.1 The Colors Conunand Screen 

TITLE BAR 

The Title Bar at the top of the Colors Command Screen shows the name of the 
program on the left side and the name of the active screen on the right side. The 
screensarecalled "Command" for theCommandScreen, "Picture" for thescreen 
of the picture you are working on, and "Palette" for the palette window. If none 
of these screens is active, then the active screen is listed as "Unknown." 

IftheCommand and Picture screens become separated from each other, and one 
of the screens is the active screen, you can bring them both to the front together 
by pressing F4. 

The Front Gadget and Back Gadget on the right side of the title bar work as they 
do on normal Amiga screens. 
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MENU BAR 

When the Command Screen is active and you press the right mouse button, the 
MenuBardisplays the menu names. Then pointing to the menu name opens that 
menu. 

COLOR STATISTICS DISPLAY 

The area below the menu bar displays infonnation about color values. The 
information given is for the currently selected color in the Register Graph, the 
Palette, or the Picture. (See Palette in the Color menu for infonnation about the 
Palette.) To get color information about any color in the picture, click that pixel 
with the left mouse button. 

The rectangle on the far left of the Color Statistics Display shows the register 
number currently selected and the color that occupies that register. If the pixel 
is a HAM pixel selected from the picture, the letter and number displayed 
indicates which component of the preceding pixel (the pixel to the left) was 
modified and to what value. For example, R15 means that the current pixel is the 
preceding pixel with the Red component changed to a value of 15. Hyou are 
using Extra-Halfbrite and the pixel is an Extra-Halfbrite pixel, this is indicated 
by an E before the register number. For example, E24 indicates the Extra
Halfbrite equivalent ofcolor register 24. 

The long rectangle in the Color Statistics Display shows numeric values for the 
red (R),green (G),blue (B), hue (H),saturation (S),value (V),yellow (Y),cyan (C), 
and magenta (M) content of the currently selected color register. This area also 
lists the number of pixels mapped to that color register, referred to as the 
Population (P) of the color, and the percentage (%) of the total picture that the 
population number represents. Values for population arenot displayed until the 
P button has been clicked. 

The levels of red, green, blue, yellow, cyan, magenta, saturation and value are 
assigned values between 0 and 15, with 0 representing minimum contribution 
and 15 representing maximum contribution. 
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Hue is measured in degrees from 0 to 360, where 0 degrees represents pure red. 
As the hue is increased, the color gradually advances along the color spectrum 
through yellow, green, cyan. blue, magenta and finally back to pure red. 

(For a discussion of RGB color theory, see Appendix A.) 

PROGRESS DISPLAY 

The Progress Display appears whenever you select a function that takes a while 
to complete. At these times the cursor changes to the cloud shape and no input 
is accepted. The rectangular area on the left side of the Color Statistics Display 
changes to a message explaining what function is in progress. Sometimes the 
Register Graph also changes to graphically represent how much of the current 
function has been completed; this display gradually fills from left to right until 
the function if completed. 

Note: operations that cause the Progress Display to appear can be terminated by 
pressing the spacebar. After you terminate one ofthese operations, you can clean 
up the display by clicking Undo or selecting Revert from the Project menu. 

A, G, B, H, S, V, PBUnONS (Keyboard Equivalents: R, G, 8, H, S, V, P) 

These buttons are used to select the register attribute displayed in the Register 
Graph. The buttons correspond to the red (R), green (G), blue (B), hue (H), 
saturation (5), value (V), and population (P) values of the registers. 

To change the attribute displayed, click one of the buttons. The Register Graph 
changes to display the relative content of the attribute you selected, and the area 
below the Register Graph lists the selected attribute. For example, ifyou click R, 
the Register Graph displays the relative red content ineach of the color registers, 
and the area below the graph contains the text "Red." 

If you click P to display the population, the relative number of pixels that use 
each registeris displayed in the Register Graph. In HAM and Extra-HalfBritenot 
all pixels are counted; therefore the percentages shown won't add up to 100%. 
The first time you select P there will bea shortdelaywhile the population for each 
re~ster is calculated. 
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Note: Holdingdown the Shiftkeyand dickingononeoftheRGBHSVP Buttons 
displays the Palette Window, which contains a graph with each of the bars 
drawn in the register's corresponding color. 

REGISTER GRAPH 

TheRegister Graph shows the relative content of theattribute selected using the 
RGBHSVP Buttons. Thefirst baron the left side ofthe graphcorresponds tocolor 
register 0, the second bar corresponds to register 1, etc. 

The Register Graph is also used to lock and unlock the registers. If a register is 
locked, it is not affected by changes made to RGB or HSV values. Oick a bar (or 
anywhere in theareaabovethe bar) to lock orunlock thecorresponding register. 
When a register is locked, its bar is red. 

Below the Register Graph are two buttons for locking or unlocking all of the 
registers. 

SET: locks all of the registers. (Keyboard Equivalent: L) 

CLR: unlocks all of the registers. (Keyboard Equivalent: N) 

Pointing toa barand holdingdown the left mousebutton causes thepixels in the 
picture that correspond to that color register to flash. 

Holding down the Shift key and clicking on one of the RGBHSVP Buttons 
displays the Palette Window, which contains a graph with each ofthecolorbars 
drawn in the register's corresponding color. 

ARROW BUTTONS 

Used to increment or decrement the currently selected color attribute (selected 
using the RGBHSVP Buttons) inall unlocked color registers. (Note: HAM colors 
cannotbe locked because their color is not taken from color registers. Locking a 
color in Extra-HalfBrite also locks its Extra-HalfBrite component.) 
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The amount of change in a register attribute is proportional to the initial values 
in the current picture. In other words, the registers with larger initial values will 
increment or decrement in larger steps to maintain the relative balance of all the 
register values. 

Ifyou increment or decrement the R, G, or B component in a HAM picture, all 
unlocked colors (including all HAM colors) are affected. However, the change 
is only temporary. Once you select some function other than R, G, B or Undo, the 
change becomes permanent. You will notice that a message "Commit Changes" 
appears at the left side ofthe Color Statistics Display as soon as you click another 
function. (Note that the temporary nature of the changes does not mean that 
clicking Undo reverses all ofthe changesyou've made using the Arrow Buttons; 
Undo only reverses the last change.) 

The changes are madeonly temporarily at first so that each click ofthe Up-Arrow 
has an equal and opposite effect to clicking the Down-Arrow. Ifyou click the Up
Arrow, Commit the changes, and then click the Down-Arrow, clicking the 
Down-Arrow may not exactly reverse your earlier click of the Up-Arrow. This 
is because information about the original relationship between color values 
(particularly of HAM pixels) no longer exists; you are changing the new image, 
where the relationship between color values may be different. 

If you increment or decrement the H, 5, or V attribute in a HAM picture, the 
change affects only pixels that get their color directly from the color registers. 
HAM pixels retain their original color. 

OPERATIONS 

There are four operations available directly from the Command Screen. 

MOSAIC (Keyboard Equivalent: M) 

Reduces the resolution of the current picture by replacing the colors in the 
selected region size with a single color. 

The numbers to the right of the Mosaic button determine the size of each region 
that is converted to a single color. The first number determines the width of the 
region in pixels, and the second number determines the height of the region in 
pixels. The maximum setting for each dimension is 50. 
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To increase the size of the mosaic regions, place the pointer on the top half of a 
number and click the left mouse button. The number increases by one for each 
click.Ifyou hold down themouse button, thenumbercontinues to increaseuntil 
you release the button. To decrease the number setting, place the pointer on the 
bottom half of the number and click or hold down the mouse button. 

This operation is affected by the the Smooth/Sample flag. IfSmooth is active, 
Mosaic will average the pixels in a region to determine the new color fur that 
region. If Sample is active, the new color fur each region is the color that occurs 
in it's top left pixel. 

RESIZE (l(eyboard Equivalent: Z) 

Resizes the current picture to the dimensions in the number gadgets to the right 
of the Resize gadget. The first number sets the new width of the picture and the 
second number sets the new height. When you first open Colors, the resize 
dimensions are set to lxl. The maximum setting is9999 x 9999, though theactual 
maximum is determined by the amount of computer memory available. Ifyou 
set the dimensions fur a size larger than canbe created, a requester tells you that 
Colors could not get enough memory fur the function. 

To change the dimensions settings, place the pointer on the top half ofa number 
and clickthe leftmousebutton. Thenumberincreasesbyone for each click. Ifyou 
hold downthemouse button, thenumbercontinues to increase until you release 
the button. To decrease the number setting, place the pointer on the bottom half 
of the number and click or hold down the mouse button. 

In Test mode, Resize only affects the screen image, and any attempt to move the 
screen returns the picture to its "real" state in memory. 

This operation is affected by the setting in the Sample/Smooth flag. 

REDUCE (l(eyboard Equivalent: C) 

Used to reduce the number of color registers used in the current picture. The 
number to the right of the Reduce button shows the number of color registers 
available in the current display mode. You can change this number to a number 
less than the current number of registers used, but you cannot set it to a higher 
number. 
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To change thecolor register number, place the pointeronthetophalf of a number 
and clicktheleft mousebutton.Thenumber increasesbyone for each click. If you 
hold down themousebutton, the numbercontinues to increase until you release 
the button. To decrease the number setting.. place the pointer on the bottom half 
of the number and click or hold down the mouse button. 

When you click Reduce, a message asks you what level ofcolor reduction sensi
tivityyou want to use. The choices are High, Medium, and Low. High generally 
produces the best result, but the results depend on many factors, and occasion
ally a picture looks better whenconverted using MediumorLowcolor reduction 
sensitivity. 

Notethatyouwon'tbeable tosee thatcolor registers haveazero population until 
you perform a population countbyclickingtheP button orbysorting thepalette 
on population. 

UNDO (Keyboard Equivalent: U) 

Reverses the last operation if that operation is undoable. 

FLAGS 

BSTFIT I TRUNCf (Keyboard Equivalent: F) 

Changes in display mode made by selecting from the Set To: submenu, and 
changes in the number of Planes are affected by this flag. 

When Bestfit is active, changes in the number of color registers also remap the 
picture to maintain the '1ook" of it's color content. If Truncate is active, the 
picture is not remapped to preserve it's '1ook". 

SAMPLE I SMOOTH (Keyboard EquiValent: 0) 

This flag affects the Mosaic and Resize operations (including display mode 
changes). When Sample is active, changes in the size of the picture simply 
expand or reduce the original without attempting to preserve the look of the 
content. When Smooth is active, the contentsofthe picture are considered in the 
resizing operation and the edges between pixels are "smoothed" (in a process 
known as anti-aliasing) so that the resized picture more closely resembles the 
original. 
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RESIZE I SIZE OK (Keyboard Equivalent: K) 

This flag affects dispJay mode changes madeusing theSetTo: option in theView 
Modes menu. When Re-size is active, changes in mode also resize the picture to 

scale when necessary to preserve the proportions of the image. If Size OK is 
active, the picture is not scaled when the mode is changed and the resulting 
picture may be out of proportion. 

SRT HiLo I SORT toHi (Keyboard Equivalent: 1) 

This flag affects sorting of the Register Graph and Palettedone with the Sort On: 
option in the Color menu. IfSrt HiLo is active, sorts will place the registers with 
the highest values to the left. If Srt LoHi is active, sorts will place the registers 
with the lowest values to the left. 

REAL I TEST (Keyboard Equivalent: T) 

This flag affects Resize, Mosaic, HAM color changes from the Color menu, and 
some Match operations. When Real is active, all operations affect the actual 
picture data. When Test is active, only the screen image is affected by changes 
you make with the commands listed above; the picture data in memory remains 
unChanged. You can only perform one operation on the screen in Testi subse
quent operations automatically return the picture to its "real" state before 
performing the new operation. Some operations that are not undoable in Real 
mode, become undoable in Test mode. 

Colors's menu items remain hidden until you move the cursor to the top of the 
screen and press the right mouse button. As you move the cursor horizontally 
across the Menu Bar, one after another of the menus drops down to reveal its 
selection of options. MOving the cursor down the selection ofoptions highlights 
each one. Releasing the mouse button whena menu option is highlighted selects 
that option. Some options reveal secondary menus to their right. To select a 
secondary menu item, move the cursor to the right (while continuing to hold the 
button down) to highlight the secondary menu item, and then release the button. 
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In many cases, you can select a menu item by using its keyboard equivalent. 
Keyboard equivalents, where available, are shown next to the corresponding 
item in the menus and in the descriptions that follow. You will find a table of 
keyboard equivalents at the back of this manual as Appendix D. 

The menus, reading from left to right across the Menu Bar, are as follows: 

PROJECT MENU 

PrOJect 

Load. 

Say. 

Say. Fast I!'!JS 

R.y.:rt I!'!JR 

.,J'Wo:rkB.noh 19W 

About 

Quit 19Q 


Figure 10.2 The Project Menu 

LOAD 

Brings up the Load File requester. See Figure 10.3. The requester contains Load 
and Cancel buttons, a field to display the current directory path, a file list 
window with arrowsand a slider for scrolling the window, and an edit field that 
displays the currently selected file. 

To load a picture, click the name of the file you want to open and then click the 
Load button at the top of the requester. 
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Load. 
PHOTOLAB: 

Figure 10.3 The Load Requester 

In addition to files, the window displays Directories, Volumes, and Oipboards. 
Ifyou dick a subdirectory name, the window displays all of the files contained 
in that subdirectory. Oicking the listing I (parent) moves you into the parent 
directory of the current subdirectory. If you click a Volume name, the contents 
of that volume are displayed. Also, if you place a different disk in a drive while 
the Load File requester is displayed, the Volume list is updated to showthe new 
disk. Ifthat drivewas thecurrent drive, the window displays the files in the new 
disk. 

SHORTCUTS 

Several shortcuts are available in the Load File Requester. 


Double clicking on a file name is the same as clicking the file name and clicking 
Load. 

Clickingon a section title in the displaywindow such as "-Files-" will skip the 
window display down to the next section. 

Keyboard shortcuts: 

Key Function 

ESC Cancel 
UpArrow Move display up one line 
Down Arrow Move display down one line 
Shift-Up Arrow Move display up one section 
Shift-Down Arrow Move display down one section 
Return Same as clicking on Load 
D Shows the directories 
F Shows the files 
V Shows the volumes 
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SAVE 

This option presents a submenu for selecting the type of save you want to 
perform. The two save options are: 

NORMALLY: Brings up a requester for you to save a picture to disk. This 
requester functions the same as the Load File Requester described under 
Load in the Picture menu,exceptthat clicldngSave saves the picture todisk. 

RESIZED: Brings up a requester for you to resize the picture as it is saved 
to disk. This requester functions the same as the other save file requesters, 
except that clicking the Resize button resizes and saves the picture to disk. 
The dimensions for the resized picture are determined by the width and 
height number settings beside the Resize gadget on the Command Screen. 
These gadgets are explained in detail underResize in the Operations section 
above. 

SAVE FAST (Keyboard Equivalent: Right Amiga-S) 

Savesyourwork todiskunder the current filename. A requester appears foryou 
to confirm yourselection.Ifyou want to saveyour file, click Okay. Ifyouselected 
Save Fast by mistake or do not wish to save the current file, click No. 

REVERT (Keyboard Equivalent: Right Amiga-R) 

Reverts to the most recently saved version of the picture currently displayed. A 
requester appears for you to confirm your selection. Hyou want to revert, click 
Okay. Hyou selected Revert by mistake, click No. 

Note: Once you have clicked Okay to confirm the Revert option, you cannot 
restore the picture you reverted from (the most recently displayed picture). 

WORKBENCH (Keyboard Equivalent: Right Amiga-W) 

Closes theWorkbench. This option is useful to free upsome extra RAM (chip and 
fast). If the Workbench is open, a check mark appears beside Workbench, and 
selecting the option closes the Workbench. 
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ABOUT 

Brings up a requester that gives the name ofthe program, copyright information, 

and the developers' names. 


QUIT (Keyboard Equivalent: Right Amiga-Q) 


Exits Colon. 


COLOR MENU 

Sepaz-ate:

Planes: 

$01'" t On: 

Match 10M 

MaJceB.I'W lOB 
Negative ION 
Pa.lette lOP 

Figure 10.4 The Color Menu 

SEPARATE: 

Presents a submenu of colors. Selecting one of the colors in the submenu 
performs a color separation on the current picture. For example, selecting Red, 
produces a red-only separation. The Red, Green, and Blue separations can be 
used to create transparencies that produce a full-color image when used to
gether. With a single-color printer, and the appropriate color ribbons (yellow, 
cyan,and magenta>, you can create a color printout byprinting the Yellow, Cyan, 
Magenta, and Black separations on top of each other. 
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The colors in the Separate submenu are: 

Color Keyboard Equivalent 


RED Right Amiga-D 

GREEN Right Amiga-E 

BLUE Right Amiga..lJ 

YELLOW Right Amiga-Y 

CYAN Right Amiga-C 

MAGENTA Right Amiga-G 

BLACK Right Amiga-K 


PLANES: 

Sets the number ofbit planes used to draw the picture. The numberofbit planes 
determines the maximum numberof colors available from the palette. Not all bit 
plane settings are available in all modes. If a selected plane setting is not 
available, the option appears in dimmed type, and you are not able to select it. 
(See Appendix B: Amiga Display Modes for an explanation of how the number 
of bit planes relates to the number of colors available in a display mode.) 

1 PLANE: Sets a single plane image with a maximum of 2colors. 

2 PLANES: Sets a 2 plane image with a maximum of 4 colors. 

3 PLANES: Sets a 3 plane image with a maximum of8 colors. 

4 PLANES: Sets a 4 plane image with a maximum of 16 colors. 

5 PLANES: Sets a 5 plane image with a maximum of 32 colors, or HAM 
mode. 

6 PLANES: Used to change from 5 to 6 bit HAM mode. 
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SORT ON: 

Presents a submenuofcolor register attributes. Selecting one oftheoptions in the 
submenu performs a sort of the color registers (in the Palette and the Register 
Graph) based on the attribute you selected. The color registers are sorted 
according to the value of the attribute. The direction of the sort depends on the 
setting of the Srt HiLo I Srt LoHi flag. The options in the submenu are: 

Color Keyboard Equivalent 

RED Right Amiga-l 
GREEN Right Amiga-2 
BLUE Right Amiga-3 
HUE Right Amiga-4 
SATURATION Right Amiga-5 
VALUE Right Amiga-6 
POPULATION Right Amiga-7 
LOCKS Right Amiga~ 

The Locks option is a special case. It allows you to sort all of the locked registers 
to one end of the graph. It does not rearrange the locked registers according to 
any other attribute. 

MATCH (Keyboard Equivalent: Right Amiga-M) 

Remaps the colors of the current picture to use the palette of a second picture 
(called the match picture) chosen in the file requester. 

Select Match from the Color menu. A file requester appears for you to select the 
picture you wish to match to. This requester functions the same as the Load 
Picture requester explained above. When the Match button in the requester is 
clicked, the current picture is remapped. 

When a picture is remapped, the colors of the current picture are re-arranged to 
maintain its original appearance as closely as possible using the match pictures 
palette. 
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Ifthe palette of thematch picture is larger than the current picture, you are asked 
ifyou wantto use thepartial palette.IfyoudickOkay in the requester, thematch 
is performed using as much of the match picture's palette as the current picture 
can accommodate. If you select No, the match operation is not performed and 
you are returned to the Command Screen, where you can add bit planes before 
trying the Match operationagain. Note that anycolor registers that are locked in 
thecurrentpicture will be maintained and the remaining registers will usecolors 
from the match picture. 

MAKE BIW (Keyboard Equivalent: Right Amiga-B) 

Converts the currentpicturetograyscale values. This feature isespecially useful 
if you want to see how the picture will appear when printed in gray scale mode. 

NEGA11VE (Keyboard Equivalent: Right Amiga-N) 

Converts the current picture to a negative image. 

P ALETI'E (Keyboard Equivalent: Right Amiga-P) 

Brings up the Palette window where you see a graph of the color registers with 
each bardrawn in thecolorthat register contains. Color registers that havea zero 
population may be rendered in a hashed pattern. This only happens if the 
population has been determined for the first time after a remapping or size 
change function. Otherwise all color registers are rendered in solid shades. A 
rectangular marker in the bottom of a palette register indicates that the register 
is currently selected. 

Figure 10.5 The PaleHe Window 
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The lower area of the window lists the commands for manipulating palette 
colors and registers. To useanyofthepalette commands, click a register with the 
left mouse button to make it the current register, click the command you want 
(the cursorchanges to an arrow with "To" under it), then click a second register. 
To cancel an operation when the "To" cursor is displayed, click the current 
register again. 

SWAP COLORS: Swaps the contents of two color registers. 

SWAP REGS: Swaps the registers currently used by two colors. 

MELD BY A VERAGE: Changes the color of two registers to the color that is the 
average of the two original colors. For example, ifColor 1 has the values R: 3, G: 
6, B: 7 and Color 2 has the values R: 10, G: 8, B: 6, a Meld By Average operation 
changes both registers to the color with values R: 6, G: 7, B: 6. Note that in this 
operation, if the average falls between two numbers, the lower number is used. 
In our example the average of 3 and 10 would be 65, so 6 was used for the red 
value. 

MELD BY WEIGHT: Changes the color of two registers to the color that is the 
weighted average of the two original colors. The operation uses the population 
countofthe two registerstodeterminethe weight each should receive increating 
the new color. Hregister A contains 75% more pixels than Register B, and you are 
melding by weight, the resulting color will have 75% more of color A than of 
color B. Note that this option is not available if you have not performed a 
population count. 

MELD REGISTERS: Remaps all pixels that point to the first register you select 
so that they point to the second register. After this function, the first register will 
bedrawnwithhash marks toshowtheregisterhasa populationofzero(no pixels 
are using it). 

Notethat this option is notavailable until you clickthePbutton orselect Sort On: 
Population to perform a population count. 

COPY COLOR: Copies thecolorofthecurrent register to the registeryou select. 
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VIEW MODES MENU 


Set To: 

C.......t; X.C.: 

Mode-- HAHK288 

Depth- " Plan•• 

Width- 328 
Height 288 

Figure 10.6 The View Modes Menu 

SET TO: 

This option presents a submenu ofdisplay modes that you can select to change 
the display mode used by the current picture. The modes available in the 
submenu are: 

320 x 200 
320 x400 
640 x 200 
640 x 400 
HAM x 200 
HAM x 400 
EHB x 200 
EHBx400 

Low resolution 
Low resolution with interlace 
High resolution 
High resolution with interlace 
Hold and Modify 
Hold and Modify with interlace 
Extra-HalfBrite 
Extra-HalfBrite with interlace 

Three of the flags in the Colors Command Screen (Best Fit, Resize, and Smooth) 
affect how Colors changes the display mode: 

If the Best Fit flag is set, any reduction in the number of colors will cause a 
restructuring of the original. This is done in an effort to preserve as much or its 
appearanceas possible. Note: ham pictures that have manycolors (2000 or more) 
can take as long as 24 minutes to convert with Best Fit set. 

If the Resize flag is set, the picture will be expanded or shrunk (with or without 
smoothing,depending onwhether the Smoothing flag isset) to fit thenew mode. 

184 




CURRENT INFO: 

Displays information about your current picture. 


MODE displays the mode your current picture is in. For example, HAM x 400. 


DEPTH displays the number of bit planes your current picture is using. 


WIDTH displays the width of the picture in pixels. 


HEIGHT displays the height of the picture in pixels. 
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In DeluxePhotoLllb, there (lI'e two ways to describe, and mix, colors. One method 
describes colors as acombination ofthree primary colors: Red, Green, and Blue. We refer 
to this as RGB color mixing. The other method. descn'bes colors as made up of the three 
properties ofHue, Saturation,and Value. Wereferto thisas HSVcoior mixing. It is most 
important that you understand RGB color mixing, since this is the method. DeluxePho
toLilb uses when it calculates color values, but HSV color mixing has some lIIi'Otlntages 
ofits own, and an understanding of its reliltionship to RGB is useful. 

RGB COLOR MIXING 

The Amiga computer uses RGB color mixing based on sixteen levels of each of 
the color components from °to 15. This yields a universe of 4.096 colors (16 x 16 
x 16 == 4,096). The universe of possible colors is best imagined as a cube in which 
each dimension is measured in one ofthethree prtmarycolors. Figure A.1 shows 
a sketch of the RGB color cube. 

Black 
(0,0,0) u.r--t--~J 

(15,15,15) 
Whl.

(15,0,0) 0;.----......... 

Red 

Figure A.1 The RGB Color Cube 

Notice that black is the absence of color (RO, GO, 00) and white is the maximum 
level ofthe three colors (RIS, GIS, BI5). The line running diagonallythrough the 
centerofthe cube from black to white shows the poSitionsofthegrays, which are 
formed by combining equal amounts of red, green, and blue. Thus R7, G7, B7 
would yield a medium gray. 
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The comers of the cube that are not labeled are the three secondary colors: cyan, 
yellow, and magenta. Ifyou move backwards along the edge of the cube to add 
Blue to Green, you would eventually reach cyan (RO, GIS, BI5). Likewise, 
moving down from Green to add Red produces yellow (R15, GIS, 80), and 
moving backwards from Red to add mue produces magenta (R15, GO, BI5). 

Each secondary color is also the complement of the primary color not contained 
in it. So cyan (RO, GIS, B15) is the complement of Red. Notice that in the color 
cube, cyan and Red are at opposite comers. In a moment, you'll see that this 
arrangement parallels the position of colors on the color wheel in HSV color 
mixing. Also noticethatifyouadd a primary color and its complement, the result 
is always white: 15,0, 0 added to0, 15, 15 yields 15, 15,15. In fact, adding any two 
colors always moves the result closer to white. 

HSV COLOR MIXING 

The HSV method of color mixing breaks each color down into its Hue, Satura
tion, and Value. 

Hue simply refers to the color's position on the color spectrum or rainbow
Red, Yellow, Green, Cyan, Blue, or Magenta, and the various shades in between. 
(Note that this spectrum is based on the mixing of colored light and not on that 
of reflected light or pigment. The spectrum based on the mixing of pigment is 
based on the primary colors of Red, Yellow, and Blue and it's order is Red, 
Orange, YeUow, Green, Blue, Violet.) 

The spectrum ofhues is normally arranged as a circle or "color wheel" as shown 
in Figure A. Thus, Hue is measured in degrees. Red is at the top of the circle by 
convention. Ifyou are trying to select a color using HSV, it helps a great deal to 
be familiar with the color's position on the color wheel. Notice that, as we 
mentioned in the discussion of RGB, each color's complement is located at the 
opposite end of the circle. 
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270 90 

180 

Figure A.:J. Additive Color Wheel 

Saturation refers to the strength of a particular hue-whether it is relatively pure 
(and hence highly saturated), or whether it contains some proportion of white. 
Thus, the more white, the less saturated. 

Value refers to a color's relative lightness or darkness (sometimes referred to as 
Luminosity). A color with a high value would have little or no black, whereas 
colors with low value would contain more black. Irrespective of Hue and 
Saturation, a Value of zero produces a pure black. 

Even at their highest saturation, hues are not all of the same value. For example, 
fully saturated green has a higher value than fully saturated red. You will notice 
this difference in value in particular if you use B&W mode in Paint to convert a 
color picture to black and white only. 

Another important concept you should remember is that Value cannot change 
independent of Saturation. As a color moves closer to white or black, its 
Saturation also changes. On the other hand, Saturation can change without any 
change to Value; the color simply moves toward its level of gray. 
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COMPARING RGB AND HSV 

When you work with DeluxePhotoLab, you will usually want to work in RGB, 
particularly since the RGB color values are used to calculate changes in color. 
However, sometimes it is easier to find the color you want to paint with by 
locating its Hue and then adjusting the Saturation and Value. Producing grays 
is one instance where it is easier to mix the color in HSV. Since a hue with no 
saturation is a graylevel bydefinition, to produce anygray, movethe Saturation 
sliderto0and adjusttheValue slider until you have the grayleve1 you want. This 
is much easier than setting each of the R, G, and B sliders to the same value, and 
then adjusting all three of them until you find the right gray level. 

To give you a point of reference, the table below shows the name of a color and 
its respective RGB and HSV values. 

Color RGB HSV 
Black 0 0 0 any any 0 
Medium Gray 7 7 7 any 0 7 
White 15 15 15 any 0 15 

Red 15 0 0 0 15 15 
Yellow 15 15 0 60 15 15 
Green 0 15 0 120 15 15 
Cyan 0 15 15 180 15 15 
Blue 0 0 15 240 15 15 
Magenta 15 0 15 300 15 15 

Notice that when you work in HSV, all pure colors have Saturation and Value of 
15.This makes is mucheasier tofind a basic color if youare not familiar with how 
Red, Green, and Blue mix to form it. 
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DeluxePhotoLab supportsall ofthe Amigagmphicdisplgy modes-low resolution, high 
resolution, extra-halfbrite, and Jwld and modify. (Dual plgyfield mode is not directly 
supported, since it is retIllya variation ofthe low and high resolution modes.) You don't 
need to know muchabout thedifferent displgy modes to creategreat art with De1uxePho
toLab. But some understanding of how the display modes work, and in particular, how 
they affect the number of colors available in the palette, am help you work more 
effectively. 

This Appendix explains how apixel derives its color, and how the display mode and the 
number ofbit planes determines the numberofcolors avaUable in the palette. We've tried 
to avoid overly-technical explanations, but the material is stUI very technical. Ifyou don't 
understand e:verythingyou read here, don't bediscouraged, just rememberthat you don't 
really need to know this. 

WHAT IS ABIT PLANE? 

A bit plane can be thought of as a flat grid ofdots - a plane of dots, where each 
dot represents a bit. So when we say "bit", think dot. 

If you look ahead to Figure B.l, you'll see that we draw the bit planes as flat 
surfaces. The best way to think of this surface is as a flat grid behind your 
computer screen. (This isn't actually how it works, but it may help you visualize 
how the colors are assigned to pixels.) The grid is the same dimensions as your 
screen resolution, For example, if your screen is 320 pixels wide and 200 pixels 
high, each bit plane is also 320 x 200 bits. 

BIT PLANES AND AVAILABLE COLORS 

Now imagine that each dot is either filled inor it's not. If the dot is filled in, it has 
a value of 1and is said to be "on", Ifit is not filled in, the dot has a value of 0 and 
is said to be "off", In the simplest case ofa display mode with only one bit plane, 
the picture can have only two colors. A pixel is one color if its corresponding bit 
is on or a different color if the bit is off. 
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The bit planes themselves don't determine the color of the pixel, they simply 
determine which color register the pixel looks to for its color. With a single bit 
plane, the pixel points to either Color 0 or Color 1. Ifyou add another bit plane 
behind the first, the number of possible color registers doubles to four. Each 
additional bit plane doubles the number of colors again. The color register 
contains the numbers for the amount of red, green, and blue in the color. 

LOW RESOLUTION AND HIGH RESOLUTION DISPLAY MODES 

Figure B.1 illustrates how the bit planes determine which color register a pixel 
points to in Low Resolution display with five bit planes. Take a look at this figure 
for a moment. Notice that we've numbered the bit planes 0 through 4. Notice also 
that the number of each bit plane corresponds to the power oftwo by which each 
bit plane value is multiplied. For example, the dot in bit plane 3 has a value of 1, 
and because it is in bit plane 3, the 1 is multiplied by 2,3, which equals 8 (2 x 2 x 
2). The numbers from the five bits are then added together to obtain the number 
of the color register the pixel points to. 
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Figure B.l Low Resolution Pixel Color Selection 

Low and High Resolutions work exactly alike, except that High resolution does 
not support as many bit planes, and therefore provides fewer colors. Figure B.2 
lists the graphics modes and the number of bit planes and colors each supports. 
Notice that Hold And Modify mode is a departure from the notion that each 
additional bit plane doubles the number of colors available. Hold and Modify is 
a special case that we'll explain in a moment. 
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Figure B.2 Number of Colon in Each Display Mode 

EXTRA-HALFBRITE DISPLAY MODE 

Extra-Halfbrite uses a trick to increase the number of colors available on the 
screen. The Amiga supports only 32 color registers directly, but Extra-Halfbrite 
uses a sixth bit plane to indicate an additional 32 registers that don't really exist. 
The first 32 registers are standard color registers; the second 32 are halfbrite 
equivalents. Pixels that use halfbrite colors point to one of the standard color 
registers and indicate that the color should be displayed at half its normal 
intensity. This means that the second 32 pixels are not independant of the first 
32; you can change the color values only in the first 32 registers, and the change 
is automatically reflected in the halfbrite equivalent. Figure 8.3 shows how 
Extra-Halfbrite uses the bit planes and color registers. 

Note: Not all Amiga 1000 computers support Extra-Halfbrite. The easiest way to 
find out whether or not your computer supports this display mode is to try it. 
Open an Extra-Halfbrite screen and look at the Palette (make sure the pOinter is 
not in the Menu Bar or Toolbox). If the last 32 colors are the same as the first 32, 
your computer doesn't support Extra-Halfbrite. 
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Figure B.3 Amiga Extra-Halfbrite Pixel Color Selection 
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HOLD AND MODIFY DISPLAY MODE 

Hold and Modify display mode uses only 16 color registers, but manages to 
display all 4,096 colors on the screen at the same time. To accomplish this, HAM 
display mode uses the first four bit planes to address the 16 color registers, and 
uses the fifth and sixth bit plane to determine whether the register color or a 
HAM color should be used. 

A HAM color is formed by taking the RGB value of the preceding pixel on the 
screen, and substituting a new value for one of the RGB components. The new 
value is the number derived from the first four bit planes. Here's a qUick 
example: 

Assume the color values of one pixel (a register color) are R3, G15, Bll. The 
following pixel (a HAM color) would have the color values R13, G15, Bll, ifbit 
planes 0 through 3 pointed to register 13and bit planes 4 and 5 indicated that the 
register value should be used to modify the red component of the preceding 
color. (Figure B.4 shows how the six bit planes are used to select a color in Hold 
and Modify mode.) 
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Figure B.4 Hold and Modify Pixel Color Selection 
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Because HAM colors are based on color values of the preceding pixel, and only 
one color value can be changed at one time, it may take three pixels to reach the 
color you really wanted. In Figure 8.5 it takes three pixels to change black (RO, 
GO, 00) to white (R15, G15, 815). Note that this example assumes there are no 
intermediate colors in the normal color registers. This gradual change from one 
colorto the next is sometimes referred toas "ramping" the color, and appears on 
thescreen to theleftofHAM pixels. Ifyou need fine details intoyour picture, you 
will want to use a color from the color registers, because those colors do not 
require ramping. 

Black (0, 0, 0) Ib (0, 0, 15) Cyan (0,15,15) WhIte (15, 15, 151 

.0 

Figure 8.5 HAM Color Ramping 

In Paint, if you hold a brush over an area made up of HAM pixels, you may 
see an effect called "fringing." The fringing appears as streaks running to the 
right from the edge of the brush. This effect is only temporary. When you 
paint the brush onto the picture, Paint corrects the fringing, but you may see 
the "ramping" effect where Paint recreates the HAM color to the right of 
your brush. 
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This appendix brieflydescribes some ofthe techniques and processes involved in creating 
afew ofthe pictures on your DeluxePhotoLab art disk. This appendix is included so that 
you can match theeffect you see on the screen with the techniques used to create theeffect. 

EVOLUTION OF THE PACKAGE COVER 

Larry Keenan based the cover photo for DeluxePhotoLab on a photograph from 
his stock photo file. The original photograph was a 16" x 20" photo / collage of the 
room with the world and the hourglass. Larry re-photographed the collage as a 
transparency and then digitized thetransparencyon the Amiga. Digitizing from 
a transparency is a great way to get sufficient lighting in the digitized image. 

Next, Larry set-up the camera lens (with the room/world reflecting in the lens) 
and the cable release in the studio and shot them in 3Smm. Lighting was very 
important to maintain continuity in the assembled photograph. He lit both items 
in warm tones to give the feeling of being in the room. Larry then digitized the 
two best shots. 

At this point, Larry had three digitized images in HAM Interlace: the room, the 
lens with the Globe reflected, and the cable release. These three elements were 
combined with DeluxePhotoLab to create the package cover photograph. 

To start, Larry had to enlarge the room to fit the width of the layout for the 
software package cover. Hemadesections of the right and left walls into brushes 
and used the brushes to extend the walls outward for more width. 

Next he cut out the lens as a brush and dropped it into the room. Once the lens 
was properly placed, Larry touched up (softened and blended) the edges. He 
then proceeded to refine the rest ofthe picture, particularly the clouds, skylight, 
window edges and the tones in the walls. 

Larry selected the cable release brush in four sections and placed it in the room. 
Notice how the cable release arches back to the floating globe and flows 
smoothly forward to give a dramatic perspective. This 3-D perspective creates 
a sense of reality in the picture. Larry also carefully added color to the edges of 
the cable release to give the feeling of light coming in through the window. 
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Larry also sharpened the sand in the hourglass at the top to make a stronger 
pyramid to sym bolize part of the Electronic Arts logo. (You'll find some form of 
each of the three shapes in the picture). 

When Larry submitted his first version of the cover to Electronic Arts, we 
requested that he reduce the size of the world floating in the room to make the 
lens seem larger and thus increase the 3-D quality of the picture. We also 
suggested a change to the angle and flow of the cable release. To accomplish 
these changes, Larry went back to an earlier version of the picture before the 
cable release was added. He then created brushes from the wall and carefully 
painted out the globe, which he digitized again about 25% smaller and dropped 
backinto the picture. He set up thecable release and re-photographed it. To help 
find the right sizeand position for the new cable release, Larry drew the changes 
on the monitor screen in felt tip pen, and then arranged thecable release to match 
the drawing as he shot it with the digitizing camera. This is a great way to 
position element and minimize guess-work. 

Once again, Larry added the cable release to the pictures as several smaller 
brushes. Because ofthe size of the cable release, Larry had to cut the release into 
four sections as brushes. He then "beefed-up" the cable release to give it more 
dimension using the Paint Modes, such as blend, average, and mix. He then 
touched up the cable release and globe on all sides. 

When this version of the cover was finished, another color stat was made and 
presented to Electronic Arts showing full mock-up with type. Only minor 
refinements were suggested, one of which was to smooth out the bend in the 
cable release. When looking at the computer screen, the eye could detect no need 
for correction, but the camera and film see the digitized image differently. On 
film, the image tends to show greater contrast and some areas tend to block-up. 
So Larry had to over-do or over-enhance some textures and tones especially for 
the camera. 

Larry finds it is very important to view the work with a dear vision. To do this, 
he uses the Pola Palette from Liquid Light to make test prints of his progress. He 
finds these test polaroids are helpful in checking his progress and tellinghim the 
"real" from thesurreal. This wasespeciallyimportantin this project, since he had 
to keep in mind how the image would print as a package cover. We think he did 
a great job. 
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PICTURES BY GENE BRAWN 

In addition to spending countless hours testing DeluxePhotoLab and assisting 
with the design of tutorials, Gene Brawn put the program through its paces by 
building pictures. In the process, Gene created three excellent pictures which 
found their way onto the art disk. 

THE HUNTERS 

The Hunters is by far the most complex image he created for DeluxePhotoLab. 
The hunter, his face, the small lizard, the Godzilla, and the Easter Island 
background are all separate HAM Inter lace images. The images were created at 
different times with different palettes and had to be matched and modified to 
combine them into a single picture. 

The hunter was originally created as a black and white image and then colorized 
with a combination of the Add, And, Low Mix, and Mix Paint Modes. The head 
was a digitized image of Gene's own head, which he smoothed and reduced to 
fit the body. 

The lizard, which Gene calls a Mylarasaurus because of the mylar effect he 
created on it, began life as a digitized image of a toy dinosaur. Gene cut this into 
its major pieces (head, torso, and legs) and made solid color mattes from them. 
He then created a one pixel wide brush of the grays ranging from dark to light 
and back to dark. Using the Brush Warp setting of the Fill Control, he filled each 
piece of the lizard to give it a mylar look. He then reassembled the pieces and 
saved it as a brush. 

Godzilla was also a digitized toy model. The image was cut out, touched-up, 
smoothed and then used at its full size. 

Gene's most important task in assembling the final picture was to set the palette 
correctly. He began by reducing the number of colors in the Easter Island 
background picture as far as possible. He used Colors to reduced the number of 
colors in small steps until he was satisfied with the result. Then he removed all 
of the blues and added a basic range of greys for the hunter and mylarasaurus 
because it is usually faster to create a HAM color from a gray scale color and the 
grays don't change the look of the colors beside them. The original background 
picture (before color reduction and palette changes) was then remapped to the 
new palette using the Match option in Colors. 
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Gene loaded his new background picture in Paint, and cut the statue out as a 
brush to move it to the right. He used. pieces of the surrounding grass and sky 
to rebuild the space vacated by the head. 

To make Godzilla seem larger, Gene placed the image behind the hill so that its 
legs and feet would be hidden. To make Godzilla seem farther away, and thus 
even larger, he made it look as though its head was in the clouds. Gene 
accomplished both ofthese effects in a few easy steps. First hecutout the sky and 
surrounding areas (leaving a black hole) and saved the screen without sky. He 
cleared the page and stamped down the sky and surrounding area. Then he 
loaded Godzilla as a brush. Using the Shade Control, Gene set the Highlight with 
the horizontal bar at the top of the region so that the image would be most solid 
above the clouds. He then stamped Godzilla into position, and erased every part 
of the image that was outside ofthe cutout area (the lower legs and feet). Finally, 
he picked up his new sky with Godzilla, reloaded the background picture 
without sky, and stamped the sky and Godzilla back into position. 

To finish it all off, Gene loaded the hunter and the mylarasaurus brushes, 
stamped them in their final poSitions, and touched them up around the edges. 

PHOTOGIRL 

The original image of the girl in this picture was digitized in Black and White 
from an old magazine ad. In DeluxePhotoLab, the girl was cut out from the 
background and the edges were smoothed by hand. The face and dress were 
redrawn to be smoother and flatter. Using the Paint Modes, Gene added color to 
the hair in Low Mix, added color to the sash and collar in And, and to the face 
and hands in Add. Gene then saved the girl as a brush. 

Next Gene cleared the screen and created a 4 x 4 pixel brush consisting of the 
main colors from the palette randomly arranged. With Brush Pattern set in the 
Fill Control. Gene filled the empty screen with this pattern to create a new 
background. Then he loaded the girl brush and placed her on the left side of the 
screen. 

Since he planned to place the title over the lower part of the girl's striped dress, 
Gene faded the dress into the background so that the vertical stripes wouldn't 
make the horizontal title difficult to read. Here are the steps Gene followed: 
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• 	 Select the lower part of the dress as a brush 

• 	 Bring up the Shade Control 

• 	 Set the Dither and High sliders to the maximum settings and set the 
highlight low in the box. 

• 	 Select Color from the Brush Mode menu 

• 	 Select the dominant color from the background as the brush color and 
stamp the brush over the dress in the original position. 

The typeface Gene wanted to use for the slogan and title was a custom font that 
he didn't have in his system fonts directory. So, to make the font useable from 
Paint, Gene returned briefly to the Workbench screen, opened a new Cli 
window, and assigned fonts: to a font directory on his second drive. (The 
command to assign fonts in this case was: 

assign fonts: df1:fonts 

We thought this was a neat tip you might want to remember. 

When he returned to Paint, Gene loaded the font directory from the Font menu 
and typed his slogan on a clear screen. He saved each block of text as a brush. 
Typing text on a clear screen and using the text as a brush is the best way to use 
text in HAM. 

Gene created the drop-shadow effect for the text by using a gray with a Value of 
1 (RGB values are 1,1,1) with Color Brush Mode and Sub Paint Mode. 

Finally, on a different screen, Gene made the main title including the drop 
shadow. Then he loaded it into the main screen as a brush and used Resize Draw 
from the Brushes menu to place the text and make it slightly smaller and 
smoother all in a single operation. 

COMICPOSTER 

Like The Hunters, this picture was composed from separate digitized images: 
the red figure below the earth, the figures on the left, and the earth. 
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Before combining the images, each was matched to the palette of the figures on 
the left using the Match option in Colors. Then, each ofthecharacterswas cut out 
and saved as a separate brush. Gene drew over them to remove the textures 
produced in thedigitizing process so that theoverall '100k" would be flatter and 
more like a comic. 

Gene then created the diagonal background area on a new screen using the same 
technique described for PhotoGirl. The title was also added using a method 
similar to adding the slogan inPhotoGirl. Finally, the figure brushes were loaded 
in order from back to front (earth, figures on the left, and red figure> so that they 
could be easily stamped. Notice that Gene added a shadow below the arm of the 
red figure to give dimension to the picture. 
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PROJECT MENU 

Right Amiga-N 

Right Amiga-C 

Right Amiga-L 

Right Amiga-A 

Right Amiga-5 

Right Amiga-Z 

P 

0 

S 

Shift-S 

New 

Close 

Load 

Load At 

Save 

Page Size 

Palette Screen 

Showpage overscan 

Show page fast 

Show page smooth 

BRUSHES MENU 

Right Amiga-G 

Right Amiga-P 

X 
y 

Z 

Shift-Z 

W 

G 

Shift-G 

Right Amiga-D 

Right Amiga-H 

Right Amiga-R 

Load brush 

Save brush 

Horizontal Flip 

Vertical Hip 

Rotate 90 degrees clockwise 

Rotate 90 degrees counter-cIockwise 

Rotate Free 

Grab last drawn 

Grab underneath last drawn 

Resize Draw 

Handle 

Remap 
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OPTIONS MENU 


Q 

Shift-Q 

C 

Shift-C 

V 

R 

\ 

Transparency on 

Transparency off 

Corner to comer ovals 

Center ovals 

Shade requester 

Repeat last draw operation 

Smooth 

FONTS MENU 

Right Amiga-F 

Right Amiga-1 thru6 

Ctrl-P 

Ctrl-U 

Ctrl-I 

Ctrl-B 

Load new font 

Activate font 

Plain 

Underline 

Italic 

Bold 

MODES MENU 

BRUSH MODES 

F1 

F2 

F3 

F4 

Matte mode 

Color mode 

Pattern mode 

Store mode 
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PAINT MODES 

Left Alt-Fl 

Left Alt-F2 

Left Alt-F3 

Left Alt-F4 

Left Alt-F5 

Left Alt-F6 

Left Alt-F7 

Left Alt-F8 

Left Alt-F9 

Right Alt-Fl 

Right Alt-F2 

Right Alt-F3 

Right Alt-F4 

Right Alt-F5 

Right Alt-F6 

Right Alt-F7 

Right All-F8 

Right Alt-F9 

Left or Right Alt-FlO 

AFFECf 

All 

Foreground 

Background 

Solid 

Low Mix 

Mix 

Average 

Blend 

Shade 

SubPict 

Scale 

Scale2 

Add 

Sub 

Max 

Min 

XOR 

OR 

AND 

Hlf 

B&W 

Solid 

F5 

F6 

F7 
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TOOLBOX/PAINT SET COMMANDS 


I 

J 

T 

L 

[ 

Shift-[ 

E 

Shift-E 

F 

Shifl-F 

B 

Shifl-B 

M 

I 

0 

K 

U 

Dotted Freehand 

Continuous Freehand 

Straight Line 

Curve tool 

Airbrush 

Text tool 

Fill tool 

Unfilled Rectangle 

Filled Rectangle 

Unfilled Oval 

Filled Oval 

Freefonn fill tool 

Polygon fill tool 

Brush Selector 

Freefonn Brush Selector 

Magnify tool 

Zoom in 

Zoom out 

Clear screen 

Undo tool 
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SPECIAL KEYS 

A 

Help 

F8 

F9 

FlO 

Spacebar 

ESC 

N 

iJ,+-~ 

Shift-i J. +- ~ 

Tab 

Get Last Built-in Brush 

Pick Cursor 

Again (repeat last menu) 

Rotates through HAM color 

combinations 

Toggle cursor 

Toggle menu bar 

Toggle toolbox 

Abort 

Abort Text mode 

New position in magnify 

Scroll the picture 

Scroll the picture in larger jumps 

Cycle through the picture screens 

FILE REQUESTERS 

ESC 

UpArrow 

Down Arrow 

Shift-Up Arrow 

Shift-Down Arrow 

Return 

D 

F 

V 

Same as clicking Cancel 

Move display up one line 

Move display down one line 

Move display up one section 

Move display down one section 

Same as clicking Load 

Shows the directories 

Shows the files 

Shows the volumes 
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POSTERS 

Right Amiga-L 

Right Amiga-P 

Right Amiga~ 

Right Amiga-V 

Right Amiga-A 

Right Amiga-H 

Load 

Print 

Quit 

Preview 

Aspect Ratio 

Horizontal Printing 

COLORS 

COMMAND SCREEN 

R, G, B, H, S, V, P 

L 

N 

M 

Z 

C 

U 

F 

0 

K 

I 

T 

RGVHSVP Buttons 

Lock all registers 

Clear all locks 

Mosaic 

Resize 

Reduce 

Undo 

BSTFIT / TRUNCT 

SAMPLE / SMOOTH 

RESIZE / SIZE OK 

SRT HiLo / SORT LoHi 

REAL / TEST 
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MENU OPTIONS 

Right Amiga-S 


Right Amiga-R 


Right Amiga-W 


Right Amiga-Q 


Right Amiga-M 


Right Amiga-B 


Right Amiga-N 


Right Amiga-P 


SEPARATIONS 

Right Amiga-D 

Right Amiga-E 

Right Amiga-U 

Right Amiga-Y 

Right Amiga-C 

Right Amiga-G 

Right Amiga-K 

SORTS 

Right Amiga-l 

Right Amiga-2 

Right Amiga-3 

Right Amiga-4 

Right Amiga-5 

Right Amiga-6 

Right Amiga-7 

Right Amiga-8 

Save Fast 

Revert 

Workbench 

Quit 

Match 

MakeB/W 

Negative 

Palette 

Red 

Green 

Blue 

Yellow 

Cyan 

Magenta 

Black 

Red 

Green 

Blue 

Hue 

Saturation 

Value 

Population 

Locks 
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INDEX 


A 

About (Colors), 179 

About (Paint), 94 

About Pictures, 201-206, (Appendix q 

About (Posters), 135 

Active Command (Colors Title Bar), 142

143 

Active Palette (Colors Title Bar), 143 

Active Picture (Colors Title Bar), 143 

active screen (Colors), 142 

Active Unknown (Colors Title Bar), 143 

Add Command (Right-Alt-Fl) (Paint 


mode), 60, 104, 

Adjust (Palette option), 91 

Affect mode, 44, 106-1!Y7, 117 

Airbrush tool (Paint Toolbox), 27, 54, 80 

All (Affect option), 44 

All (Highlight type), 1!Y7, 109 

Amiga 1000, 5 

Amiga Display Modes, 18, 7(}'71. 


See also Appendix B 

AND command (Right-Alt-F7), 60, 106 

anti-aliasing algorithm (Paint), 115 

anti-aliasing (Colors), 165 

anti-aliasing (Posters), 134 

arrow buttons (Colors Register Graph), 


145 

arrows, up and down, 9 

art disk, 3, 17 

Aspect Ratio (Right Amiga A) (Poster 


Mode menu),124, 126,135-136 
Average Command (LeIt-Alt-F4), 57,102 

B 

B&W (paint), 97 

B&W (Right-Alt-F9) (Paint), 57, 61,90 97 


106 

Back Gadget (Paint Palette Screen), 75 

Background,20,22 


Affect option (F7), 44 

color, 20, 21, 22, 23, 3(}'31 


Backspace key, 27,81 

Begin Range Marker, 48, 51, 53, 78, 110 

Bestfit/Truncate [BSlFIT/TRUNCT (F)] 


(Colors), 174, 184 


bit planes (Colors), 158, 161, 180 

bit planes (Paint), 18,19,71 

bit planes 


and colors, 193-194 

and display modes, see Appendix B 


black and white, 61, 63. See also B&W 

(Paint) 


black and white image (Colors), 153 

Blend Command (Left-Alt-F5), 102 

Blue (B) (Colors), 146 

Blue option (Right Amiga-3) (Colors 


Sort),181 
Bold Command (CTRL-B) (Text style), 

58,116 

bounding rectangle, 100, 101 

Brush 


area, freeiorm, 83 

area, rectangular 83 

Border (Brush Fills), 112 

and bounding rectangle, 101 (Fig) 

built-in, 24 (Fig), 56, 73, 95,99, 108 

color, 107 

creating irregular-shaped, 39,10(}. 


101 

creating rectangular, 38 

custom, 95 (Fig), 19,23,35,37-42, 


55,56,73,83,95-99, 1!Y7, 108, 

110, 117 


default, 100 

Fills, 67-68, 109 

Load and Save, 40-41 

and memory management, 117 

menu, 24,39 

mode, 99-100 

palette, 53 

Pattern gadget, 11(}'111, 114 

and position, 24 

Selector tool (B rectangular, Shift-B 


freeform), 3(}'31, 38-40,55,67, 
83,95-%,10(}'101 


single-pixel, 24 

Size and speed, 25 

Stretch (Brush Fills), 113 

and Text Tool, 24 

Warp (Brush Fills), 68, 113 




C 

built-in brush. See brush, built-in 

button, left, 83 

button, right, 83 

button. See under individual button name 


Cancel 

Gadgets, 77 

Paint Load Requester, 87 

Palette Screen, 78 

Print Brush Control, 91, 98 

Print Picture Control, 91 

Print Posters, 135 


Center 

picture in magnified area (n), 31 

Print Brush Control, 98 

Print Picture Control, 91 

Ovals command (C - on, Shift-C 

off),115 

center-out, 82 

changing display modes (Colors), 154

156, 158, 160 

Circle. See Oval Tool 

Oear (Toolbox), 22, 84 

Oipboards, 87 

Oose Command (Right Amiga-C), 86 

CLR(Oear) 


Colors Register Graph, 171 

Paint, 22, 24 


color(s). See also Appendix B 

4,096 colors, 10 

32 colors, 10 

background, 100 

Command (F2), 100 

component (Colors), 145 

copying from the picture, 50 

copying into the Palette, 49-50, 77 

creating a spread of, 51-52 

HSV, 190-193 

indicating a range of, 50 

Indicator. See Color Indicator 

low-contrast,111 

menu (Colors), 179 (Fig) 

mode (Paint), 107 

object color, 101-106 

option (Brush mode), 100-101 

palette, 91 

picture color, 100, 102-106 


and Print Brush Control: Shades, 

97 


and Print Picture Control: and 

Shade, 90 


pure (HSV), 193 

range, 110-111 

register (Colors), 144-145 

RGB,189-190 

selecting from screen, 23 

Selection of in 4,096 Color Palette, 


76 

separation, 179-180 

Theory of, see Appendix A. 

wheel, additive, 191 (Fig) 


Color 0 (Meld Registers), 164-165 

Color 1 (Meld Registers), 165 

Color Indicator (",") [Palette Screen], 20, 


21, 48, 50, 51,74,76, 77 

Color Palette and screen formats, the, 53 

Color Statistics Display (Colors), 143

146, 154, 168-170. See also Appendix 

A 

Command Screen (Colors), 142 (Hg), 167 

(Fig), 141-143, 167-175 


Commands, keyboard. See specific 

command, Appendix D 


Commit Changes message (Colors 

Register Graph), 146, 172 


complements, 105 

Continuous Freehand Tool (' [apostro

phe]) [Toolbox], 25, 39, 54, 79, 100 

contrasting colors, 24 

Coordinates (Paint Screen), 23, 74 

Copies (Print Brush Control), 97 

Copies (Print Picture Contro!), 91 

Copy Color (Colors Palette), 183 

Copy Colors (Colors), 163 

Copy gadget (Paint), 77 

copying disks, 4 

Copying colors into the palette. See 


Color(s), copying into the Palette. 

comer-to-comer, 82 

correction of text, 56 


and "fringing" in HAM mode, 58 

Count Pixels (Colors) 159 

Counting Pixels message (Color Statis


tics Display), 154, 159 

Creating Colors. See Color(s), creating a 


spread of 




cross-hair, 23, 24, 25, 39, 74 

current background color, 78, 79 

current directory path, 86 

Current Info (Colors), 185 

current screen, 34 

Curve Tool Command (j),26, 54, 80 

custom brush. SeeBrush, custom 

cutting and pasting (Paint), 18, 71 


D 
default background color, 20 

default palette, 53 

default settings (Paint), 6, 90 

Delete (Show Page option), 94 

delete files, 4 

DeluxePaint, 17 

DeluxePhotoLab pictures, 201-206 

Depth (Colors info), 185 

Depth gadget (Display Mode 


Requester), 18, 19,71 

directories, 9, 87 

Directory Display Command (d), 9 

disk drives, 9, 33 

Display Mode Requester (Paint), 6 (Fig), 


17 (Fig), 34 (Fig), 17, 18, 19,70-71 

Display Modes (Colors), 184-185 See also 

Appendix B: Amiga Display Modes; 
Extra-Halfbrite; Hold and Modify 
(HAM); Low Resolution; High Reso
lution; and screen formats 

changing, 154-155, 160-162 

Display Modes (Paint), 17,20. See also 

Appendix B: Amiga Display Modes; 
Extra-Halfbrite; Hold and Modify 
(HAM); Low Resolution; High 
Resolution; and screen formats 

selection of, 17, 19 

Display Palette Screen command (p) 


[Paint),47, 61, 62 

Display Type, 3. See also Display Modes 

(Colors); Display Modes 
(Paint);Appendix B 

Dither,55,~, 112,113 

Highlight, 109 

slider, 64, 113 


Dots (Magnify option), 43, 114 

Dotted Freehand Tool Command, (";"), 


25,54 

drawer(s). See also Directory(ies), 3,4,9 


Dual Playfield Display Mode. See 
Appendix B 

E 
edit field, 9, 86 

Eject Paper At (Print Posters), 134 

Eject Paper At (Print Requester, Posters), 


128 

End Range Marker, 48, 51, 52, 77, 78, 110 


and spread, 77 

erase, 20, 22, 81 

exit (Show Page Function), 45 

Extra HalfBrite Display Mode, 18, 53, 71, 


169, 171,196 

F 

Fast (Show Page option), 45, 93 

File gadget, 9, 34 

file list window, 86 

files, 9 

Fill and shape tools, 54 

Fill areas, 1 09-11 0 

Fill Control (Option menu), 55 (Fig), 109 


(Fig),66,67, 78, 81, 82,100,107,109
114 


Fill Offset, 100, 109, 114 

Fill Tool (L), 27-28, 31,81,107 

Fill Type, 54-55, 67, 109,110 

Filled Objects, Filled Areas, 110 (Fig) 

Filled Rectangle, Shade mode (black and 


white), 63 (Fig) 

Fills, 111-113 

Font(s), 27, 81 


directory, 56 

list, 56, 116 

menu, 115 (Fig), 116-117. See also 


Appendix D 
Names (Right Amiga 1 through 6), 

117 

Foreground (Affect option), 44,106-107 

Foreground Command (F6), 107 

foreground, 20 

foreground color, 19-21, 73, 77 

four-point curve, 80 

4,096 Color Palette (Palette Screen), 47, 


49, 53, 75-76 

Freeform Shape Tool (Toolbox), 29-30, 


82-83 




Freehand, Painting. See Dotted Free
hand Tool; Continuous Freehand 
Tool 

"fringing" in HAM mode, 58 

Front and Back gadgets, 34 


G 
gadgets, 18 

GenLocks, 115 

Grab Last Command (G), 99 

gradient, 51, 68 

Gradient Fill Function, 55, 109-110 

Gradient Type, 55, 110 

gray level, 191-192 

Green (G) (Colors), 14~146 


Green option (Right Amiga-2) (Colors 

Sort),181 

Grey 

Print Brush Control; Shade, 97 

Print Picture Control; Shade, 90 


H 
HAM (Hold and Modify) (Colors), 172. 

See also Display Modes; display type 

colors, 153, 159 

display mode, 141, 145, 154-155 

and HSV attribute, 172 

Interlace mode, 165 

pixel, 145, 170 

and Pixel Color Selection, 195 (Fig) 

and RGB value, 195 


HAM (Hold and Modify) [Paint], 3, 5, 

10, 17, 18,33-34,43,46,48,57-58,71, 

78,99,101, 113. See also Display 

modes; display type 


and text "fringing", 58 

HAM (Hold and Modify) (Posters), 122. 


See also Display Modes; display type 

Handle command (Right Amiga-H), 99 

Hard Disk Installation, 4-5 

Height (Colors info), 185 

Height 


Print Brush Control, 97 

Print Picture Control, 91 


Height edit field 

Load At,88 

Save From, 89 


Height setting (Paint Set option; Page 
Size),93 

Help Key, 76 
Hide/Display 


cross-hair (F8 ), 43 

menu bar (F9 ), 42 

Title bar (F9), 35 

Toolbox (FlO), 35, 42 


High (Colors, Reduce), 174 

Paint, Highlight, 108 


High Resolution Display Mode, 18, 53, 

71. See also Display Modes; display 
type; Appendix B; Amiga Display 
Modes 

Colors, 154-155 

High slider, 65, 66, 67 108 

Highlight, 7, 20, 6~67, 107-108 

Highlights, (Point, All, Horizontal and 


Vertical) 66-67 

HLF Command (Right-Alt-FB), 57, 106 


Hold and Modify (HAM) Display Mode. 

See HAM (Colors; Paint; and Posters). 


Horizontal 

Border (Range Fills), 111 

Brush (Brush Filis), 112-113 

fashion, 67 

Flip, (Brush Rotations), 41,96 

Highlight type, 107 

lines (Paint tools), 79, 80 

movement, 82 

Page (Range Filis), 112 

Printing (Right Amiga-H) (Posters), 


125, 126, 136 

Screen (Range Fills), 112 

Width (Range Fills), 112 


Horz Flip 00 (Brushes menu; Rotations 

option), 41, 96 


HSV (Colors) (Hue, Saturation, Value), 

144,145-146 


color mixing, 190-192 

color values, 192 (fable) 

compared with RGB, 192 


H5V (Paint) (Hue, Saturation, Value), 62 

change to RGB, 75 

color mixing, 48 

mode and spread, 51 

and numeric value, 75 

Slider (Palette Screen), 47, 75 

Value, 75, 76 


Hue, 48, 51, 190-191. See also HSV 

(Colors); HSV (Paint) 




I 

increase magnification, 84 

Indicators, 23. See also Color Indicator 

initialized disks, 4 

Interlaced, 18, 71 

Italic (crRL-I), 56, 116 


I,K 
jaggedness (Colors), 165 

Keyboard Commands (equivalents). See 


specific commands; Appendix D 


L 
Line Tool, 54 

Lines (Magnify option), 43, 114 

Load At (Right Amiga-A), [Paint] 44, 


88,115 

and Affect, 44 

Requester, 86 (Fig) 


Load (Colors), 176-177 

File Requester, 177 (FIg) 

picture, 141 

shortcuts, 177 


Load (Right Amiga-G), [Paint] 8-9 

button,86 

Brush Requester, 41,95 

Brushes menu,95-99 

Font Requester, 56 (Fig), 116 (Fig) 

Keyboard shortcuts, 87-88 

New Font (Right Amlga-F), 116 

Paint Sets, 53, 92-94 

Palettes, 53, 91-92 

picture 34-35 

Picture Requester, 41 

Project menu, 86-94 

Requester (Paint Set, Load), 9 (FIg), 


86 (FIg), 34, 86, 88 

Load (Right Amiga-L), [Posters] 122, 


132-133 

locked colors arrows (Colors), 171-172 

locking registers (Colors), 147 

Locks option (Right Amiga-8) (Colors 


Sort),181 

Low (Colors, Reduce), 174 

Low Mix Command (Left-Alt-F2), 102; 


Low (PainO, 67, 109 

Low Resolution Display Mode (Colors), 


154,159,194-195 


Low Resolution Display Mode, (Paint), 

18, 19,34,53,71 


Low slider, 65, 66, 109 


M 
Magnify Mode (m), 31-32, 43, 44, 65, 84 


and amount of magnification, 43 

and arrow (cursor) keys, 43 

and Zoom tool, 43 


Make B/W (Right Amiga-B) (Colors), 

153,182 


Match (Right Amiga-M) (Colors), 181
182 


Match Palette (Colors), 152-153 

Match Requester (Colors), 152 

Matte (Brush Mode), 100 

Max command (Right-Alt-F3), 104 

Medium (Colors, Reduce), 174 

Meld By Average (Colors Palette), 164, 


183 

Meld By Weight (Colors Palette), 164, 


183 

Meld Registers (Colors Palette Window), 


164-165,183 

Memory (Colors), 165 

Memory management, 117 

Menu Bar (Colors), 169 

Menu Bar (PainO, 7, 73 

Menu Bar (Posters), 121, 130,131 

Menu Items (Paint), 85-117 

Menus (Colors), 175-185 

Menus (Paint), 7, 20 

Menus (posters), 131-136 

Min Command (Right-Alt-F4), 105 

Mix Command (Left-Alt-F3), 102 

Mode (Colors info), 185 

Modes menu (Posters), 135-136 

Modes menu (Paint), 99 (Fig), 20, 45-46, 


57,99-107 

Mosaic button (M) [Colors], ISO, 172-173 

moving Colors screens, 143 

multiple piCtures, and the Palette Screen, 


75 

Multiple screens. See Screen(s) 


N 
Negative (Right Amiga-N> [Colors], 153, 


182 

negative image (Paint), 105 




93 

new background color, 21 

New command (Right Amiga-N), 86 

New Page Size Requester (Paint Set), 44, 


No Background (Preferences), 115 

Non-Interlaced,6, 18, 71 

Normal (Magnify option), 43, 114 

nozzle, 54 

Number of Copies (Print Requester, 


Posters), 127, 133 


o 
object color (Value). See Color(s), value 

old background color, 21 

Open File requester (Posters), 132 (Fig) 

Options menu (Paint), 107 (Fig), 82, 117 

OR command (Right-Alt-F6), 105 

Orientation (Print Brush Control), 97 

Orientation (Print Picture Control), 90 

Oval Tool, 29, 82 

Overscan display mode (D), 45, 94 


Show Page, 45 


p 

Page, 72 

Page Grid (posters), 121, 123,125, 135, 


136 

Page Height (Posters), 126 

Page Size (Paint) (Right Amiga-Z), 19, 


44,93 
and computer memory, 44 


Page Size gadgets (Posters), 121-122, 131 

Page Width (Posters), 123, 125 

Paint mode(s), 57, 62, 67,101-107 


and color values, 38 

default mode, 57 

and Fill Type, 101 

and memory management, 117 

and Palette, 101 


Paint Palette, 75 

Paint Screen, 72-84 

Paint Set (palette Screen), 48-53, 61, 78, 


92-94 

Loading and Saving, 53 


Paint 

defaultsetling~6 

Painting Screen, 7 (Fig), 19 (Fig),72 

(FIg),73 


painting tools, 25 


Palette (Colors) (Right Amiga-P), 151 

(Fig), 152, 168, 182-183 


Window, 182 (Fig), 164-165, 183 

Palette (Paint), 20-23, 72-74 


and brush, 40 

gadgets, 48, 77 

Indicators, 73 

loading and saving, 53, 77 

option, 45, 91 

Screen,47 (Fig), 46-53, 61, 73, 75-78, 


91-92 

Path gadget, 9 

Pattern (F3), 100 

Pause Printer At (poster) 134 


Print Requester, 126-128 

percent of page size, 91, 97 

Pick pointer, ( ",") , 23, 24, 74 

Pictures. See Appendix C 

picture, 19 


color (Value) (see Color(s), value) 

palette, 50 

Screen (Colors), 143-144,167-176 


pixel(s),23,24, 74, 91, 97, 107, 112, 146 

and Affect, 106-107 

count, 144 

marker, single,83 


Plain (CTRL-P), 116 

Plain (Text style), 116 

planes. See bit planes 

Point (Highlight type), 108 

Polygon. See Freeform Shape Tool 

Population (P) (Colors), 145, 146, 148, 


157,159,169-171 
option (Right Amiga-7) (Colors 

Sort),181 

Poster Height (Posters), 122-124, 130, 136 

Poster Size. See Sizing Posters 

Poster size gadgets. See Poster Width; 


Poster Height 

Poster Width (Posters), 122-124, 130, 136 

Posters Screen, 121 (FIg), 129 (FIg), 122, 


130 

Preferences (paint) 


device drivers, 3 

submenu (Options menu), 114 


Preferences (Posters), 121, 131 

Preview (Right Amiga-V) (Poster Mode 


menu),124 

and printing Posters, 124 




Preferences (poslers), 121, 131 

Preview (Righi Amiga-V) (Posler Mode 


menu),124 

and printing Posters, 124 


primary colors, 105 

PrInt (Paint) 


Brushes menu, 95 

cancel printing, 98 

PrInt Picture Control, 90 (Fig), 91 


PrInt (posters), 126-128, 133-134 

and color separation, 179-180 

Requester, 127 (Fig), 135 


prinler drivers, 3 

printers, 4 

program disk, 3 

Progress Display (Colors Register 


Graph), 146, 154 

Project menu (Colors), 176 (Fig) 

Project menu (Paint), 8 (Fig), 85 (Fig), 


85--94 

Project menu (Posters), 132-135 

Proportional printing 


PrInt Picture Control, 90 

PrInt Brush Control, 97 


pure colors (HSV), 192 


Q 

Quit (Colors) (Right Amiga-Q), 179 

Quit (Paint) (Project menu), 10, 94 

Quit (Posters) (Right Amiga-Q), 135 


R 

RAM, 3 

ramping, 200 

Range FUIs, 111 (Fig), 112-113 

Ranges, 77-78 


and Gradient Fill options, 77 

Real/Test (T) (Colors), 149, 175 

Rectangle Tool, 28, 81-82 

rectangular cursor, 27 

Red (R) (Colors), 146 

Red, Blue, and Green (RGB), 76-77,189. 


See also RGB 

Red option (Right Amiga-l) (Colors 


Sort),180 

Redraw Picture (Colors), 159 


Redraw Pictures message, 154, 159 

Reduce (C) (Colors), 150, 157-165, 173

174 


RedUcing Colors message (Color Statis

tics Display), 154 


Register Graph (Colors), 145-150, 151, 

171-172 


flags, 149, 165 

Register Palette, 78 

Remap (Right Amiga-R), 99 

Repeat, 1(17 

requester, 6, 17, 86-89 

Resize (Z) (Colors), 150, 165-166, 173, 


175,184 

Resize Draw Command (Right Amiga


D), 35-36, 98-99, 115 

Resize Image (Load At), 88 

Resize (Paint), 98, 115 


and Affect, 44 

Resized (Colors, Save), 178 

Return key (Text Too)), 81 

Revert (Right Amiga-R) (Colors), 155

156,178 

RGB (Red, Blue, Green) (Colors), 144 


buttons, 145, 158,170-171,192 

compared with HSV, 192 


RGB (Red. Blue, Green) (Paint), 21, 75-77 

change to HSV, 47, 75 

Color Cube, 76 (Fig), 189 (Fig) 

color mixing, 49,189-191 

Sliders, 47, 48,75-76,192 

and spread, 51, 77 

value, 21,101,192 (Table) 


RGB/HSV sliders, 47 

RGBHSVP buttons (Colon.), 145 

RGBHSVYCM (Color Statistics Display), 


169-176 

RGBYCMB (Colors), 152 

root, directory of, 9 

Rotate 90 commands (Z, clockwise, Shift


Z, counter-clockwise), 41, 96 

Rotate Free command (W), 41, 96 

Rotations option (Brushes menu), 41, % 


s 
Sample/Smooth (0) (Colors), 174 


Colors Register Graph, 151 

Mosaic and Resize, 165-166 


saturation, 47-49, 191-192 

Saturation option (Right Amiga-5) 


(Colors Sort), 181 

Saturation (S) (Colors), 145 




Save (Colors), 178 

Fast (Right Amiga-S), 178 

Resized (Colors), 165-166 


Save (Paint) 

Brush Requester (Right Amiga-P), 


53,95 

changes, 10 

From (Project menu), 89 

From Requester, 89 (Fig) 

one drive, 33 

Paint Sets, 53 

Palette option, 92 

Palettes, 53 

picture ("files"), 32 

Project menu (Right Amiga-S), 89 

Requester, 32 (Fig), 34, 93 

Set option,93-94 

two drives, 33 

under another name, 33 


Scale Command (Left-Alt-Fa), 103 

Scale2 Command (Left-Alt-F9), 103 

Screen Format, 18-19. See also Display 


Modes; display type; Appendix B 

Screen Resolutions, 45-46, 53. See also 


screen type; Appendix B, 

Display Mode Requester; Extra 

Halfbrite, High Resolution, Hold 

and Modify (HAM), interlaced 

mode, Low Resolution and mul

tiple screens, noninterlaced, 45 


Screen Type, 17-18,71. See also Screen 

Resolutions; Appendix B 


Screen Type Gadget (Display Mode 

Requester), 2.2, 5.3 


Screen(s) (Pain!), 33-34 

scroll box, 9 

scroll gadget, 116 

secondary colors, 105 

Select, 8 

selecting colors, 23 

Separate (Color menu), 179-180 

Set (Colors Register Graph), 171 

Set To option (Colors View Modes 


menu), 154, 184 

Shade Command (Left-Alt-F6), 103 


Print Brush Control, 97 

Print Picture Control, 90 


Shade Control command (V), 64 (Fig), 

108 (Fig), 109 


default settings, 64 

and dither (see Dither) 


Shade effect, 108 

Shade mode, 64-65 

Shade option (Paint modes), 103 

Shade requester, 66-67 

Shapes (Brushes menu), 95 

Shapes option, 24 

Shortcuts (Project menu), 87-88 

Show Page option (Shift-S), 45, 93 


quickly.. See Fast 

six bit planes, 71. See also bit planes 

Size (Display Mode Requester), 71 


and conserving memory, 71 

Size Factor (Print Picture Control), 90,97 

Size gadget, 18 

Sizing Posters, 123-124 

Smooth (Paint), 94 


Preferences ("\"), 115 

Smooth (Posters), Print, 128, 134 

Solid Color gadget (Fill), 109 

Solid Commands (Left-Alt-Fl, Left or 


Right Alt-FlO), 57,67,101 

Sort On (Colors), 147-148, 151, 159,181 

split screen, 84 

spout (fill), 81 

Spread gadget (Palette Screen), 51, 77 

Square. See Rectangle Tool 

SRT HiLo/SRT LoHi (1) (Colors), 147

149, 175,181 

Start/Stop (Print Requester,Posters), 


127, 134 

Starting Paint, 68-69 

Starting the Programs, 5-6 

Store (F4) (Brush mode), ]01, 107 

Straight Line Tool (n1"), 26, 80 

Style submenu (Fonts menu), 56, 81, 116

117 

Sub Command (Right Alt-F2), 104 

Sub Pict Command (Left Alt-F7), 104 

subdirectory name, 87 

submenus, 9, 24 

Swap Colors (Colors Palette), 162, 183 

Swap Registers (Colors Palette), 163, 183 

Sys:Fonts, directory, 56 


T 
Test flag button (Colors), 151. See also 

Real/Test (Colors) 



Text (T),56, 80, 109 

and Backspace, 58 

correction, 27 

cursor, 81 

editor, 58 

fonts and style of, 27 

icon, 58 

moving with brush selector, 58 

styles, 116-117 


three-quarter (3/4) screen setting. 71-72 

three-point curve, SO 

Title Bar (Colors), 142, 168 

TItle Bar (Pain!), 7,19,20,47,73,75, S5 


Paint Screen, 72 (Fig), 73 

Palette Screen, 75 


TItle Bar (Posters), 121, 129 

Tool Selection, 25-32 

Toolbox (Paint), 25 (Fig), 6, 19,22,72,79

84. See also indiuidual tools. 
Tools 


and background color, 79 

and foreground color, 79 

and mouse buttons, 79 


Trace Edges gadget (Fill), 55, 109 

Transparency (q, on; Shift-Q, om, 114 

type style, 81 


U 
Underline (CTRL-U), 58, 116 

Undo (U) (Colors), 148, 174 

Undo (U) (Paint), 21, 61, 78, 84 


and copy, 78 

Unfilled/Filled Oval tool <Toolbox), 82 


(E, unfilled; Shift-E, filled), 82 

Unfilled/Filled Rectangle tool (L un

filled; Shift-[, filled), 81-82 

Use Brush (Palette option), 92 

Use Default (Palette option), 92 

Use Picture (Palette option), 92 


Value (V) (Colors), 145, 190-191 

slider, 192 


Value option (Right Amiga-6) (Colors, 

Sort), 181 


Value (paint), 48, 49, 51 

Vert Brush (Brush Fills), 113 

Vert Flip (Vertical Flip) 00, (Brush 


Rotations), 41, 96 


Vertical, 67 

bar, 66 

Height (Range Fills), 112 

Highligh t type, 1 Cl! 

lines (Paint tools), 80 

movement, 82 

Page (Range Fills), 112 

Screen (Range Fills), 112 


View Modes menu (Colors), 184 (Fig), 

154 


volume(s),9 

Display Command (v), 9, 34 

List, S7 


W 
wash, 21 

White Background (Print Posters), 128, 


134 

Width (Colors info), 185 

Width (Paint) 


edit field {Load At), 88 

edit field (Save From), 89 

gadget (Paint Set option: Page Size), 


93 

gadget (Print Brush Control), 97 

gadget (Print Picture Control), 91 


Workbench (Colors) (Right Amiga-W), 

141,142,178 


Workbench (paint), 5 

Preferences, 114 


X, V,Z 

X Horz Flip command, 96 

XPos 


Load At, 88 

Save From, 89 


XOR (Right-Alt-F5), 144 

YPos 


Load At, 88 

Save From, 89 


YCM (yellow, Cyan, and Magenta) 

(Colors), 144 


Zoom tool <Toolbox), 84. See also 

Magnify tool 


decrease magnification (0), 84 

increase magnification (0,84 

zoom in/out,31-32 


V 



CREDITS 


Software: David Porter, Ryndert Johan Jongens, and Brian Jones of 
Digital Creations 

Producer: Tom Casey 

Technical Director: Steve Hayes 

Manual: Hal Jordy, with contributions from Nicholas Lavroff 

Product Manager: Tom Casey, John Skeel 

Software Testing: Keith McCurdy, Gene Brawn 

Program Art: Gene Brawn, Larry Keenan, Richard Antaki, and 
Avril Harrison 

Package Design: Lance Anderson/Triad 

Art Direction: Nancy L. Pong 

Cover Photography: Larry Keenan 

About our company: Were an association of electronic artists who share a 
common goal. We want to fulfill the potential ofpersonal computing. That's a tall 
order. But with enough imagination and enthusiasm, we think there's a good 
chance for success. Our prod ucts, like this one, are evidence of our intent. Ifyou 
would like a product brochure, send $1.00 and a self-addressed, stamped enve
lope to: Electronic Arts Catalog Request, 1820 Gateway Drive, San Mateo, CA 
94404-2497. 



NOTICE 

ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE IMPROVEMENTS IN THE PRODUCT DESCRIBED IN THIS 
MANUAL AT ANY TIME AND WrrHOUT NOTICE. 

THIS MANUAL,ANDTHE SOFlWARE DESCRIBED IN THIS MANUAL, ISCOPYRIGHTED.ALL RIGHTS ARE RESERVED. 
NOPARTOFTHISMANUALORTHEDESCRIBEDSOfTWAREMAYBECOPIED,REPRODUCED,TRANSLATEDORRE· 
DUCED TO ANY ELECTRONIC MEDIUM OR MACHINE·READABLE FORM WrrHOUT THE PRIOR WRITTEN CONSENT 
OF ELECTRONIC ARTS, 1820 GATEWAY DRIVE, SAN MATEO, CALIFORNIA 94404. 

UMITED WARRANTY 

Umlted Warranty. Electronic Arts (REA·) provides to the original purchaser of the computer software product, 
for a period of ninety (90) days from the date of original purchase (the ·W8IT8nty Periodj, the following limited 
warranties: 

Media: EA warrants that, under normal use, the magnetic media and the packaging provided with it are 
free from defects in materials and workmanship. 

Software: EA warrants that the software, as originally purchased, will perform substantially in confor
mance with the specifications set forth in the packaging and in the user manual. 

Warranty Information. If you are having any problems with the product, we are happy to help. Please address 
all correspondence to Electronic Arts, 1820 Gateway Drive, San Mateo, California 94404. Or call us at (415) 
572-ARTS. 

Warranty Claims. To make a w8lT8nty claim underthis limited warranty, please return the product to the point 
of purchase, accompanied by proof of purchase, a statement of the defect, and your name and return address. 
To replace defective media after expiration of the Warranty Period, send the product, in protective packaging, 
postage prepaid, to Electronic Arts, at the above address, enclosing proof of purchase, a statement of the 
defect, your name and return address, and a check for $7.SO. EA or its authorized dealer will, at its option, repair 
or replace the product, and return it to you, postage prepaid, or issue you a credit equal to the purchase price. 
THE FOREGOING STATES THE PURCHASER'S SOlE AND EXCLUSIVE REMEDY FOR ANY BREACH OF WARRANTY 
WITH RESPECT TO THE SOFTWARE PRODUCT. 

Warranty Exclusions. EA EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES WITH RESPECT TO THE MEDIA 
AND THE SOFTWARE, INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PUR· 
POSE. ANY WARRANTIES IMPUEDBY LAW ARE LIMrrED IN DURATION TOTHE WARRANTY PERI00. SOME STATES 
DONOTALLOWUMrrATIONSONTHEDURATIONOFANIMPLIEDWARRANTY,SOTHEABOVELlMrrATION MAY NOT 
APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY FROM STATE TO STATE. 

UMITAll0NS ON DAMAGES 

EA SHALL NOT IN ANY CASE BE LIABLE FOR INCIDENTAL, CONSEQUENTIAL OR OTHER INDIRECT DAMAGES 
ARISING FROM ANY CLAIM UNDER THIS AGREEMENT, EVEN IF EA OR ITS AGENTS HAVE BEEN ADVISED OF THE 
POSSIBLITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE L1MrrATION OR EXCLUSION MAY NOT APPLY TO YOU. 

Unless indicated otherwise, all software and documentation are (01988 Electronic Arts. All rights reserved. 



Commodore-Amlga System Software Version 1,3 


Program License Agreement and Limited Warranty 


Carefully read all the terms and cond~ions of this agreement prior to using the enclosed diskette. Your use of the dISkette indicates your acceptance 
of these terms and c;ond"ions. 

«you do not agree to these terms and c;ondftions, you may obtain a fuft refund by retumlng the unopened diskette package and the other c;ofTl>O
nents of this product along with your receipt to the Cof'MlOdore dealer wherethe purchase was made wfthln three (3) days following such purchase. 

1. Copyright: These programs and the related documentation are 
copyrighted. You may not use, copy, modify,or transfer the programs 
or documentation. or any copy except as expressly provided in this 
Agreement. 

2. License: You have the non·excluslve right to use any enciosed pr0

gram only on a single c;omputer. You may load the program Into your 
computer's tl)l1l:>Ol'ary memory (RAM). You mayphyslcatly transfer the 
program from one computer to another provided that the program Is 
used ononlyonecornputer atatime. You may not electroolcaftytransfer 
theprogramfromone cornputer to another over a network. You may not 
distribute copies of the program or aooorr.,anying documentation to 
others. You may not decornpUe. dlslUlllarm... reverse engineer, modify 
or translate the program or documentation. You may not alt8fT1)t to 
unlock or bypIU!Il anycopy protection utilized wfththe program. All other 
rights and uses not specifically granted in this Hcense are r888l'lled by 
Commodore. 

3. Back-up and Tr_fer:You may make one (1) copy of the program 
solely for back-up purposes. You must reproduce and Include the copy. 
right notice on Iheback-upcopy. You may transfer and Ilcanse the prod
uct to another party only ff the other party agr_ to the terms and con
dklons of this Agreement and c;ompfetes and retulrlS a registration card 
to Commodore. Hyou transfer the program you must at the same time 
transfer the documentation and back-up copy or transfenhe documen· 
tation and destroy Ihe back-up copy. 

4. Terma: This license is effective untK terminated. You may temninate 
II by deslroying the program and documentation and all copies thereof. 
This ficensewill aisotermlnate «you faB IOc;omplywfth anytemn oroon
dftion of this Agreement. You agree upon such termination to destroy all 
eoples of the program and documentation. 

5. Program Disclaimer: The programs are provided 'as Is' wfthout 
Warranty of any kind. ekher expressed or impfied. Including. but not 
Ilmhed to, the 1"",,1ed warranties of merchantabllify and fftnees for a 
particular purpose. The entire risk as to the resuks and performance of 
any program Is lUIIlumed by you. Should the program prove detective, 
you (and n~ Commodore or ks dealers) assume the entire cost of all 
necessary servicing, repair or correction. Further, CommodOre does 
not warrant, guarantee or make any representations regarding the use 
of. or the r_uks of the use of, the program In terms of c;orrecllons. ac
curacy, rellabUhy, currentness, or ~herwlse: and you rely on the 
program and resuks solely at your own risk. 

8. Dlakette Umited Warranty: Commodore warrants to the original II· 
cens.... that the dlskette(s) on which the program is recorded shall be 
lreefromdefects In material and workmanship only for aperiod r:A ninety 
(90) days from the date of original purchase. H a detect COllared by this 
warranty occurs dullng this 9O-day warranty period. and It Is flIIumed 
to the deelerfrornwhom Itwas purchased not later than five (5) days of 
the end of such 9O-day period, the dearer Shall. at the dealer's option, 
e~her repair or replace the diskette. 

The above warranty is exclusive and In lieu of all other warranties. 
express or imPlied (other than those warranties imPlied by slate law). 
An Slate statutory ImpHed warranties, Including, but not I~ to im
pfied warranlles of merchantability or fftnesa for a particular purpose 
shall be Ilmhed to a period of 90 days from the date of your original 
purchase. No warranties, ekher express or ImpHed. wfil apply aIIer this 
period. 

7. limitation 01 Uabllity:Commodore's llabiflty Is limned soiely to the 
repair or replacement of the defecllveproduC!., In ks sole discretion. and 
shall not in any evenl Indude damages for loss of use or loss of 
anlic~edprofksorbenefksorotherincldentalorconsequentlaloosts. 

expenses or damages. Including wfthout limitation any date or informa
lion which may be lost or rendered Inaccurate. even ~Commodore has 
been advised of the possibility of such damages. 

Some states do not alow a limitation on haN ion9 an inl>J1ed warranty 
lasts. orllmalion of incidental or oonsequentlal damages,so the above 
Ilmftatlons or exclusions may not apply to you. This warranty gives you 
specllc legal rights, and you may also have ~her rights which vary from 
state to Slate. 

8. MlIMliIII_oua: This Agreement represents the entire understand· 
ing regarding the programs and related documentation, and super
sedes any prior purchase order. comrnunlcallons, or representations. 
This Agreement may only be modHIed by a written amendment signed 
by an officer of Commodore. Hany prevision of the Agreement shal be 
deemed unlawiul, \/Old. or for any reason. unenforceable It shall be 
deemed a_,abIe from. and shall In no way effect the validify and en
forceability of the remaining provisions of the Agreement. 

This license Agreement shall be govemed by the laws of the United 
States of America, Commonwealth of Pennsylvania. 

9. The program Ucense Agreement shall Inure to the benellt of Corn
modore-Amiga. Inc.. hs parent, and all aIIlliated companies thereof. 

COMMODORE LICENSEE 

Mail to: 
Commodore Software License Agreement, 1200 Wilson Drive, West Chester, PA 19380 U.S.A. 
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